Készítette: Petrán Attila
SZAKMAI GYAKORLATI VIZSGA – JEGYZET
Követelmények:
Hálózatok telepítése és beállítása
· VLAN-ok használata VLAN-ok közti forgalomirányítás
· Második rétegbeli redundancia
· Dinamikus címkiosztás IPv4 környezetben
· IPv6 címzés és dinamikus címkiosztás IPv6 környezetben
· Harmadik rétegbeli redundancia
· Hálózatbiztonság kapcsoló biztonságossá tétele
· Vezeték nélküli technológiák
· Forgalomirányítási alapok statikus forgalomirányítás
· Dinamikus forgalomirányítási ismeretek
· Hálózatbiztonság
· Hozzáférési listák használata
· Statikus és dinamikus címfordítás lehetőségei
· WAN technológiák
· Virtuális magánhálózat (VPN) kialakítása
· Minőségbiztosítási alapok hálózatfelügyelet megvalósítása
· Hálózattervezés hibaelhárítás
· Hálózat virtualizáció hálózat automatizáció
· Komplex hálózat tervezése kialakítása

Szerverek telepítése és beállítása
Windows-server
· Hitelesítés, jogosultságok, engedélyek kezelése
· Fájlrendszerek, fájlműveletek, partíciók, szoftveres RAID
· DHCP, DNS, DFS szolgáltatások
· Rendszerfelügyelet (pl. MMC konzol, Server Manager)
· Active Directory tartományvezérlő telepítés, konfigurálás
· Címtárszolgáltatás objektumainak kezelése
· Csoportházirend szolgáltatások konfigurálása
· PowerShell szkript
· Windows Server Backup
· Távmenedzsment (pl. RSAT)
· VPN kapcsolat konfigurálás
· IIS

Linux-server
· Betöltési folyamatok, boot manager
· Futási szintek
· Particionálás, fájlrendszerek, fájlműveletek, linkek
· Fájlhozzáférések, ACL-ek
· Shell-beállítások, alapvető segédprogramok, pipeline
· DHCP, DNS szolgáltatások
· Forgalomirányítás, címfordítás
· Web- és adatbázis-kiszolgálók telepítése, beállítása
· Tűzfal, proxy
· Shell-szkriptek
· Levelezési szolgáltatások telepítése, beállítása

Felhőszolgáltatás
A feladat során a vizsgázónak az általa választott felhőszolgáltatóhoz (pl. AWS, Azure, Google Cloud) kapott előfizetés segítségével kell egy hálózati szolgáltatást (pl. web, adatbázis, DNS) létrehoznia és beállítania.
A feladat az alábbiakból legalább három témakörhöz tartozó, különböző nehézségű részfeladatot tartalmaz:
· SaaS (Software as a Service) (pl. Onedrive, Dropbox, Google Apps, Office 365))
· PaaS (Platform as a Service) (pl. Google App Engine, Apache Stratos)
· IaaS (Infrastructure as a Service) (pl. Amazon EC2, Windows Azure)
· Felhő címtárszolgáltatás (pl. Azure Active Directory)
· Virtuális gép és konténer létrehozása, menedzselése a felhőben
Linux-server
Betöltési folyamatok, boot manager
Betöltési folyamat (boot process)
A boot folyamat a számítógép bekapcsolásától az operációs rendszer betöltéséig tart.
Lépések:
1. BIOS / UEFI indul 
a. Boot eszköz kiválasztása (pl HDD, SSD)  és ellenörzi a hardvereket
2. Boot manager betöltése 
b. (pl GRUB/LILO) 
3. Kernel betöltése 
c. (Ez felel a hardverekért, pl CPU vagy memória )

4. Init / systemd indul (Szolgáltatások indításáért felel, login folyamat indítása)
5. Rendszer használatra kész
BIOS vs UEFI
BIOS:
• régebbi rendszer
• MBR-t használ (Az első 512 byte tartalmazza a bootloader-t)
• limitált (max 2 TB, max 4 elsődleges partició, lassabb indulás, csak hardver ellenörzés, és boot indítása)
UEFI:
• modern
• GPT támogatás (Nincs 2TB os korlát, 128+ partició, Vannak backup táblák)
• gyorsabb(ESP ből bootol, ez egy speciális partició, innen kikeresi a bootmanager fájl és elindítja)
• több funkció
Boot manager (bootloader)
A boot manager feladata:
• operációs rendszer betöltése
• kernel kiválasztása
• több OS kezelése
 Példa:
• Linux + Windows dual boot
GRUB (GRand Unified Bootloader)
A GRUB a leggyakrabban használt Linux bootloader.
Mit csinál a GRUB?
• menüt jelenít meg induláskor
• kiválasztod az OS-t
• betölti a Linux kernelt
[image: ]
GRUB konfiguráció
Fő fájl:
sudo nano /etc/default/grub
Mit tartalmaz:
• default OS (Melyik menupont idnul automatikusan 0= első menüpont és így tovább, Ha ide konkrét nevet adsz meg, pl Debian, Ubuntu, vagy Windows akkor az az os indul majd)
• timeout (Hány másodpercig várjon, mielőtt amutómatikusan tovább lép)
• kernel paraméterek (Itt megtudod nézni, hogy milyen beállításokat ad át a kernelnek leginkább hibakeresésnél használt)

GRUB frissítése (root / sudo)
sudo update-grub
Mit csinál:
• újra generálja a boot menüt, az eredetit meghadja, és a módosított verziót egy új néven működésbe helyezi.

GRUB telepítése (Csak speciális esetben kell, pl ha nem bootol a rendszer, vagy dual boot esetében a windows felülírja a linuxos grub-ot)
sudo grub-install /dev/sda
Mit csinál:
• bootloader telepítése lemezre
fontos:
• nem partícióra, hanem lemezre (sda, nem sda1)

LILO (Linux Loader)
Régi bootloader (ma már nem használják)
Tulajdonságok
• egyszerűbb mint GRUB(Nincs menürendszer, nincs automatikus OS felismerés)
• nincs dinamikus konfiguráció(Ha valami változik pl új kernel, új rendszer, nem frissul magától)
• minden változtatás után újra kell írni
Konfiguráció
/etc/lilo.conf 
Ha módosítod a fájl, akkor kötelező utánna a „sudo lilo” parancs
Telepítés
sudo lilo
Mit csinál:
• felírja a bootloadert, a config alapján elkészíti a boot információkat és kiírja az MBR-re
GRUB vs LILO
	Tulajdonság
	GRUB
	LILO

	Használat
	modern
	régi

	Menü
	van
	limitált

	Frissítés
	update-grub (automatikus felismerés)
	lilo(kézzel írt config fájl, majd azt kiiratni a lemezre)



Futási szintek
Mi az init?
Az init a Linux rendszer első folyamata (PID 1), ami a rendszer indulásakor elindul.
Feladata:
• rendszer indítása
• szolgáltatások elindítása
• futási mód (runlevel) kezelése
Régi rendszerek: SysV init
Modern rendszerek: systemd

Runlevel-ek (régi rendszer – SysV init)
A runlevel meghatározza, hogy milyen állapotban fusson a rendszer

0 – rendszer leállítása
sudo init 0
Mit csinál:
• azonnali shutdown
Mikor használod:
• szerver leállítás
• karbantartás előtt
veszély:
• mentetlen adat elveszhet

1 – single user mód
sudo init 1
Mit csinál:
• csak 1 user (root)
• nincs hálózat
• minimális szolgáltatás
Mikor használod:
• jelszó reset
• hibajavítás
• fájlrendszer javítás
példa:
· elrontott config → nem bootol → single mode 

2 – multi-process mód
sudo init 2
Mit csinál:
• több folyamat fut
• disztribúció függő
3 – multi-user mód (NAGYON FONTOS)
sudo init 3
Mit csinál:
• több felhasználó
• hálózat aktív
• nincs GUI
Mikor használod:
• szerver környezet
• SSH használat
• hibakeresés GUI nélkül
tipikus:
· web szerver 
· adatbázis szerver

4 – custom (nem használt)
sudo init 4
Mit csinál:
• egyedi célra fenntartva
gyakorlatban:
• szinte soha nem használják

5 – grafikus mód
sudo init 5
Mit csinál:
• GUI elindul
• desktop környezet
Mikor használod:
• desktop Linux
• fejlesztés

6 – újraindítás
sudo init 6
Mit csinál:
• reboot
Mikor használod:
• rendszer újraindítás
Runlevel ellenőrzése
runlevel
Mit csinál:
• aktuális runlevel megjelenítése
Miért lett lecserélve az init?
Probléma:
• lassú indulás
• egymás után indulnak a szolgáltatások
• nehéz kezelni
Systemd (modern megoldás)
A systemd:
• gyorsabb
• párhuzamos indítás
• jobb szolgáltatás kezelés

Target-ek (runlevel megfelelője)
	Régi
	Systemd

	0
	poweroff.target

	1
	rescue.target

	3
	multi-user.target

	5
	graphical.target

	6
	reboot.target



Target váltás
CLI
sudo systemctl isolate multi-user.target
Mit csinál:
• GUI leáll
• csak konzol
Mikor használod:
• szerver
• hiba keresés

Grafikus mód
sudo systemctl isolate graphical.target
Mit csinál:
• GUI indul
Mikor használod:
• desktop

Single user mód
sudo systemctl isolate rescue.target
Mit csinál:
• minimális rendszer
• csak root
Mikor használod:
• javítás
• recovery

Alapértelmezett mód beállítása
Lekérdezés
systemctl get-default
Beállítás példa
sudo systemctl set-default multi-user.target
→ szerver mód
sudo systemctl set-default graphical.target
→ GUI mód

Rendszer leállítás / újraindítás
Ajánlott (systemd)
sudo poweroff
sudo reboot
Alternatívák:
sudo systemctl poweroff
sudo systemctl reboot
Szolgáltatások kezelése
Indítás
sudo systemctl start nginx

Leállítás
sudo systemctl stop nginx

Újraindítás
sudo systemctl restart nginx

Állapot
systemctl status nginx
Mit látsz:
• fut-e
• hibák

Automatikus indulás
sudo systemctl enable nginx
→ bootkor indul
sudo systemctl disable nginx
→ nem indul

Particionálás, fájlrendszerek, fájlműveletek, linkek
Mi a particionálás?
A particionálás a lemez felosztása több logikai részre (partíciókra).
Miért kell:
• külön van a rendszer és az adatok
• jobb kezelhetőség

Partíciós táblák
MBR (msdos)
• régi típus
• max 2 TB lemez
• max 4 elsődleges partíció
Partíció típusok:
• elsődleges (primary) → max 4
• kiterjesztett (extended) → 1 db
• logikai (logical) → extended-en belül (max ~65535)
rendszerindítás → primary partícióról

GPT (GUID Partition Table)
• modern típus
• nincs 2 TB limit
• sok partíció (alapból 128)
• UEFI rendszerhez kell
ajánlott: GPT
Partíciók kezelése
1. Lemezek listázása
lsblk
Mit csinál:
• lemezek + partíciók listázása
fdisk használata (MBR/GPT kezelése)
sudo fdisk /dev/sdb
Alap parancsok:
· m→help
· n → új partíció
· d → törlés
· p → lista
· w → mentés
· q → kilép mentés nélkül
Példa fsdiskes particionálásra(2 db 10GB os partició létrehozása):
0. A virtuális gépben kell lennie plusz egy 20GB os disk-nek
1. lsblk
a. megnézed hogy mi annak a disknek a neve amit beraktál 
2.  sudo fdisk /dev/<disk neve>
3. n
a. primary
b. 1
c. (üres)
d. +10G
4. n
a. primary
b. 2
c. (üres)
d. +10G (Ha engedi, de előfordul, hogy nem teljesen 20G az elérhető ugyanis a lemez elején tárolódik a boot info, nagyon kicsi de elég ahhoz hogy ne tudd a particiókat rendesen létrehozni, ebben az esetben csak ’enter’ és akkor az összes maradék helyet felhasználja)
5. w
cfdisk (egyszerűbb, grafikus)
sudo cfdisk /dev/sdb
Mit csinál:
• Grafikus partició kezelés
Példa cfdiskes particionálásra(2 db 10GB os GPT partició létrehozása):
0. -||-
1. GPT
2. New – enter
3. 10G
4. write
5. yes
6. Kiválasztod a ’free space’ részt
7. new
8. 10G
9. write
10. yes
11. quit – enter
Ellenörzés
lsblk 
Fájlrendszerek (filesystem)
Gyakoribb típusok:
• ext2 → régi, nincs journal
• ext3 → journaling
• ext4 → leggyakoribb
• xfs → nagy fájlok
• btrfs → modern (copy-on-write)
• ntfs → Windows
Fájlrendszer létrehozása (formázás)
sudo mkfs.ext4 /dev/sdb1
Mit csinál:
• fájlrendszert hoz létre a partíción
Csatolás (mount)
Ideiglenes csatolás
sudo mount /dev/sdb1 /data
FONTOS: létre kell hozni a csatolási pontot, ebben az esetben a ’/data’ mappát
Mit csinál:
• elérhetővé teszi a partíciót
Tartós csatolás UUID alapján
Debian 13 alatt ezt így csináld UUID alapján:
blkid
A Debian dokumentáció szerint az /etc/fstab használhat UUID-t, és az UUID lekérdezésére a blkid vagy az lsblk -f javasolt. 
2. Hozd létre a csatolási pontot: 
sudo mkdir -p /mnt/adatok
3. Nyisd meg az fstab fájlt: 
sudo nano /etc/fstab
4. Írd bele ezt a sort: 
UUID=1234-ABCD  /mnt/adatok  ext4  defaults  0  2
Példa valódi Linux fájlrendszeres UUID-val:
UUID=8f3b2f2d-6d9d-4d6a-a4a2-1c9b1f4e7c11  /mnt/adatok  ext4  defaults  0  2
Mit jelent:
· UUID=... = a partíció egyedi azonosítója 
· /mnt/adatok = ide lesz csatolva 
· ext4 = fájlrendszer típusa 
· defaults = alapértelmezett mount opciók 
· 0 = dump általában nincs használva 
· 2 = fsck ellenőrzési sorrend, a root után ellenőrizhető partícióknál tipikus érték 
Az /etc/fstab pont erre való, vagyis megmondja, milyen fájlrendszerek hogyan csatolódjanak a rendszerben. A Debian hivatalos dokumentáció külön írja, hogy az fstab UUID-t is tud használni. 
sudo systemctl daemon-reload
Frissíteni kell az állományt
5. Ellenőrizd hiba nélkül betölthető-e: 
sudo mount -a
6. Nézd meg, sikerült-e: 
lsblk

Fájlműveletek
Másolás
cp file1.txt file2.txt
Mappa:
cp -r mappa1 mappa2

Mozgatás / átnevezés
mv file1.txt file2.txt
Törlés
rm file.txt
rm -r mappa

Listázás
ls -l
kapcsoló:
l  részletesen listáz(jogosultságok, tulajdonos, csoport, méret, dátum, név)

Fájl tartalom kiírása /megtekintése
cat file.txt
nano file.txt
Hard link
ln file.txt hardlink.txt
Mit csinál:
• létrehoz egy új nevet ugyanarra a fájl inod(id-ra)
Lényeg:
• nem másolat
• ugyanaz az adat
• ugyanaz az inode(id)
ha egyik törlődik:
• a másik működik tovább
FONTOS: csak ugyanazon a partición működik ahol a fájl is van

Soft link (symbolic link)
ln -s file.txt softlink.txt
Mit csinál:
• létrehoz egy hivatkozást egy másik fájlra
Lényeg:
• nem maga az adat
• csak egy "pointer"
ha az eredeti törlődik:
• a link hibás lesz

Gyakori hibák
• rossz lemez (/dev/sda vs sdb)
• mountpoint nem létezik
• nincs sudo
• rossz fájlrendszer



Fájlhozzáférések, ACL-ek(Access Control List)
Mi az ACL?
Az ACL a Linux jogosultságkezelés kiterjesztése.
A hagyományos modell (chmod) csak 3 szintet kezel:
· user (tulajdonos) 
· group (csoport) 
· others (mindenki más) 
Az ACL lehetővé teszi:
· konkrét user jog 
· konkrét csoport jog 
· finomhangolt hozzáférés 
Jogosultságok (Permission)
Alap jogok:
· r → read (olvasás) 
· w → write (írás) 
· x → execute (futtatás) 
· - → nincs jog 
Kombinációk:
· rwx → teljes hozzáférés 
· rw- → olvasás + írás 
· r-- → csak olvasás 
· --- → nincs hozzáférés 

ACL használat előkészítése
1. ACL csomag telepítése (root / sudo szükséges)
sudo apt update && sudo apt install -y acl
Mit csinál:
· telepíti a getfacl és setfacl parancsokat 

2. Fájlrendszer ellenőrzése
lsblk
df -T
Mit nézel:
· partíció neve (pl: /dev/sdb1) 
· csatolási pont (pl: /data) 
· fájlrendszer (pl: ext4) 

3. ACL engedélyezése
Ideiglenesen (root / sudo):
sudo mount -o remount,acl /data

Tartósan (/etc/fstab szerkesztése – root / sudo)
sudo nano /etc/fstab
A fájl végére szúrd be:
/dev/sdb1 /data ext4 defaults,acl 0 2
vagy UUID alapján (ajánlott):
UUID lekérdezése:
sudo blkid
UUID=xxxx-xxxx /data ext4 defaults,acl 0 2
(Ha UUID alapján szúrod be, akkor akkor is ugyan azt a meghajtót fogja csatolni, ha másik csatlakozóba dugod be. Ha név alapján akkor megváltozik a neve pl ’sda’ helyett ’sdb’ ezért ajánlottabb UUID-vel dolgozni)

fstab mezők jelentése
/dev/sdb1   /data   ext4   defaults,acl   0   2
· /dev/sdb1 → partíció 
· /data → csatolási pont (léteznie kell: mkdir /data) 
· ext4 → fájlrendszer (egyéb fájlrendszerek: ext3, ext2, xfs, btrfs, ntfs)
· defaults → alap mount opciók (Magába foglalja a rwx, automatikus mountolást egyéb funkciókat)
· acl → ACL engedélyezés 
· 0 → dump (0 = Ne mentse ; 1=Dump backup eszköz használja) 
· 2 → fsck ellenőrzési sorrend  (0= ne ellenőrizze ; 1=Elsőként ellenörízze ; 2= root után ellenőrizze)

Ellenőrzés
sudo mount -a 
(Le ellenörzi az FSTAB állományt, ha hiba van akkor az kiírja.)
mount | grep /data 
(mount= listázza az összes felcsatolt fájl rendszert ; | grep /data= megkeresi azt a sort ahol a ’/data’ ról van szó)

Könyvtár és fájl létrehozása ACL használathoz
sudo mkdir /data/projekt
cd /data/projekt
touch test.txt (Fájl létrehozása)

ACL jogosultságok kezelése
Jogosultság lekérdezése
getfacl test.txt
User hozzáadása a fájlhoz (root / sudo)
sudo setfacl -m u:bob:rwx test.txt
Szintaxis:
· -m → modify, hozzá adás 
· u → user 
· g → group 
· o → others
· m→mask (Maximum milyen jogosultsága lehet egy csopornak, vagy usernekpl m:r—csak írás jog, akkor hiába állítasz u:bob:rwx-ot)
· formátum: típus:név:jog <fájl.txt> | others esetében: típus:jog <fájl.txt>

Csoport hozzáadása
sudo setfacl -m g:sudo:r-- test.txt

ACL meglétének ellenőrzése
ls -l test.txt
+ jel → van ACL
pl.: ’-rw-rwxr--+ 1 test test 0 nov 10 12:30 test.txt’

ACL törlése
Egy user:
sudo setfacl -x u:bob test.txt
Egy csoport:
sudo setfacl -x g:sudo test.txt
Összes ACL:
sudo setfacl -b test.txt

Default ACL (öröklődés könyvtárban)
sudo setfacl -m d:u:bob:rwx /data/projekt
Mit csinál:
· új fájlok automatikusan öröklik 
Ellenőrzés:
touch uj.txt
getfacl uj.txt

Mask (ACL limit)
sudo setfacl -m m:r-- test.txt
Mit csinál:
· maximális jog limit az ACL-re 
Lényeg:
· ha mask = r-- → minden ACL user max olvas 

chmod és ACL kapcsolata
chmod 755 test.txt
· chmod → alap jogosultság 
· ACL → extra szabályok 
Mindig ellenőrizd:
getfacl test.txt

Gyakori hibák
· nincs acl az fstab-ban 
· mount nincs újratöltve (mount -a) 
· nincs + jel → nincs ACL 
· mask korlátozza a jogokat 
· rossz user/csoport név


Shell-beállítások, alapvető segédprogramok, pipeline
Mi az a shell?
A shell egy parancsértelmező program, ami lehetővé teszi, hogy parancsokat adj ki a rendszernek.
Leggyakoribb shell:
• bash (alapértelmezett Linuxon)
Feladata:
• parancsok futtatása
• fájlok kezelése
• programok indítása
• pipeline-ok kezelése

Shell alap parancsok
Navigáció:
• pwd → aktuális mappa
• ls → fájlok listázása
• cd mappa → belépés
Fájlkezelés:
• touch file.txt → fájl létrehozás
• mkdir mappa → mappa létrehozás
• rm file.txt → törlés
• cp forras cel → másolás
• mv forras cel → áthelyezés/átnevezés

Shell beállítások (gyakorlat)
1. Shell config fájl
Felhasználó szintű beállítások:
~/.bashrc
Szerkesztés:
nano ~/.bashrc

2. Alias létrehozása
Gyors parancsok rövidítése
Példa:
alias update='sudo apt update && sudo apt upgrade -y'
Mit csinál:
• saját parancsnevet adsz meg
Aktiválás:
source ~/.bashrc

3. PATH változó
A rendszer itt keresi a parancsokat
Megnézés:
echo $PATH
Hozzáadás:
export PATH=$PATH:/home/user/scripts
Mit csinál:
• új mappából is futtathatóak a programok

4. Környezeti változók
Változók shell-ben
Példa:
MENTES="/home/<felhasz>/backup"
cp file.txt $MENTES
Alap segédprogramok (core tools)
Szövegkezelés
cat file.txt
• fájl kiírása
less file.txt
• görgethető nézet
head -n 5 file.txt
• első sorok
tail -n 5 file.txt
• utolsó sorok

Keresés
grep "hiba" file.txt
Mit csinál:
• adott szöveget keres
Opciók:
• -i → nem számít kis/nagy betű
• -r → rekurzív keresés

Szűrés és feldolgozás
sort file.txt 
	-Nem változtatja meg a fájlt, csak a kimentetet rendezi.
	kapcsolók:
		-r (fordított sorrend)
		-n (számszerű rendezés)
		-kx (x. oszlop szerinti rendezés)
		
uniq file.txt
	-Az egymás mellett lévő ismétlődő sorokat szűri ki
	- Gyakran párban használjuk a sort al pl „sort file.txt | uniq
	Kapcsolók:
		-c (megszámolja hányszor ismétlődött)
		-d (csak a duplikált sorokat mutatja)
wc -l file.txt 
	Megszámolja a paraméterben megadottakat
	Kapcsolók
		-l (sorokat, lineokat számól)
		-w (szavakat számól)
		-c (byte-ok száma)
Rendszer info
top
· futó folyamatok valós időben, és a rendszer terheltsége
ps
· A futó folyamatokat listázza ki.
ps aux
· a = más felhasználók folyamatait is mutassa
· u = részletesebb, pl felhasználót is mutassa
· x = terminál nélküli folyamatokat is mutassa
pl.: ps aux | grep nginx  fut e az nginx program
df
· A csatolt fájlrendszerek szabad és foglalt helyét mutatja.
· -h kapcsoló = human, azaz emberi olvasható forma
free
· Memóriahasználatot mutat.
· -h kapcsoló = human, azaz emberi olvasható forma

Pipeline (|)
Mi az a pipeline?
Több parancs összekötése úgy, hogy az egyik kimenete a másik bemenete legyen.
Szintaxis:
parancs1 | parancs2

Egyszerű példa
ls | grep ".txt"
Mit csinál:
• kilistázza a fájlokat
• csak .txt fájlokat hagy meg

Több lépéses pipeline
cat file.txt | grep "error" | sort | uniq
Mit csinál:
• fájl beolvasás
• hibák szűrése
• rendezés
• duplikátumok kiszűrése

Sorok számolása pipeline-ban
cat file.txt | grep "error" | wc -l
Mit csinál:
• megszámolja a hibákat

Redirect (átirányítás)
Kimenet fájlba:
ls > lista.txt
Mit csinál:
• felülírja a fájlt
FONTOS „>” ez létre is hozza a fájlt
Hozzáfűzés:
ls >> lista.txt
	

Hiba kimenet:
ls nemletezo 2> error.txt
Mit jelent ez?
A Linux parancsoknak alapból 3 adatfolyama van:
0 → standard input, stdin 
1 → standard output, stdout 
2 → standard error, stderr 

Mi történik itt?
ls nemletezo 2> error.txt
ls nemletezo hibát fog adni, mert nincs ilyen fájl vagy mappa 
a normál hibakimenetet, vagyis a stderr-t átirányítod az error.txt fájlba 


Standard output + error együtt = a standard output és a hiba is az out.txt-be megy
ls > out.txt 2>&1

Gyakorlati példák
1. Log elemzés
cat syslog | grep "error" | wc -l

2. Leggyakoribb szavak
cat file.txt | tr ' ' '\n' | sort | uniq -c | sort -nr

3. Fájlok méret szerint
ls -lh | sort -k5 -h

Script lépésről lépésre (Leg minimálisabb működő script)
1. touch backup.sh
chmod +x backup.sh
Mit csinál:
· létrehoz egy scriptet
· futtathatóvá teszi
2. nano backup.sh
#!/bin/bash – Minden bash ezzel kezdődik
3. tar -czf /home/nin/backup_$(date +%Y-%m-%d).tar.gz /home/nin/adatok
· tar tömörítő
· -c (create)
· z(gzippel tömörít)
· f(ezután adod meg a fájlt)
· Milyen néven menti le + dátumok + kiterjesztés
· Mit mentsen le
Futtatás
Ha ugyanabban a mappában vagy:
./backup.sh

Ha máshonnan:
/home/nin/backup.sh

Gyakori hibák
• elfelejted a | jelet
• rossz sorrend pipeline-ban
• > felülírja a fájlt
• PATH nincs beállítva → parancs nem fut
• alias után nincs source ~/.bashrc
• grep nem talál semmit → rossz minta
DHCP, DNS szolgáltatások
DHCP 

Mi az a DHCP?
A DHCP egy automatikus IP kiosztó rendszer.
Feladata:
· IP-cím kiosztás 
· gateway megadása 
· DNS megadása 
Portok:
· szerver → UDP 67 
· kliens → UDP 68 

DHCP működés (vizsgán ez fix kérdés)
1. DISCOVER → kliens IP-t keres (broadcast) 
2. OFFER → szerver ad egy IP ajánlatot 
3. REQUEST → kliens elfogadja 
4. ACK → szerver véglegesíti 

Cél (irodai példa)
· hálózat: 172.16.0.0/16 
· kiosztás: 172.16.0.100 – 172.16.0.200 
· gateway: 172.16.0.1 
· DNS: 8.8.8.8, 8.8.4.4 
· domain: iroda.lan 
· lease: 7200 sec (2 óra) 

TELEPÍTÉS ÉS KONFIG (LÉPÉSRŐL LÉPÉSRE)

1. Root jog
sudo -i

2. Telepítés
apt update && apt upgrade -y && apt install isc-dhcp-server -y
Mit csinál:
· felrakja a DHCP szervert 

3. Szolgáltatás leállítás (config előtt)
systemctl stop isc-dhcp-server

4. Statikus IP ellenőrzés
cat /etc/network/interfaces
Fontos:
· DHCP szervernek FIX IP kell 
Példa:
iface enp0s3 inet static
address 172.16.0.254/16
gateway 172.16.0.1

5. Backup config
mv /etc/dhcp/dhcpd.conf /etc/dhcp/dhcpd.conf.old

6. DHCP config létrehozás
nano /etc/dhcp/dhcpd.conf
TARTALOM:
authoritative;
default-lease-time 7200;
max-lease-time 7200;

option domain-name "iroda.lan";
option domain-name-servers 8.8.8.8, 8.8.4.4;

subnet 172.16.0.0 netmask 255.255.0.0 {
    option routers 172.16.0.1;
    option subnet-mask 255.255.0.0;
    option broadcast-address 172.16.255.255;

    range 172.16.0.100 172.16.0.200;
}

CONFIG MAGYARÁZAT (SORONKÉNT)
authoritative;
→ ez a szerver a fő DHCP (nem vár másra)
default-lease-time 7200;
→ IP meddig él (2 óra)
max-lease-time 7200;
→ max idő
option domain-name "iroda.lan";
→ kliens domain
option domain-name-servers 8.8.8.8, 8.8.4.4;
→ DNS szerverek

subnet rész
subnet 172.16.0.0 netmask 255.255.0.0
→ melyik hálózatra dolgozik
option routers 172.16.0.1;
→ gateway
option subnet-mask 255.255.0.0;
→ maszk
option broadcast-address 172.16.255.255;
→ broadcast cím
range 172.16.0.100 172.16.0.200;
→ kiosztható IP-k

7. Interfész megadása
nano /etc/default/isc-dhcp-server
INTERFACESv4="enp0s3"
INTERFACESv6=""
Mit csinál:
→ melyik hálókártyán fusson

8. Konfig ellenőrzés
dhcpd -t
Ha nincs hiba → mehetsz tovább

9. Szolgáltatás indítás
systemctl start isc-dhcp-server

10. Állapot ellenőrzés
systemctl status isc-dhcp-server
Ha:
active (running)
→ működik

TESZTELÉS

DHCP szerveren
dhcp-lease-list
Mutatja:
· IP 
· MAC 
· hostname 

Windows kliensen
ipconfig /all
Mit kell látni:
· DHCP Enabled: YES 
· IPv4: pl. 172.16.0.100 
· Gateway: 172.16.0.1 
· DNS: 8.8.8.8 
· DHCP Server: 172.16.0.254 

GYAKORI HIBÁK
· nincs statikus IP a szerveren 
· rossz interface név 
· config hiba → dhcpd -t nem fut le 
· tűzfal blokkol (UDP 67) 
· nincs elindítva a service 
· rossz subnet / range 

EXTRA (vizsgán jól jön)
Lease fájl helye
/var/lib/dhcp/dhcpd.leases

Service restart
systemctl restart isc-dhcp-server

Gyors ellenőrzés egyben
dhcpd -t && systemctl restart isc-dhcp-server && systemctl status isc-dhcp-server

1. DNS alapok
A DNS feladata:
domain név → IP-cím átalakítás
Példa:
www.office.lan → 192.168.12.10

Legfontosabb rekord típusok
A rekord
Mit csinál:
→ egy névhez IP-címet rendel
Példa (office.lan zónában):
www.office.lan → 192.168.12.10
CNAME rekord
Mit csinál:
→ egy név egy másik névre mutat
Példa:
portal IN CNAME www.office.lan.
Fontos:
· a cél mindig teljes domain név (FQDN) → ezért kell a pont a végén 
· MX rekord nem mutathat CNAME-re 

MX rekord
Mit csinál:
→ megmondja, melyik szerver fogad levelet
Példa:
@ IN MX 10 mail.office.lan.
Mit jelent:
· @ = maga a domain → office.lan 
· 10 = prioritás (kisebb = fontosabb)

2. BIND9 telepítés
sudo apt update && sudo apt install -y bind9 bind9-utils bind9-doc
Mit csinál:
· bind9 → DNS szerver 
· bind9-utils → tesztelés (dig) 
· bind9-doc → dokumentáció 

Szolgáltatás ellenőrzése
sudo systemctl status bind9
Logok:
sudo journalctl -u bind9

3. Tűzfal (ha nincs telepítve, akkor előbb telepíted!)
UFW telepítés
Jogosultság: sudo
sudo apt install -y ufw
Bekapcsolás:
sudo ufw enable

DNS port megnyitása
sudo ufw allow 53/tcp
sudo ufw allow 53/udp
Mit csinál:
· TCP + UDP 53 portot engedi (DNS működéshez kell) 

4. ACL (Access Control List) DNS-ben
Mi az ACL?
→ IP tartomány lista, aki használhatja a DNS-t

Fájl szerkesztése
sudo nano /etc/bind/named.conf.options

Példa konfiguráció
acl "lan" {
 192.168.12.0/24;
 localhost;
};
options {
 directory "/var/cache/bind";
 recursion yes;
 allow-query { lan; };
 listen-on-v6 { none; };
};

Soronként magyarázat
acl "lan" {
→ létrehozol egy listát "lan" néven
192.168.12.0/24;
→ belső hálózat (ez kérdezhet)
localhost;
→ saját gép mindig kérdezhet
recursion yes;
→ a szerver tovább kérdez más DNS-eket
allow-query { lan; };
→ csak a "lan" listában lévők kérdezhetnek
listen-on-v6 { none; };
→ IPv6 kikapcsolása

Ellenőrzés
sudo named-checkconf

5. Zóna definíció (EZ KÖTELEZŐ)
Mi az a zóna?
→ egy domain adatainak leírása (pl. office.lan)

Fájl
sudo nano /etc/bind/named.conf.local

Forward zóna
zone "office.lan" {
 type master;
 file "/etc/bind/db.office.lan";
};

Magyarázat
zone "office.lan"
→ melyik domainről van szó
type master;
→ ez a szerver az elsődleges (itt módosítasz)
file "/etc/bind/db.office.lan";
→ ebben a fájlban vannak a rekordok

Reverse zóna
zone "12.168.192.in-addr.arpa" {
 type master;
 file "/etc/bind/db.192.168.12";
};

Mit csinál?
→ IP → név feloldás

6. Zóna fájl (Forward)
sudo nano /etc/bind/db.office.lan

Teljes példa
$TTL 604800
@ IN SOA ns1.office.lan. root.office.lan. (
 2026032401
 7200
 3600
 1209600
 3600
)
@ IN NS ns1.office.lan.
@ IN A 192.168.12.1
ns1 IN A 192.168.12.1
www IN A 192.168.12.99
portal IN CNAME www.office.lan.
mail IN A 192.168.12.10
backup IN A 192.168.12.20
@ IN MX 10 mail.office.lan.
@ IN MX 20 backup.office.lan.

@ IN TXT "v=spf1 mx ip4:192.168.12.10 ip4:192.168.12.20 -all"
default._domainkey IN TXT "v=DKIM1; k=rsa; p=PUBLIC_KEY"
_dmarc IN TXT "v=DMARC1; p=reject; rua=mailto:postmaster@office.lan"
_imap._tcp IN SRV 0 1 143 mail.office.lan.
_submission._tcp IN SRV 0 1 587 mail.office.lan.

Fontos szabályok
· Serial számot minden módosításnál növelni kell 
· pont kell a domain végére 
· @ = maga a domain (office.lan) 

sudo nano /etc/bind/db.192.168.12
$TTL    604800
@       IN      SOA     ns1.office.lan. admin.office.lan. (
                        2026032402      ; Serial
                        604800          ; Refresh
                        86400           ; Retry
                        2419200         ; Expire
                        604800 )        ; Negative Cache TTL
@       IN      NS      ns1.office.lan.
1       IN      PTR     ns1.office.lan.
10      IN      PTR     www.office.lan.

7. Ellenőrzés és újraindítás
Konfig ellenőrzés
sudo named-checkconf
Zóna ellenőrzés
sudo named-checkzone 12.168.192.in-addr.arpa /etc/bind/db.192.168.12 
sudo named-checkzone office.lan /etc/bind/db.office.lan
sudo named-checkzone office.lan /etc/bind/db.office.lan

Újraindítás
sudo systemctl restart bind9

8. Tesztelés (dig)
MX
dig @127.0.0.1 office.lan MX

TXT
dig @127.0.0.1 office.lan TXT +short

SRV
dig @127.0.0.1 _imap._tcp.office.lan SRV +short

Forgalomirányítás, címfordítás
Mi az a forgalom irányítás és NAT?
Forgalom irányítás:
• meghatározza, hogy egy csomag merre menjen (routing + firewall döntések)
NAT (Network Address Translation):
• belső IP-ket (pl. 192.168.x.x) átalakít külső IP-re
• így a belső hálózat ki tud menni internetre
Tipikus helyzet:
• belső háló: 192.168.11.0/24
• szerver = gateway (két hálókártya)
• egyik kártya → internet
• másik → belső háló

ELŐFELTÉTEL – 2 hálókártya
Ez kötelező!
	Interfész
	Szerep

	enp0s3
	külső (internet, DHCP)

	enp0s8
	belső (LAN, statikus IP)



Hálózat beállítása
Fájlok létrehozása
cp /etc/network/interfaces /etc/network/interfaces.d/enp0s3
cp /etc/network/interfaces /etc/network/interfaces.d/enp0s8
cp /etc/network/interfaces /etc/network/interfaces.d/lo

Fő config fájl
nano /etc/network/interfaces
Külső interfész (internet)
nano /etc/network/interfaces.d/enp0s3
allow-hotplug enp0s3
iface enp0s3 inet dhcp
Mit csinál:
• automatikusan IP-t kér a routertől
Belső interfész (LAN)
nano /etc/network/interfaces.d/enp0s8
allow-hotplug enp0s8
iface enp0s8 inet static
address 192.168.11.1/24
dns-search test.lan
Mit csinál:
• ez lesz a gateway IP
• a kliensek ide fognak csatlakozni

Loopback
nano /etc/network/interfaces.d/lo
auto lo
iface lo inet loopback

Hálózat újraindítása
systemctl restart networking
DNS fixálása
sudo nano /etc/resolv.conf
nameserver 8.8.8.8
IP FORWARD bekapcsolása
Ideiglenes
sysctl net.ipv4.ip_forward=1
Tartós
nano /etc/sysctl.d/99-ip-forward.conf
net.ipv4.ip_forward = 1
sysctl --system
Mit csinál:
• engedi, hogy a gép routerként működjön
NAT beállítása
iptables -t nat -A POSTROUTING -s 192.168.11.0/24 -o enp0s3 -j MASQUERADE
Mit csinál soronként:
• -t nat → NAT táblát használ
• -A POSTROUTING → kimenő csomagoknál
• -s 192.168.11.0/24 → belső háló
• -o enp0s3 → külső interfész
• -j MASQUERADE → IP átírás (NAT)
FORWARD szabályok (átengedés)

Mi az a FORWARD?
A FORWARD lánc akkor lép működésbe, amikor:
• a csomag nem a szervernek szól
• csak átmegy rajta (mint egy routeren)
Tehát:
• kliens → internet → FORWARD
• internet → kliens → FORWARD

1. Belső → külső (kimenő forgalom)
iptables -A FORWARD -i enp0s8 -o enp0s3 -s 192.168.11.0/24 -j ACCEPT
Mit csinál szó szerint:
• -A FORWARD
→ hozzáad egy szabályt a FORWARD lánchoz
• -i enp0s8
→ innen jön a csomag (belső háló)
• -o enp0s3
→ ide megy (internet felé)
• -s 192.168.11.0/24
→ forrás IP a belső hálóból
• -j ACCEPT
→ engedd át

Emberi nyelven:
„Ha a belső hálóból jön egy csomag, és kifelé megy az internetre → engedd ki”

2. Külső → belső (csak válasz!)
iptables -A FORWARD -i enp0s3 -o enp0s8 -d 192.168.11.0/24 -m state --state ESTABLISHED,RELATED -j ACCEPT
Mit csinál szó szerint:
• -A FORWARD
→ új szabály
• -i enp0s3
→ kívülről jön (internet)
• -o enp0s8
→ belső háló felé megy
• -d 192.168.11.0/24
→ cél a belső háló
• -m state
→ állapot alapú vizsgálat
• --state ESTABLISHED,RELATED
→ csak meglévő kapcsolat válasza
• -j ACCEPT
→ engedd át

Emberi nyelven:
„Internetről csak akkor jöhet be csomag, ha az egy korábbi kérés válasza”
7. ALAP TŰZFAL (biztonság)

Mi az INPUT lánc?
Az INPUT lánc azokra a csomagokra vonatkozik, amik:
• a szerverednek szólnak
• nem csak átmennek rajta
Pl:
• SSH kapcsolat
• ping a szerverre

1. SSH engedélyezése
iptables -A INPUT -p tcp --dport 22 -j ACCEPT
Kapcsolónként:
• -A INPUT
→ szabály hozzáadása az INPUT lánchoz
• -p tcp
→ TCP protokoll (SSH ezt használja)
• --dport 22
→ cél port = 22 (SSH port)
• -j ACCEPT
→ engedélyezd

Emberi nyelven:
„Engedd be a szerverre az SSH kapcsolatokat”

2. Ping engedélyezése
Bejövő ping
iptables -A INPUT -p icmp --icmp-type echo-request -j ACCEPT
Kapcsolónként:
• -p icmp
→ ICMP protokoll (ping)
• --icmp-type echo-request
→ ping kérés
• -j ACCEPT
→ engedd be

Kimenő válasz
iptables -A OUTPUT -p icmp --icmp-type echo-reply -j ACCEPT
Kapcsolónként:
• -A OUTPUT
→ kimenő forgalom
• --icmp-type echo-reply
→ ping válasz
• -j ACCEPT
→ engedd ki

Emberi nyelven:
„A szervert lehessen pingelni, és tudjon válaszolni”

Már meglévő kapcsolatok engedélyezése
iptables -A INPUT -m state --state ESTABLISHED,RELATED -j ACCEPT
Kapcsolónként:
• -A INPUT
→ INPUT lánc
• -m state
→ állapot alapú vizsgálat
• --state ESTABLISHED,RELATED
→ csak már létező kapcsolatok
• -j ACCEPT
→ engedd be
Minden más tiltása
iptables -P INPUT DROP
Kapcsolónként:
• -P INPUT
→ alapértelmezett szabály az INPUT láncra
• DROP
→ dobja el

Mit csinál?
Ha egy csomagra nincs külön ACCEPT szabály, akkor:
FONTOS SORREND!
iptables felülről lefelé nézi a szabályokat
Ezért:
1. SSH 
2. ping 
3. established 
4. DROP 
Ha fordítva lenne:
❌ semmi nem működne

Szabályok ellenőrzése
iptables -L
iptables -L -t nat

Mentés
netfilter-persistent save
netfilter-persistent reload
vagy
iptables-save
iptables-save > /etc/iptables/rules.v4


Web- és adatbázis-kiszolgálók telepítése, beállítása
Minimális, de működő Apache2 + PHP + MySQL/MariaDB rendszer Debian 13-on
Ez a legkisebb működő verzió.
Nincs benne VirtualHost, phpMyAdmin, extra biztonsági finomhangolás, HTTPS, .htaccess, külön domain.
Csak az, ami kell ahhoz, hogy:
Apache fusson
PHP működjön
Adatbázis fusson
PHP tudjon kapcsolódni az adatbázishoz
Böngészőből működjön a tesztoldal

1. Rendszer frissítése
sudo apt update
sudo apt full-upgrade -y

2. Apache2, PHP és MySQL/MariaDB telepítése
sudo apt install -y apache2 php libapache2-mod-php php-mysql default-mysql-server
Ez felrakja:
apache2 - webszerver
php - PHP futtatás
libapache2-mod-php - Apache PHP modul
php-mysql - PHP adatbázis-kapcsolat MySQL/MariaDB felé
default-mysql-server - MySQL-kompatibilis adatbázis-szerver, Debianon MariaDB

3. Szolgáltatások indítása
sudo systemctl enable --now apache2
sudo systemctl enable --now mariadb
Ellenőrzés:
sudo systemctl status apache2 --no-pager
sudo systemctl status mariadb --no-pager

4. Apache + PHP működés tesztelése
Hozz létre egy PHP tesztfájlt:
echo "<?php phpinfo(); ?>" | sudo tee /var/www/html/info.php
Jogosultság beállítása:
sudo chown www-data:www-data /var/www/html/info.php
sudo chmod 0644 /var/www/html/info.php
Nyisd meg böngészőben:
http://SZERVER_IP_CIME/info.php
Vagy szerveren:
curl http://localhost/info.php
Ha PHP infó oldalt látsz, akkor az Apache + PHP működik.
Utána törölheted:
sudo rm /var/www/html/info.php

5. Adatbázis létrehozása
Lépj be az adatbázisba:
sudo mariadb
Hozd létre az adatbázist:
CREATE DATABASE app_db CHARACTER SET utf8mb4 COLLATE utf8mb4_unicode_ci;
Hozz létre külön felhasználót:
CREATE USER 'app_user'@'localhost' IDENTIFIED BY 'Er0s_Jelszo_123!';
Adj neki jogot az adatbázishoz:
GRANT ALL PRIVILEGES ON app_db.* TO 'app_user'@'localhost';
Jogosultságok frissítése:
FLUSH PRIVILEGES;
Kilépés:
EXIT;

6. Adatbázis tesztelése
Lépj be az új felhasználóval:
mariadb -u app_user -p app_db
Jelszó:
Er0s_Jelszo_123!
Hozz létre egy teszttáblát:
CREATE TABLE users (
    id INT AUTO_INCREMENT PRIMARY KEY,
    name VARCHAR(100) NOT NULL,
    email VARCHAR(150) NOT NULL UNIQUE,
    created_at TIMESTAMP DEFAULT CURRENT_TIMESTAMP
);
Tegyél bele adatot:
INSERT INTO users (name, email) VALUES
('Teszt Elek', 'teszt@example.com'),
('Minta Béla', 'minta@example.com');
Listázd ki:
SELECT * FROM users;
Kilépés:
EXIT;

7. PHP adatbázis-kapcsolat tesztoldal
Hozd létre az index.php fájlt:
cat <<'EOF' | sudo tee /var/www/html/index.php
<?php
$dsn = 'mysql:host=localhost;dbname=app_db;charset=utf8mb4';
$user = 'app_user';
$password = 'Er0s_Jelszo_123!';

try {
    $pdo = new PDO($dsn, $user, $password, [
        PDO::ATTR_ERRMODE => PDO::ERRMODE_EXCEPTION,
        PDO::ATTR_DEFAULT_FETCH_MODE => PDO::FETCH_ASSOC,
    ]);

    $stmt = $pdo->query('SELECT * FROM users');
    $users = $stmt->fetchAll();

    echo '<h1>Apache + PHP + MySQL működik</h1>';

    foreach ($users as $user) {
        echo '<p>' . htmlspecialchars($user['name']) . ' - ' . htmlspecialchars($user['email']) . '</p>';
    }
} catch (PDOException $e) {
    http_response_code(500);
    echo '<h1>Adatbázis hiba</h1>';
    echo '<pre>' . htmlspecialchars($e->getMessage()) . '</pre>';
}
EOF
Jogosultság:
sudo chown www-data:www-data /var/www/html/index.php
sudo chmod 0644 /var/www/html/index.php
Apache újraindítása:
sudo systemctl restart apache2

8. Végső teszt
Böngészőben:
http://SZERVER_IP_CIME
Vagy szerveren:
curl http://localhost
Ha ezt látod, akkor működik:
Apache + PHP + MySQL működik
Teszt Elek - teszt@example.com
Minta Béla - minta@example.com

Minimális teljes parancssor egyben
Ha csak a lényeg kell, ezt kell végigcsinálni:
sudo apt update
sudo apt full-upgrade -y
sudo apt install -y apache2 php libapache2-mod-php php-mysql default-mysql-server
sudo systemctl enable --now apache2
sudo systemctl enable --now mariadb
sudo mariadb
CREATE DATABASE app_db CHARACTER SET utf8mb4 COLLATE utf8mb4_unicode_ci;
CREATE USER 'app_user'@'localhost' IDENTIFIED BY 'Er0s_Jelszo_123!';
GRANT ALL PRIVILEGES ON app_db.* TO 'app_user'@'localhost';
FLUSH PRIVILEGES;
EXIT;
mariadb -u app_user -p app_db
CREATE TABLE users (
    id INT AUTO_INCREMENT PRIMARY KEY,
    name VARCHAR(100) NOT NULL,
    email VARCHAR(150) NOT NULL UNIQUE,
    created_at TIMESTAMP DEFAULT CURRENT_TIMESTAMP
);

INSERT INTO users (name, email) VALUES
('Teszt Elek', 'teszt@example.com'),
('Minta Béla', 'minta@example.com');

EXIT;
cat <<'EOF' | sudo tee /var/www/html/index.php
<?php
$dsn = 'mysql:host=localhost;dbname=app_db;charset=utf8mb4';
$user = 'app_user';
$password = 'Er0s_Jelszo_123!';

try {
    $pdo = new PDO($dsn, $user, $password, [
        PDO::ATTR_ERRMODE => PDO::ERRMODE_EXCEPTION,
        PDO::ATTR_DEFAULT_FETCH_MODE => PDO::FETCH_ASSOC,
    ]);

    $stmt = $pdo->query('SELECT * FROM users');
    $users = $stmt->fetchAll();

    echo '<h1>Apache + PHP + MySQL működik</h1>';

    foreach ($users as $user) {
        echo '<p>' . htmlspecialchars($user['name']) . ' - ' . htmlspecialchars($user['email']) . '</p>';
    }
} catch (PDOException $e) {
    http_response_code(500);
    echo '<h1>Adatbázis hiba</h1>';
    echo '<pre>' . htmlspecialchars($e->getMessage()) . '</pre>';
}
EOF

sudo chown www-data:www-data /var/www/html/index.php
sudo chmod 0644 /var/www/html/index.php
sudo systemctl restart apache2
Végső próba:
curl http://localhost
Ennyi a minimum működő LAMP rendszer Debian 13-on.

Tűzfal
nftables, ufw
Mi az UFW?
Az UFW (Uncomplicated Firewall) egy egyszerű Linux tűzfal.
Feladata:
• bejövő és kimenő forgalom szabályozása
• portok nyitása / zárása
• hálózati biztonság növelése

Alap működés
A tűzfal szabályok alapján dönt:
• allow → engedélyez
• deny → tilt
Két irány:
• incoming → bejövő forgalom
• outgoing → kimenő forgalom

1. UFW telepítése
sudo apt update && sudo apt install -y ufw
Mit csinál:
• telepíti a tűzfal kezelő eszközt

2. Tűzfal bekapcsolása
sudo ufw enable
Mit csinál:
• aktiválja a tűzfalat
• azonnal életbe lépnek a szabályok

3. Alap szabályok beállítása
Bejövő tiltása:
sudo ufw default deny incoming
Mit csinál:
• minden bejövő kapcsolat tiltva lesz
• csak amit külön engedélyezel az mehet

Kimenő engedélyezése:
sudo ufw default allow outgoing
Mit csinál:
• a szerver kifelé kommunikálhat

4. Alap szolgáltatások engedélyezése
SSH (távoli elérés):
sudo ufw allow 'OpenSSH'
Mit csinál:
• megnyitja a 22-es portot
• tudsz csatlakozni SSH-val

Apache (webszerver):
sudo ufw allow 'Apache Full'
Mit csinál:
• megnyitja:
• 80 → HTTP
• 443 → HTTPS

5. Szabályok ellenőrzése
sudo ufw status numbered
Mit mutat:
• aktív szabályok listája
• sorszámozva
Példa:
Status: active

[1] OpenSSH       ALLOW IN    Anywhere
[2] Apache Full   ALLOW IN    Anywhere

6. Szabály törlése
Sorszám alapján:
sudo ufw delete 1
UFW kikapcsolása
sudo ufw disable

10. Gyakori hibák
• nincs engedélyezve SSH → kizárod magad
• Apache nincs engedélyezve → nem jön be az oldal
• rossz irány (IN/OUT)
• elfelejtett default szabály
Tűzfal megvalósítása nftables-szel

Mi az nftables?
Az nftables a Linux modern tűzfalrendszere.
Feladata:
• hálózati forgalom szűrése
• portok kezelése
• NAT (címfordítás)
Előnye:
• gyors
• átlátható
• egyben kezeli IPv4 és IPv6-ot

Előfeltételek
Mielőtt elkezded:
• Linux (Debian / Ubuntu)
• sudo jog
• hálózati interfészek ismerete
Ellenőrzés:
ip a
Példa:
• enp0s3 → internet (WAN)
• enp0s8 → belső háló (LAN)

1. nftables telepítése
sudo apt update && sudo apt install -y nftables

2. Szolgáltatás kezelése
Állapot:
systemctl status nftables
Indítás:
sudo systemctl start nftables
Automatikus indulás:
sudo systemctl enable nftables

3. Jelenlegi szabályok megtekintése
sudo nft list ruleset

4. Alap tűzfal létrehozása
Táblázat létrehozása
sudo nft add table inet filter

INPUT lánc (bejövő forgalom)
sudo nft add chain inet filter input { type filter hook input priority 0 \; }

OUTPUT lánc (kimenő)
sudo nft add chain inet filter output { type filter hook output priority 0 \; }

FORWARD lánc (továbbítás)
sudo nft add chain inet filter forward { type filter hook forward priority 0 \; }

5. Alap szabályok (nagyon fontos)
Loopback engedélyezése
sudo nft add rule inet filter input iif "lo" accept
Mit csinál:
• saját gép kommunikáció működik

Meglévő kapcsolatok engedélyezése
sudo nft add rule inet filter input ct state established,related accept
Mit csinál:
• válasz csomagok visszajöhetnek

6. Alap szolgáltatások engedélyezése
SSH
sudo nft add rule inet filter input tcp dport 22 accept

HTTP
sudo nft add rule inet filter input tcp dport 80 accept

HTTPS
sudo nft add rule inet filter input tcp dport 443 accept

7. Ping (ICMP) engedélyezése
sudo nft add rule inet filter input icmp type echo-request accept

8. DHCP engedélyezése
sudo nft add rule inet filter input iifname "enp0s8" udp dport 67 accept
sudo nft add rule inet filter input iifname "enp0s8" udp dport 68 accept
Mit csinál:
• IP cím kiosztás működik

9. DNS engedélyezése
sudo nft add rule inet filter input iifname "enp0s8" udp dport 53 accept
sudo nft add rule inet filter input iifname "enp0s8" tcp dport 53 accept

10. Minden más tiltása
sudo nft add rule inet filter input drop

11. NAT (internet megosztás)
1. IP forward bekapcsolása
sudo sysctl -w net.ipv4.ip_forward=1
Tartós:
echo "net.ipv4.ip_forward=1" | sudo tee /etc/sysctl.d/99-ip-forward.conf

2. NAT tábla létrehozása
sudo nft add table ip nat

3. Postrouting lánc
sudo nft add chain ip nat postrouting { type nat hook postrouting priority 100 \; }

4. Masquerade szabály
sudo nft add rule ip nat postrouting oifname "enp0s3" ip saddr 192.168.12.0/24 masquerade
Mit csinál:
• belső hálózat internetet kap

12. Forward szabályok
Belső → internet
sudo nft add rule inet filter forward iifname "enp0s8" oifname "enp0s3" accept

Válasz visszaengedése
sudo nft add rule inet filter forward ct state established,related accept

13. Szabályok mentése
sudo nft list ruleset | sudo tee /etc/nftables.conf

14. Újratöltés
sudo systemctl restart nftables

Gyakori hibák
• rossz interfész név (enp0s3 vs enp0s8)
• nincs ip_forward → nincs net
• nincs forward szabály → nincs net
• nincs NAT → nincs net
• túl korán van a drop szabály
Teljes működő kód
sudo nft flush ruleset

sudo nft add table inet filter

sudo nft add chain inet filter input { type filter hook input priority 0 \; }
sudo nft add chain inet filter output { type filter hook output priority 0 \; }
sudo nft add chain inet filter forward { type filter hook forward priority 0 \; }

sudo nft add rule inet filter input iif "lo" accept
sudo nft add rule inet filter input ct state established,related accept

sudo nft add rule inet filter input tcp dport 22 accept
sudo nft add rule inet filter input tcp dport 80 accept
sudo nft add rule inet filter input tcp dport 443 accept

sudo nft add rule inet filter input icmp type echo-request accept

sudo nft add rule inet filter input iifname "enp0s8" udp dport 67 accept
sudo nft add rule inet filter input iifname "enp0s8" udp dport 68 accept

sudo nft add rule inet filter input iifname "enp0s8" udp dport 53 accept
sudo nft add rule inet filter input iifname "enp0s8" tcp dport 53 accept

sudo nft add rule inet filter input drop

sudo sysctl -w net.ipv4.ip_forward=1

sudo nft add table ip nat
sudo nft add chain ip nat postrouting { type nat hook postrouting priority 100 \; }
sudo nft add rule ip nat postrouting oifname "enp0s3" ip saddr 192.168.12.0/24 masquerade

sudo nft add rule inet filter forward iifname "enp0s8" oifname "enp0s3" accept
sudo nft add rule inet filter forward ct state established,related accept

sudo nft list ruleset | sudo tee /etc/nftables.conf
Levelezési szolgáltatások telepítése, beállítása
ELŐFELTÉTELEK (EZT NE UGORD ÁT)
Kell:
· Debian 12 (NEM 13!) 
· 2 hálózati kártya: 
· enp0s3 → internet (DHCP) 
· enp0s8 → belső háló (STATIC) 
· root jog (sudo) 

🌐 1. HÁLÓZAT BEÁLLÍTÁSA
📌 enp0s8 (belső háló)
sudo nano /etc/network/interfaces.d/enp0s8
auto enp0s8
iface enp0s8 inet static
 address 192.168.12.1
 netmask 255.255.255.0
🔁 Hálózat újraindítás
systemctl restart networking
🧠 Mit csinál:
· 192.168.12.1 → ez lesz a szerver IP-je (gateway + DNS is) 
· minden kliens ehhez fog csatlakozni 

🏷️ 2. HOSTNÉV + FQDN
Rövid név:
sudo hostnamectl set-hostname mail
FQDN + hosts fájl:
cat <<EOF | sudo tee /etc/hosts
127.0.0.1 localhost
192.168.12.1 mail.office.lan mail
EOF
🧠 Mit csinál:
· mail → rövid név 
· mail.office.lan → teljes név (FQDN) 
· /etc/hosts → helyi DNS helyettesítő 

📦 3. iRedMail TELEPÍTÉS
Előkészítés:
apt update && apt install -y gzip dialog
sudo -s
cd ~
Letöltés:
wget https://github.com/iredmail/iRedMail/archive/refs/tags/1.7.4.tar.gz
Kicsomagolás:
tar xzf 1.7.4.tar.gz
cd iRedMail-1.7.4
Telepítés:
bash iRedMail.sh
🧠 Mit telepít:
· levelező rendszer 
· webmail 
· adatbázis (MariaDB) 
· tűzfal (nftables) 

🌐 4. DNS + DHCP (dnsmasq)
Telepítés:
apt install dnsmasq
Saját config:
sudo nano /etc/dnsmasq.d/office.conf
TELJES KONFIG:
# ALAP
port=53
listen-address=127.0.0.1,192.168.12.1
interface=enp0s8

# BIZTONSÁG
domain-needed
bogus-priv
expand-hosts
no-resolv
no-hosts

# KÜLSŐ DNS
server=1.1.1.1
server=8.8.8.8

# DOMAIN
domain=office.lan

# A rekordok
host-record=office.lan,192.168.12.1
host-record=mail.office.lan,192.168.12.1
host-record=backup.office.lan,192.168.12.1

# PTR
ptr-record=1.12.168.192.in-addr.arpa,mail.office.lan

# MX
mx-host=office.lan,mail.office.lan,10

# SPF
txt-record=office.lan,"v=spf1 mx ip4:192.168.12.1 -all"

# SRV
srv-host=_imaps._tcp.office.lan,mail.office.lan,993,0,5
srv-host=_submission._tcp.office.lan,mail.office.lan,587,0,5

# DHCP
dhcp-range=192.168.12.100,192.168.12.200,1h
dhcp-authoritative
Restart:
systemctl restart dnsmasq
🧠 Mit csinál:
· IP-ket oszt (DHCP) 
· neveket old fel (DNS) 
· MX → levelek ide jönnek 
· SRV → kliensek automatikusan beállnak 

🔥 5. NFTABLES (TŰZFAL)
Szabályok listázása:
nft list ruleset

📌 FONTOS PORTOK MEGNYITÁSA
DHCP:
nft add rule inet filter input iifname "enp0s8" udp dport 67 accept
nft add rule inet filter input iifname "enp0s8" udp dport 68 accept
DNS:
nft add rule inet filter input iifname "enp0s8" udp dport 53 accept
nft add rule inet filter input iifname "enp0s8" tcp dport 53 accept
Web:
nft add rule inet filter input tcp dport 80 accept
nft add rule inet filter input tcp dport 443 accept

🌍 6. IP FORWARD + NAT (INTERNET A BELSŐ HÁLÓNAK)
IP forward bekapcsolás:
sudo sysctl -w net.ipv4.ip_forward=1
Tartós:
echo "net.ipv4.ip_forward=1" | sudo tee /etc/sysctl.d/99-ip-forward.conf

NAT:
sudo nft add table ip nat
sudo nft add chain ip nat postrouting { type nat hook postrouting priority 100 \; }

sudo nft add rule ip nat postrouting oifname "enp0s3" ip saddr 192.168.12.0/24 masquerade
🧠 Mit csinál:
· belső gépek → internet 
· IP-t átírja a szerver IP-jére 

FORWARD:
sudo nft add rule inet filter forward iifname "enp0s8" oifname "enp0s3" accept
sudo nft add rule inet filter forward ct state established,related accept

Ping engedély:
sudo nft insert rule inet filter input iifname "enp0s8" icmp type echo-request accept

Mentés:
sudo nft list ruleset | sudo tee /etc/nftables.conf

🌐 7. AUTODISCOVER (KLIENSEK AUTOMATIKUS BEÁLLÍTÁSA)
Mappa:
sudo mkdir -p /var/www/autodiscover/autodiscover
sudo chown -R www-data:www-data /var/www/autodiscover
sudo chmod -R 755 /var/www/autodiscover

XML:
sudo nano /var/www/autodiscover/autodiscover/autodiscover.xml
(beilleszted amit kaptál)

NGINX config:
sudo nano /etc/nginx/sites-available/autodiscover.conf
(beilleszted a configot)

Aktiválás:
sudo ln -s /etc/nginx/sites-available/autodiscover.conf /etc/nginx/sites-enabled/
sudo nginx -t
systemctl restart nginx

🧪 8. TESZTELÉS
DNS:
ping mail.office.lan
DHCP:
· kliens kap IP-t → 192.168.12.100+ 
Internet:
ping 8.8.8.8
Ha ez megy → kész vagy

⚠️ GYAKORI HIBÁK
· nincs ip_forward → nincs net 
· nincs NAT → nincs net 
· dnsmasq nem fut → nincs IP 
· rossz interface név → semmi nem működik 
· nftables nem mentve → reboot után meghal

Felhőszolgáltatás
Amazon Web Services
https://moodle.njszki.hu/pluginfile.php/23012/mod_resource/content/2/aws_webszerver.pdf

jelszó: G1mcI@ZXJZds!eRs5?e3

https://drive.google.com/file/d/1dAUKGV1oul8CiZ_l8EUO7NGEIPKl4wNh/view?usp=sharing
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1. A felhószolgáltatásokról általánosságban
A felhőszolgáltatások területén jellemzően három fó szolgáltatási szintet különböztetünk meg:
· Software as a Service (SaaS) - Szoftver, mint szolgáltatás
· [image: ]Platform as a Service (PaaS) - Platform, mint szolgáltatás
· Infrastructure as a Service (IaaS) - Infrastruktúra, mint szolgáltatás
Software as a Service (SaaS)
A felhő alapú szolgáltatások közül az üzleti ügyfelek számára ez a leggyakrabban használt megoldás. Az SaaS lényege, hogy a hagyományos módszerrel szemben itt nincs szükség szoftver saját szerveren történő telepítésére. Az adott szoftver ugyanis közvetlenül a szolgáltató szerveréről futtatható, és a felhasználó gépére telepített kliensprogram vagy egy böngészőprogram segítségével bármikor és bárhonnan online elérhető és használható.[image: ]
A modell előnye, hogy az összes lehetséges technikai problémát a gyártók kezelik, a felhasználó cég IT csapatának nem kell foglalkoznia a szoftvert kiszolgáló szerverekkel, tárhellyel, verziókövetéssel és a számos, adott esetben eltérő kliens géppel. Vagyis a vállalkozások a SaaS modell segítségével egyszerűsíthetik karbantartást és támogatást, amivel idót és pénzt takarítanak meg.[image: ]
Amikor ez a megoldás hasznos lehet:[image: ]
[image: ]ha startup cégként gyorsan, kis tőkével kell egy szolgáltatást elindítani [image: ]rövid távú proj ektek esetében, amikor együttműködésre van szükség [image: ]nem folyamatosan használt alkalmazások esetén, mint pl. egy adószoftver [image: ]ha az alkalmazásokat webről és mobilról egyaránt fontos elérni
(pl. : Amazon WorkDocs, Zoom, Netflix, Google Apps, Microsoft 365)
Platform 
as 
a 

A felhőplatform szolgáltatás fejlesztők számára nyújt egy olyan keretrendszert, amelyben testreszabott alkalmazásokat hozhatnak létre. A programozók az interneten keresztül érik el a platformot, vagyis nem kell foglalkozniuk a szerverekkel, operációs rendszerrel, tárhellyel, szoftverfrissítésekkel és az infrastrukturával. Arra koncentrálhatnak, amihez a legjobban értenek: a szoftverfejlesztéshez.
A modell további előnye, hogy a fejlesztők speciális, felhőalapú komponenseket építhetnek be a szoftvereikbe. Egyes funkcionalitásokat már készen kapnak, például a webes szolgáltatások és az adatbázis eleve integrálva vannak. Az így fejlesztett programok rendkívül jól skálázhatók lesznek, és nagy lesz a rendelkezésre állásuk is. A projekten számos fejlesztő dolgozhat párhuzamosan, és a fejlesztést, tesztelést, telepítést különféle szolgáltatások segítik. A programozóknak kevesebbet kell kódolni, és nem kell foglalkozni az applikációk üzemeltetésével sem. Vagyis a PaaS modell cégmérettól függetlenül egyszerűsíti és költséghatékonyabbá teszi a szoftverfejlesztést.(pl. 
: 
Amazon 
Relational 
Database 
Service, 

Infrastructure as a Service (IaaS)
Az IaaS szolgáltatás nagymértékben skálázható és automatizált informatikai erőforrásokat kínál a felhasználoja számára. A segítségével telj esen önkiszolgáló rendszerben lehet igénybe venni, illetve monitorozni számítási-, hálózati- és tárhelykapacitást és egyéb szolgáltatásokat. A modell lehetővé teszi, hogy egy cég bármikor IT kapacitáshoz tudjon jutni, és csak azért az erőforrásért fizessen, amit valóban igénybe is vett - mindezt beruházás nélkül[image: ]
[image: ]
Tehát az IaaS valojában szerverkapacitást, tárhelyet, operációs rendszert, hálózatot kínál ügyfeleinek, virtualizációs technológia segítségével. A modell magába foglal minden funkcionalitást, amit egy hagyományos adatközpont biztosít, az eszközök fizikai beszerzése és üzemeltetése nélkül. A teljes rendszert jellemzően egy dashboard felületen vagy API-n keresztül lehet elérni és kezelni: szervereket (processzor telj esítményt és memória kapacitást), tárhelyet és hálózatot igénybe venni és skálázni.[image: ]
Az IaaS keretében jellemzően a szolgáltató menedzseli a szervereket, merevlemezeket, hálózatot, virtualizációt és a tárhelyet, vagy akár az adatbázisokat. Viszont ebben a modellben a szolgáltatás felhasználója is felel bizonyos technikai paraméterekért, mint például az alkalmazásokért és az adatokért.[image: ]
2
Ami az előnyöket illeti, ez a legrugalmasabb felhő alapú modell: a felhasználó teljes kontrollt kap az infrastruktúra felett, saját maga skálázhatja és a költség arányos a felhasznált kapacitással.
[image: ]Az IaaS egyaránt előnyös lehet startupoknak és kisvállalatoknak, mert informatikai beruházás nélkül használhatják a szükséges erőforrásokat. Ugyanakkor nagy cégek számára is hasznos, a teljes kontroll, a gyors skálázhatóság és a használatarányos költségek miatt.
(pl. Amazon Web Services EC2, Goog/e Compute Engine, IBM Cloud)
Három kiilönbözó teriilet
[image: ]Míg egymáshoz hasonló, rövid betúszavakat könnyű összekeverni, a fentiekből látható, hogy valójában egymástól jól megkülönböztethető szolgáltatásokról beszélünk. Hiszen nem mindegy, hogy egy cég felhő alapú szerver és tárhely kapacitást, online elérhető szoftvereket akar igénybe venni, vagy éppen ilyeneket szeretne fejleszteni magának. A SaaS, PaaS és IaaS rendszerek lehetőségeit ennek ismeretében érdemes mérlegelni.
Amazon Web Services
Az Amazon Web Services (röviden AWS vagy Amazon WS) az Amazon.com által az interneten kínalt szolgáltatások gyűjteménye, amelyek egy felhő alapú platformot alkotnak. A legismertebb szolgáltatasok például az S3 és az EC2. A szolgáltatás nagyon nagy számítási kapacitást szolgáltat[image: ]
Az Amazon Web Services jelenleg (2025. augusztusi adatok szerint) 37 földrajzi régióban érhető el világszerte. Ezek mindegyike több elerhetőségi zónát (Availability Zones) tartalmaz, melyek magas rendelkezésre állást és hibaelhárítást biztosítanak.
Az AZ-k az AWS szolgáltatásait biztosító adatközpontok. Az elérhetőségi zónák egymástól el vannak különítve, hogy az kiesések ne terj edhessenek át másik elérhetőségi zónára. Több AWS szolgáltatás működik több elérhetőségi zónában, például az S3 és a DynamoDB, más szolgáltatásokat lehet ugy konfigurálni, hogy több elérhetőségi zóna között replikálódj anak az adatok.
2. AWS regisztráció
Az oktatónak megadott e-mail címre - miután az oktató felvette a tanulót a kurzusba - érkezni fog egy megerősítő e-mail az AWS-től. Az e-mailben található egy link, melyre rákattintva megerősíthető a meghívás, és elvégezhető a regisztráció.
2.1 
Az 
https://www.awsacademy.com/vforcesite/LMS 

jelentkezzünk be a regisztrációkor megadott e-mail címmel és jelszóval

2.2 Az AWS kezd6felülete
Bejelentkezés utån az alåbbi felület fogad. Itt låtjuk a „Vezér16pult" (Dashboard) fülön azokat a kurzusokat, amelyekhez az oktat6 hozzårendelt.
[image: ]
vålasszuk ki azt a kurzust (ha több van), amelyet az oktatö meghatåroz a tan6rai feladatokhoz
A kurzus kivålasztåsa utån az alåbbi felületet kapjuk:
	
	Modules
Grades
Lucid (Whiteboard)
	AWS Academy Learner Lab
academy
AWS Academy Learner Lab provides a long-running sandbox environment for ad hoc exploration ofAWS services. Within this class. students will have access to a restricted set ofAWS services. Not all AWS documentation walk-through or sample labs that operate in an AWS Production account will work in the Leamer Lab environment. You will retain access to the AWS resources set up in this environrnent for the duration of this course. We limit your budget (S50USt)). so you should exercise caution to prevent charges that will deplete your budget too 	If you exceed your budget. you will lose access to your environment and lose all of your work.
Each session lasts for 4 hours by default. although you can extend a session to run longer by pressing the start button to reset your session timer. At the end of each session, any resources you created persist However, we automatically shut EC2 instances down. Other resources, such as ROS instances, keep running- Keep in mind that we do not stop some AWS features, so they can still incur charges between sessiorw. For example, an Elastic Load Balancer or a NAT. You may wish to delete those types of resources and recreate thern as needed to test your work during a session. You will have access to this environment for the duration of the class that you are enrolled in. When the class ends. your access to the learner lab will also end.
Educator / Teacher Only
This sandbox is for eåxator designed project work. lab exercises, or practice that is created and tested within Learner Lab.
	View Course Stream
View Course Calendar
View Course Notifications
To Do
Nott-ing now
Recent Feedback t"thing now

	
	
	
	

	Dashboard
	
	
	

	Courses
	
	
	

	Calendar
	
	
	

	Inbox
	
	
	

	History
	
	
	

	
	
	
	


vålasszuk a „Modules" menüpontot
	• AWS Academy Learner Lab
Launch AWS Academy Learner Lab [image: ]


[image: ]kattintsunk a „Launch AWS Academy Learner Lab' menüpontra
2.3 Laborgyakorlat indítása
[image: ]
A laborgyakorlatok négy óra időtartamúak. A négy óra elteltével a laborgyakorlat automatikusan leáll! Ha a feladatot befejeztük, minden alkalommal az „End Lab”-bal állítsuk le laborgyakorlatot! A laborgyakorlatban készített feladataink nem fognak elveszni a négy óra elteltével, csak leállítja a működésüket a rendszer. A „Start Lab”-bal ujraindíthatjuk a laborgyakorlatot, és ujra lesz négy óránk, valamint az elkezdett feladatainkat folytathatjuk!
Költségek:[image: ]
[image: ]A kurzus végéig 50$ keret áll rendelkezésünkre! Ezt természetesen a tanulóknak nem kell kifizetni, az oktatás ideje alatt ingyenesen használhatjuk az AWS-t! Viszont a 50$ keretnek bele kell férni a kurzus időtartamába! Azaz okosan kell gazdálkodni a költségkerettel!
Alapszabályok:[image: ]
[image: ]Használjunk alacsony költséggel járó eszközöket és szolgáltatásokat!
[image: ]Az AWS-ben végzett gyakorlás után mindig állítsuk le az elindított szolgáltatásokat! [image: ]Az AWS-ben végzett gyakorlás után mindig állítsuk le a laborgyakorlatot!
[image: ]A már nem szükséges szolgáltatásokat töröljük! A laborgvakorlat telies alaphelyzetbe [image: ]állításához használiuk a „Reset” lehetőséget!
kattintsunk az AWS linkre, miután zöldre váltott
I
	Sea.ch	t.nted 	Virg") •
	[image: ]q 	(N. 	[image: ]
Console Home
Recently visited
Region: US East (N, Virginia)
[image: ]
NO recently visited services
	Explore one of these con-unanly visited AWS service	No applications
Get started by creating an application.
	EC2	SS Aurora and ROS Lambda
Create application
	V.ew all services	Go to myApplications


kattintsunk a „View all services"-re
	
	All services
Services by category
Compute
Lambda
Batch
Easti,: Burr-stalk
Application
AWS
EC2
	AWE 	Runn•r
AN'S Sims-paca 'Weave
Para'"i
EC2
Containers
Eastk
E'%tk sat Openstlitt 	on aw•s
East}: CantSrer
Storage
Gateway
AWE
ASVS Elastic Disaster
Database
	Aurora 	ROS
Neptune
Amaz:c«-.
Tlnwsrern
Z.tnarnoOB Aurora OSQL
Anuzcn
Migration Transfer
	AWS 	Scrv*ce
Fanuty
AWS snow oat*gnc
Transform
AFS
Elasb.: VMnre S-xvici
Networking & Content Delivery
Cc.-.o:t
AV.'S Oata Trmster
Agg./.icat;ort
	Developer Tools
x.u,y
ZWS 	Studio
AVIS
CodeAJtit.:t
Amazon Q 	thcludlng
CodeWhisperer)
Customer Enablement
Services
AVIS
Robotics
Blockchain
Amano
Satellite
Ground Staun Quantum Technologies
Arnazcn Ecaket
Management Governance
AVIS
A'WS
Catalog
Yanagcs
Trusted
CM rot Tewø
A'WS Will Architcctoci
Amaznn Q 	ire
Cvov.•iaAy AWLS Cha,tbctl
Wizu•d
AVIS
& Editor
Arnazcc
A'WS
AWS Heath
AVIS
AVIS user Naotlcaöot-r;
AVIS License Manager
"VS Resource
Serwce Q,t-otas
Media Services
MediaStn,ce
MediaTaLcr
Eternental 	Sattware
ELMO: Trarrzoder
Arnazcc int«actve Video
Deadline Cloud
Modi•Connect
	Machine Learning
kna.zon 	Ai
Oe.C•p; Guru
Ennon
F,xccast xmaznn
Kendra
Pally
Textro,tt
Tcmscrib'•
Re-nann Translate
AVIS
AWS
AVIS Paoyarna
Manitrnn
AWS
Asmazan L.o*aut tu
I-ouout tu Laxanut tu mann Q
AWS ecdrock: Bedrock
Xmaznn Q
Xenazan Ae-nazon
ÅWS
Analytics
X.•-nazan
O*f9S.axch Scr•40Z
nata
AVIS Lab* Furna•to•-.
MSX
AV.'S 	OataBreo
Xtnazon
Apache Funk
EMR AWS knazan AWE
»•naznn Data
DataZone
Security, Identity, Compliance
Secrets Manager
X•-naan Insoector
X•mamn
IAM lifntity Center
V•.4anager
*anagc-ncnt Servin
Oirectncy zWS 	Manager
aws
Octect' w
Securety Lake
WAF Shild
AWS Audit
Security 	CSFM
Seculfty
AV.'S Prfvz• CertiftGte
AVIS Payment
AV.'S 	Incident Rct@nnse
	Cloud Financial Mmagement
AWS
	A',vs 	C,x-.ductor
Billing area Cast
Front-end web & Mobile
ARS App-sync
Faun
Location
Application Integration
St. Functions
	Simolo 	SEVEe
Simple Quwe
AWS 82B Ceta Mtcrchange EvmtBri* business Applications
Canoe-ct
Chi-ne
En•.ail
WaüOøcs
'WaONaL
	AWS 	cram
Arnazon
Arnaaon One Enterpriw aws
AWS
AWS Erd
Amazon Chi-ne
End user Computing
AæStrearn 2.0
Thin Client
War E-Soaces See Ufe
Internet of Things
I AT Analyn,c;
iaT
10 T
AWS
Game Development
Carrx-L'tt
An-non CanuL.itt Stre%TrG


itt låtjuk az AWS szolgåltatåsait
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3. VPC (Isolated Cioud Resources)
Létrehozhatunk az AWS-ben egy logikailag elkülönített részt, ahol futtathatjuk az erőforrásainkat egy általunk előre meghatározott virtuális hálózatban. A VPC-k hálózati konfigurációját testreszabhatjuk, valamint több biztonsági réteget is alkalmazhatunk.
[image: ]A virtuális hálózat paraméterei lehetnek:
· IP tartományok
· alhálózatok
· átjárók, routing táblák stb.
A VPC-k:
· logikailag elkülönülnek a többi VPC-tól
· közvetlenül az AWS fiókhoz kötődnek
· egyetlen régióhoz tartoznak, és több AZ-ra is kiterj edhetnek
A VPC-n belüli alhálózatok:
· a VPC-ket felosztó IP tartományok
· egyetlen AZ-hoz tartoznak
· lehet nyilvános, vagy privát
A VPC IP címzése:
· a VPC létrehozásakor hozzárendelünk egy IPv4 CIDR blokkot (privát cím)
[image: ]
· a legnagyobb blokk méret: / 16
[image: ]- a legkisebb blokk méret: /28[image: ]
· a VPC létrehozása után a címtartományt módosítani már nem lehet
· az IPv6 is támogatott (más blokk méretekkel)[image: ]
· az alhálózatok CIDR-blokkjai nem fedhetik át egymást
Hozzunk 

a keresőben keressünk rá a VPC-re, és a listából válasszuk ki a VPC-t
I
	
	VPC dashboard
[image: ]
Virtual private cloud
your vpcs
Subnets
Route tables
Internet gateways
Eqreqs-only internet gateways
Carrier gateways
DHCP option sets
Elastic IPS
Managed prefix bsts
NAT gateways
Peering cM1nections
Route servers New
	[image: ]
Resources by Region
You are using the followtinq Amazon VPC resources
See all regions
See all regions
Route Tables
See all regions
internet fatewap
See all regions
	N. Virginia 1
N. Virginia 6
N. Virginia 1
N. Virginia I
	regions

VPC Peering Connections
See atl regions
Network ACL
See all regions
Securi!y Grog"
See all regions
	C Refresh Resources
N. Virginia g
N. Virginia O
[image: ]N. Virginia 1
M. Virginia I
	[image: ]
Settings

VPCAdditional 

All VPC
[image: ]
Foruns	[image: ]	[image: ]	[image: ]
Report issue	[image: ]
[image: ]
[image: ]

	
	
	
	
	
	
	


kattintsunk a „Create VPC"-re[image: ]
	vpc > your vpcs > create vpc	[image: ]
	

	[image: ]


kattintsunk a , VPC only"-ra
	vpc > Your VPCs > Create VPC

	Create VPC Info
A VPC is an isolated portion of the AWS Cloud populated by AWS objects, such as Amazon EQ instances.
VPC settings
Resources to create Info
Create only the VPC resource or the VPC and other networking resources.
	O VPCon1y	C) VPC and more
Name tag - optional
Creates a tag with a kcy ot •Name' and a valuc that you specify.
vpc-web-server
IPv4 CIDR block Info
O IPv4 CIDR manual input
	0 IPAM-a110cated 	CIDR block
IPV4 CIDR
10.10.0.0/16
CIDR block size must bc between / 16 and 128.
IPv6 CIDRbtock info
O No IPv6 CIDR block
0 IPAM-a110catedlPv6 CDR block O Amazon-provided IPV6 CIDR block
C) IPv6 CIDRowned by me
Tenancy Info
Default
Tags
A tag is a label that you assign to an AWS resource. Each tag consists of a key and an optional value. You can use tags to search and filter your resources or track your AWS costs.
	Key	Value - optional
Q Name
Add tag
You can add 49 more tags

		Cancel	Preview code
	Create VPC
	


konflguråljuk a VPC-t a képen låthat6 m6don kattintsunk a „Create VPC"-re
	
	vpc > yourVPCS > vpc-0210bf6A798370777
VPC dashboard <	@ Vou q_xcess/uuy created vpc021CH6a7983707a7 / voc-web-serm
vpc-0210bf6a7983707a7 / vpc-web-server
EC2 Global View
vpc
Details
Virtual private cloud	State
Your	vpc-0210bf6a7985707a7	@Available
Subnets	ONS	Tenancy
Route tables	Enabled
nternet gat%ays	Main network ACL	Default vpc
Egress-only hternet	No gateways
	(Network border VOup)	Network Address usage metrics
Carrier gateways	DisaNed
DHCP option
Elastic IPS
	Resource map 	CIDRs	Flow logs	Tags	Integrations
Managed prefix Lists
NAT
Resource map
Peering connections
Route servers New
	VPC	Subnets (O)
Security	your AWS vWtual network	Subrwts within this VPC
Network
"pc-web-server groups
	Block Public Access
@off
DHCP option set eopt-07Mb7240f32142e1
CIDR
10.10.0.0/16
	53 	DNS 
Route tables (1)
Route network traffic to res0LJCeS
rtb-0217313f7d9e89533
	DNS hostnames
Main route table rtb-02173 '3f7d9e89533
rule	Owner
043011324168
Network Connections (O)
C'*u.ections to other
	Show 
	Actions
an details

	I
	
	
	
	
	


kattintsunk a „ Subnets"-re
	
	VPC 	Subnets
VPC dashboard
EQ Gtot»al View by vpc
Virtual private cloud
Your VPCs
Route tables
Internet gateways Egress-only internet
	Subnets (6)
( 
Name
	by 
	tag
	V
	Subnet 10
	State
@Available
@Available
@Available @AuaiWe
@Avail.ble
	vpc
4bb56esafb92.t94c'8
.0bbS6esafb92494d8
-ObbS6e5atb92494d8
-Obb56.e5afb92494d8
	Publie„.
	v
	IPv4 OOR
172.31.160/20
172.31.480'20
17231.00/20
17231.320/20
	

	
	
	
	
	
	
	
	
	
	
	
	
	


qateways kattintsunk a „Create subnet" -re
	VPC > Subnets 	Createsubnet
Create subnet
VPC vpc
a VOC vpc-ObbS6e3afb92494dB
Select a VP'C first to create r,ew subnets.
Add new subnet
	(defaLAt)
	Cancel


vålasszuk ki a fent létrehozott VPC-nket
	Subnet settings
Specify the CIDR blocks and Availability Zone for the subnet.
Subnet I Of I
Subnet name
Create a ta9 with a key of 'Name' and a value that you specify.
sub net-web-server
The name can be up to 256 characters tong.
Availability Zone Info
Choose the zone in which your subnet wilt reside, or tet Amazon choose one for you. United States (N. Virginia) / usel-azl (us-east-I c)
	IPva vpc 	block info
	Choose the VPC's IPv4 CIDR block for the subnet. The subnet's iPv4 CIOR 	within this block.
10.10.0.0/16
IPv4 subnet CIDR block
	10.10.1.0/24


[image: ]
[image: ]
	Cancel
	[image: ]


	I 	[image: ]
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Subnet name: subnet-web-server
Availability Zone: vålasszuk az „azl " ID-jü z6nåt
IPv4 VPC CIDR block: csak azt a blokkot tudjuk kivålasztani, amit fentebb mår létrehoztunk
IPv4 subnet CIDR block: 10.10.1.0/24
A paraméterek megadåsa utån kattintsunk a „Create subnet"-re!
	WC > Subnets
VPC dashboard
EC.2 Global View by vpc
Virtual private cloud
Your vpcs
Subnets
Route tables
Internet gateways
Egress-only internet gateways
Carrier gateways
DHCP option sets
Elastic IPS
Managed prefix lists
NAT gateways
Peering
Route servers
	[image: ]
Q Find subnets by attribute Or rag
	Name	Subnet JD	State	vpc	Block Public...	I IPv6CiDR	I tpv6
	Subnet-web-server	subnet-Oß7b8f94e3f01b(H9	@Available	10.10.1.0/24


kattintsunk az „lnternet gateways"-re
	VPC > Internet gateways
	Internet gateways (1) Info
Q Find inurnet gateways by attribute or tag
	Name	V
	Internet gateway ID
	V
	State
@Attached
	v
	vpc ID
	V
	

	VPC dashboard <
EC2 Global View
Filter by VPC
Virtual private cloud
Your vpcs
Subnets
Route tables
Internet gateways
Egress-only internet gateways
Carrier gateways
DHCF Option sets
Elastic I Ps
Managed prefix lists
NAT gateways
Peering connections
Route servers New
	
	
	
	
	
	
	
	OwnU
04301152416b


kattintsunk a ,Create internet gateway"-re
		VPC > Internet gateways 	Create internet gateway
	

	Create internet gateway Info
An internet gateway is a virtual router that connects a VPC to the internet, To createä new internet gateway specify the name forthegateway below.
Internet gateway settings
Name tag
Creates a tag with a key of'Name' and a value that you specify.
igw-wed-seruer
Tags - optional
A tag is a label that you assign to an AWS resource. Each tag consists of a key and an optional value. You can use tags to search and filter your resources cr track your AWS costs.
Value - optional
	Q Name	X 	Q igw-web-server	x QED
Add new tag
You can add 49 more tags.
Cancel
	eeate internet gateway


a „Name tag" legyen: igw-web-server kattintsunk a „Create internet gateway"-re
	[image: ]
VPC dashboard <
[image: ]
Your VPCs
Route tables
Internet gateways
Egress-only internet gateways
Carrier gateways
	[image: ]
[image: ]


[image: ]
az „Available VPCs"-nél vålasszuk ki az åltalunk létrehozott VPC-t, majd kattintsunk az
„Attach internet gateway"-re
	VPC dashboard
EQ Global View
Filter by vpc
Virtual private cloud your vpcs
Route tables
Internet gateways
Egress-only internet gateways
Carrier gateways
DHCP option sets
Elastic
Managed prefix lists
NAT gateways
Peering conn«tion5
Route servers New
	igw-046cceb72604fdbb7
@ Internet gateo•ay igw.046cceb72Ø4fdbb7 successfully attached to vpc-0210bf6a7983707a7
Notifications 00 6 0 igw-046cceb72604fdbb7 / igw-web-server
Details
Internet gateway ID tgw-046cceb72604fdbbI	@Attached
Q Search MOs
Value low-web-server
	00 00
	043011324168
	Actions
Manage tags


kattintsunk a „Route tables"-re
	VPC > Route tables
VPC dashboard
EC2 	View
by VPC
Virtual private cloud
Your VPC%:
Subnets
Route tables
Intemet gateways
Egress-only internet gateways
Carrier gateways
DHCP option sets
Elastic
Managed prefix lists
NAT gateways
Peering connections
Route Servers New
	Route tables (2)
Q Find route tables by attribute or tag
Name
	table ID
	V
	Explicit subnet
	V
	Edge associations
	Main
	v
	Last
thri a minute ago
vpc	v I Owner ID
010bf6a79S37070	.web•server
-Obb5€esafb92494d8	043011324168


[image: ]e16ször kattintsunk a frissités gombra kattintsunk az åltalunk létrehozott VPC „Route table ID"-j åra
[image: ]
konflguråljuk az uj ütvonalat a képen låthat6 m6don
VPC > Route tat*es ) rtb-02173t3f7d9e89533
@ 
	VPC dashboard 	<	updated route for 	succeshAly
Details
EC2 Global View
	rtb-0217313f7d9e89533	Actions
by vpc
Virtual private cloud
Details
Your VPCs
	Route table ID	Main	Explicit subnet associations	associations
Suhts
	rtb-0217313f7d9e89533	ves
Route table
Owner ID Imernet gatew•ays	vpc-0210bf€ä798370737 1	043011524168
Egress-only internet gateways
	Routes 	Subnet associations	Edge	Route propagation	Tags
Carrier gateways
DHCP option sets
	Routes (2)	Both	Edit routes
Elastic IPS
	Managed 	lists	I-Q Filter routes
	NAT gateways	Destination	V	Target	Status	Propagated	V	Route Origin
	Peering connections	00.00/0	72604 fdbb7	No	Create Route
	Route 	New	10.10.mo,'16	@Active	No	Create Route Table
Security
Network ACL
Security groups kattintsunk a , Security groups" -ra
	VPC > Security Groups
VPC dashboard
EC2 Global View by VPC
Virtual private cloud your vpcs
	Security Groups(2)
Q Arid security groups by 
	Of tog
I Security group ID
	Security group name
default
	vpc ID
	Actions	to CSV
	
	

	
	
	
	
	
	Export security groups 
I Description default VPC security group default VPC security group
	Create security group
I Owner
043011324168


kattintsunk a „Create security group"-ra
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Security 
Description:
V 

ållitsuk be a bejöv6 szabålyokat a képen låthat6 m6don kattintsunk a „Create security group"-ra„lnbound 
résznél 
kattintsunk 
az 
„Add 
rule"-ra

4. EC2 (Virtual Servers in the Cloud)
Az Amazon EC2 (Amazon Elastic Compute Cloud) az Amazon Web Services felh6
platformj ånak központi eleme. Az EC2 lehet6vé teszi a felhasznå16knak, hogy virtuålis gépeket béreljenek, amelyen sajåt alkalmazåsaikat futtathatjåk. Az EC2 lehet6vé teszi alkalmazåsok skålåzhat6 telepitését. A felhasznå16k igényeiknek megfele16en létrehozhatnak, elindithatnak, leållithatnak és törölhetnek szerver példånyokat és Ora-alapü szåmlåzåst kapnak. Az EC2 a szerver régi6 megszabåsåt is engedi, amely lehet6vé teszi a késleltetés optimalizålåsåt és régi6k
4.1 
kattintsunk 
a 
„Launch 
instace"-ra
közötti 

I 
Végezzük el az alåbbi beållitåsokat:
	Launch an instance
Amazon EC2 allows you to creatc virtual machines, or instances, that run on the AWS Cloud. Quickly get started by following the simple steps below.
[image: ]
Name
	linux.web.scrver


Add additional tags
Application and OS Images (Amazon Machine Image)
An AMI contains the operating system, application server, and applications for your instance. If you don't see a suitable AMI below, use the search field or choose
Browse more AM Is.
Q Search our full catalog including 1 OOOs of application and OS Images
Quick Start
	Amazon	macOS	Ubuntu	Red Hat	susE Linux	Debian
Linux
Browse more AMIS
AMIS from aws	ubuntu•	Microsoft	Red'-Ot	AWS. Marketplace and
SUSE
Amazon Machine Image (AMI)
	Dcbian 13 (HVM). SSD volume Type arni-Ob0012dad04fbe3d7 (6a-bit (x86)) / uni-01b1eba8Sc1cd6a3d (6d-bit (Arm)) Virtualization: hvrn ENA ma-bled: Root device type: ebs
	Free tier eligble


Description
Debian 13 (BVM). EBS General purpose (SSD) Volume Type. Community developed free GNU/Linux distribution. https://www.debian.org/
Debian 13 (20250814-2204)
Architecture	AMI 10	Publish Date	Username
	64-bit (x86)


	ami-Ob0012dad04fbUd7 2025-08-14	admin	Verified provider

	Instance type Info I Get advice
Instance type
	t2.medium
Family: t2 2 vCPU 4 GiB Memory Current generation: true
On-Demand Ubuntu Pro base pricing; 0.0499 USO per Hour On-Demand Linux base pricing: 0.0464 LJSD per Hour
On-Demand RHEL base pricing: 0.0752 USO per Hour On-Demand Windows base pricing: 0.0644 USD per Hour On-Demand SuSE base pricing: 0.1464 USD per Hour


All generations
Compare instance types
Additional costs apply for AMIS with pre-installed software

	


	[image: ]
The name can include up to 255 ASCII characters. It can't include leading or trailing spaces.
[image: ]
Key pair type
	
	O RSA
RSA encrypted private and public key pair



	
	O ED25519
ED25519 encrypted private and public key pair





[image: ]Private key file format
O .pem
For use with OpenSSH

	Cancel
	Create key pair


katiintsunk a , create new key pair " linkreeligible) 
tipust 
is)

a legenerålt kulcsot mentsük le a szåmit6gépünkre
I 
	v Network settings Info
Network Info vpc-Obb56e3afb92494d8
Subnet Info
No preference (Default subnet in any availability zone)
Auto-assign public IP Info
Enable
Firewall (security groups) Info
A security group is a set of firewall rules that control the traffic for your instance. Add rules to allow specific traffic to reach your instance.
	O Create security group


· Select existing security group
We'll create a new security group called 'launch-wizard-I' with the following rules:
Allow SSH traffic from	Anywhere
Helps you connect to your instance	0.0.0.0/0
· Allow HTTPS traffic from the internet
To set up an endpoint, for example when creating a web server
· Allow HTTP traffic from the internet
To set up an endpoint, for example when creating a web server
	
	Edit





szerkesszük a hålözati beållitåsokat
	

	v Network settings Info
VPC - required Info
	vpc-021 Obf6a7983707a7 (vpc-web-server)
10.10.0.0/16
	

	Subnet I Info
	

	subnet-087b8f94e3f01 b049 vpc: vpc-02100f6ä7983707a7 OwnE 043011324168 Zone type: Availability Zone [P addresses available: 2S1
	subnet-web-server
Availability Zone: us-east-Ic (usel -azl) OOR: 10.10.1.0/24)


c
Create new subnet
Auto-assign public IP Info
	Disable


Firewall (security groups) I Info
A security youp is a set of firewall rtAes that control the traffic for your instance. Add rules to allow *ecific traffic to reach your instance.
	
	C) Create security group



	
	O Select existing security group





Common security groups i Info
	Select security groups


	security-group-web-server sg-0148d220f25239285 X vpc: vpc-02[image: ]


	[image: ]	Compare security group ru les
Security groups that you edd or rervw•e ha-e will be added to or rernoved from all your network interfaces.
[image: ]
[image: ]
[image: ]
[image: ]
Advanced network configuration


[image: ]


		Configure storage Info	[image: ]	Advanced
[image: ]
@ Click refresh to view backup information	c The tags that you assign determine whether the instance will bc backed up by any Data Lifecycle Manager policies.
[image: ]
O x File systems	Edit


[image: ][image: ]	VPC 	az åltalunk létrehozott VPC[image: ]
Subnet -5 az åltalunk létrehozott subnet
	Firewall (security groups) 	Select existing security group
Common security groups -5 vålasszuk ki az åltalunk létrehozott security group-ot
Configure storage -5 50GB
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[image: ]5
	v Summary
[image: ]
Software Image (AMI) Debian 13 (20250814-2204) ami-Ob0012dad04fbe3d7
Virtual server type (instance type) t2.medium
Firewall (security group) security-group-web-server
Storage (volumes)
1 volume(s) - 50 GiB

		Launch instance


Cancel
Preview code


inditsuk el a felh6ben létrehozott virtuålis gépünket
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	

	Successfully
log
Next Steps
Create billing usage alerts
ro 	costs *Oid sawpose bills, set
Create billing alerts
Create AWS budget
AV.'S Budgets allows to Crete speru take
Create
	Connect to your instance
Once ytxjr instance is 	ioq from 	local
Manage CioudWatch alarms
Create or upote Amazon 
	it
Orms
	Connect an ROS database
Ccnfiqtwe the connection between EQ and a database to
Connect ROS database
Create 	ROS eatat'k'* ream
Disaster recovery for pur instances
the ytx• iu•st into different Zone c. a Off—eit ARS Elastic 1085).
	Disaster 	for 	instances
	Create EBS snapshot policy
Create policy that A'tmnats ti•e retention, etid 	EDS
Monitor for suspicious runtime activities
pu to malicious activity mauthorized betuvk*. *ith real-tune 	Into on-tryst acrog your Anuzon EC2
	for 	runtime
	Manage detailed monitoring
Enable or t%.able detailed 	'o. the
tiu• Amano q•aohs Mth 	perm
instance screenshot
Cawe a screenshot from O'e
Get instance screenshot
	Create Load Balancer
Create aooiic.atioo. 	qate.ay
Get system log
"stem 109 to


létrejött a virtuålis gépünk a felh6ben kattintsunk a „View all instances"-ra
	EC2
Dashboard
EQ 	v-,ew e
Instances
Instane—
Types
Laund Terrv&tes
Spot Requests
Savings mans
Reserved
Dedicated Hosts
Capacity Reservations images
AMI catalog
Elastic Block Store
Lif«ße Manager
Network & Security
Security Groups
Elastic
Placernent Groups
Key pairs
Network Interfates
Load Balancing
Load Balancers
	Instances (1/1) info
	Name' v Instance ID	hi-stance 
	lhux-web-server i-Oe2b1b311 fl eG9e5d	@Gunning 
i-Oe2b1 b311fie69e54 (linux-web-server)
Details I Status and alarms 	Monitoring
Instance summary
ad&esv
Hostname type name: ip- 10-10-1-120.ec2.internai
Answer private resource DNS name
Auto-assigned address
Rote
iMDSv2
	state 
@
Security
	v
	All check 	I Atarm status I Availabilityzøne v I publiclPvaoNS v I 	v
u.medium	@ 3/3 checks passed	View alarms + us-east-1 c
Networking	Storage	Tags
Public IPva address
10.10.1.120
*'stance State	public DNS
@Running
Private IP DNS name (IPva only) ip-10-10-1-120.ea.internai
	type	Elastic
t3.medium
AWS Compute Optimizer finding vpc-0210bt6e/98370ia7 Wpc.eb-server) O Opt-in to AWS Compute Optimizer for recommendations. I Learn rnore
Subnet ID subnet- 087b8f94e3fO 	(sub-opt-web-serve')
Instance ARN	Marvaged
If1e69eS4


5. Elastic IPs
Az elasztikus IP-cim nyilvånos IPv4-cim, amely elérhet6 az internetr61. Ha az instance-nak (példånyånak) nincs nyilvånos IPv4 cime, tårsithatunk hozzå egy elasztikus IPv4-cimet, mely segitségével tudunk kommunikålni az interneten. Ezen cim segitségével tudunk csatlakozni a példånyhoz a helyi szåmit6gépünkr61 Az elasztikus IP-cim statikus, csak egy adott régi6ban
hasznålhat6.
	EQ > inst.nces
hboard
EQ 	View
Events
Instances
Irvstaru.e Types tmanch Templates
Spot Requests
Reserved Instances
Dedirated
Capacity Reservations
• Images
Catalog
Elastic 	Store
Snapshots
Network & Security
Security Groups
Elastic
Placement Groups
Key pairs
Load Balancing
Load Balancers
	Instances (1/1)
b31 Ifl e69e54 (limn-web-server)
	Details 	Status and alarms 
Instarxe summary
instance 10 ivoezb1h31tf1r69e54
addr.ss
Hostname type
Answer private resource ONS rum.
Role
Required
O*ratOr
	@ 
Monitoring
	Instance
Running @ @
Security
	states
	type V	Status check
@ 4/3 
Networking	Storage
public address
Instance state
•p DNS
Instance
vec to
Subnet ID subnet07b8Bae3t01b049 
ARN
	passed
Tags
(subnet-neb-server)
1324168:instance/i.Oe2b 
	I 
View alarms
1b" If1e69eS4
	O 
	CES)
V 	DNS v public 	v 	•p
Private addreø•s
DNS
addresses
AWS Compute Optimizer findinq
@ Opt-in t. AWS Compute Opt'mi:.zer for r«mmodations. I Learn more
Auto Scaling Group

	
	
	
	
	


kattintsunk az „Elastic IPs"-re
	Elastic IP addresses	Allocate EL.stic
	Global	q nnd resource' by 	or
	Instances	Name	Allocated iPv4 addr.„	Type	I Allocation ID	Reverse DNS	Associated instance ID	I private 'P a
	Instances	No Elastic IP addresses found in this Region
Instance Types
Launch Templates
Spot Requests
mans
Reserved
Dejicatei Hosts
Images
Catalog
kattintsunk az „Allocate Elastic IP address"-re
		Flaqir 	Allocate
Allocate Elastic IP address
Elastic IP address settings
Public address pool
	O 	pool Of
	O 	ur 
Network border group
Gioböl static addresses
AWS Gloo.alßccelerato« can provide 9LCL-al static addressE that are announced worldwide 
Create
Tags tag a label that a%ign to retourcp. Fath tag of a and an optionai value. 
	MO Lays 	"tit
Add
	Yau 	up 	t"
	anycast 
can 
	AWS 
tags to 
	pouti
locations This 	availability and tatency tor 
filter your resources or track your AWA
	by users the Amazon globat network. Learn

	
	
	
	
	


[image: ]maradhat minden az alapbeållitåson, kattintsunk az Allocate"-re[image: ]
[image: ]
	EC2 > Elastic IP addresses
EC2
Dashboard
EQ Global View
Instances
Instances
Instance Types
Launch Ternplates
Spot Requests
Savings Plans
Reserved Instances
Dedicated Hosts
Capacity Reservations images
AM's
AMI Catalog
Elastic Block Store
Volumes
Snapshots
Lifecycle Manager
Network & Security
Security Groups
Elastic
Placement Groups
Key pairs
Network Interfaces
	[image: ]
Select an elastic IP address	[image: ]


hozzå kell rendelnünk a példånyunkhoz a lefoglalt IP-t kattintsunk az „Associate this Elastic IP address"-re
	Ea 
	Elastic IP addresses > Associate Elastic IP address
Associate Elastic IP address
Choose the instance or net-work interface to associate to this Elastic address (3.232.235.23
Elastic IP address: 3.232.235.231
Resource type the type of resource mvlctl to awoOate the IP O Instance o Network interface
	If you associate an Elastic IP address with an instance that already has an Elastic IP address associated. the previousty assocoted Elastic IP acfiÉess will be disassociated, but the address wilt still be allocated to 
If private •P address is specified, the Elastic iP address witl be associated with the primary private iP address
	account.


Instance
private IP address
	Ihr pnvarQ addrm.s with 	to 	'tm 	addrr".
Q 10.10.1.120
Reassoeiation
	Specify whether thr Hastic IP address tan 	with a different resource f it already 	With a
C) Allow this Elastic iP address to be reassociated
	Cancel	Associate


vålasszuk ki a fut6 példånyunkat és a privåt IP-t az „Associate" gombbal rendeljük hozzå a példånyunkhoz az IP-t
[image: ]
létrejött a publikus IP cimünk és az összerendelésünk
		EC2	i@nees
	
	
	
	
	

	Dashboard
EC2 Global View
Instances
Instance
Launch Templates
Spot Requests
Savings Plans
Instances
Dedicated Hosts
Capacity Reservations
Images
AMI Catalog
	Instances (1/1) info
Q Find 	by attribute or tag Kase-sensitiw'
	Name 	I i 	D	Instance state v
	linuy-web-server 	i-Oe7b 1b3t If1e69e54	@Running @ @
i-Oe2b1b311 fl e69e54 (linux-web-server)
[image: ]
Instance JD i-Oe2b1b311f1e69e54
address
	I•stance type
Networking
address

	All States
I Status check 	I
@ 3/3 checks passec
Storage	Tags
open address
	Alarm status
View alarms
	AvailabilityZone 	I 	DNS
us-east-1 c
private
10.10.1.120
Public DNS


az „lnstances" fülön a „Details" alatt låthatjuk, hogy a példånyhoz hozzårendeltük az IP-t ha nem jelenne meg a publikus IP-cim, kattintsunk a frissités gombra
I 
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I IO 
6. A DDNS és DDNS cím regisztrálása
A DDNS (Dynamic Domain Name System) egy olyan szolgáltatás, amely lehetővé teszi, hogy egy dinamikus IP-címmel rendelkező eszközt (pl. otthoni router, NAS, IP-kamera stb.) egy állandó és könnyen megj egyezhető domain névhez társítsunk. Ez különösen akkor hasznos, ha az internetszolgáltatónk dinamikus IP-címet oszt ki, amely időnként megváltozik.[image: ]
Hogyan mííködik a DDNS?
Dinamikus IP-cím változása: Az internetszolgáltató idónként uj IP-címet ad az eszközöknek. DDNS kliens frissítés: Egy DDNS kliens, amely általában a router-ben vagy egy külön eszközön fut, értesíti a DDNS szolgáltatót az új IP-címról.
Domain név frissítése: A DDNS szolgáltató frissíti az adott domain nevet, hogy az az új IPcímre mutasson.
Elérés domain név alapján: Mostantól az eszköz elérhető az általunk beállított állandó domain név segítségével.
[image: ][image: ][image: ]Népszeríí DDNS szolgáltatók:
· Dynu DNS (ingyenes és fizetős opciók) - No-IP (ingyenes és fizetős opciók)
· DynDNS (fizetős)
· DuckDNS (ingyenes)	[image: ]
· Cloudflare (DNS funkciók)[image: ]
Előnyök:[image: ]
· állandó hozzáférés az eszközökhöz a dinamikus IP-címek ellenére
· könnyebb távoli hozzáférés, például kamerák, szerverek vagy otthoni hálózat eléréséhez
Nem csak dinamikus, hanem fix, publikus IP-címekhez is használhatunk DDNS nevet!
Jelen esetben a laborgyakorlathoz költséghatékonysági szempontból (nem kell fizetős domain nevet regisztrálnunk) DDNS címet fogunk használni a statikus publikus IP-címünkhöz! A [image: ]DDNSfrissítési funkciója ebben az esetben nem releváns.[image: ]
A fent említett DDNS szolgáltatók közül az egyik legismertebbet, a Dynu DNS-t fogjuk használni, amely a https://www.dynu.com címen érhető el.
Regisztráljuk erre az oldalra, jelentkezzünk be, és folytassuk a telepítést!
mindenki az example- utån a saiåt monogramjåt adja meg kattintsunk az „Add"-ra7. 
DDNS 
cim 
létrehozåsa:

example-bp.ddnsfree.com
Last Update	Wildcard IPV4 Alias ta116zzuk be a kulcsfåjlt a képen låthat6 m6don
| 10 
[image: ]
	x
ssh-ed25519255 SHA256.R30C/d9dCxr3k/W7gM3RU5/rL/CumF17760mYUR54computer 
you 
think 
it 
is.
without 
adding 
the 
key 
to 
the 
cache, 
press

If you trust this host. press Accept•r to add the key to PuTTY"s cache and cany on
'Connect Once" [image: ]
If vou do not trust this host. oress 'Cancel" to abandon the connection.

	
	Help
	
	More info..



	Accept
		Cancel


Connect Once


[image: ][image: ]a „Host Name"-hez mindenki a sajåt létrehozott virtuålis gépének publikus IP cimét irja
fogadjuk el a flgyelmeztetést az „Accept" gombbal
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[image: ]1
[image: ]
8. Az Apache2 webszerver telepitése, konfigurålåsa sudo apt update && sudo apt upgrade -y [image: ]sudo apt install -y apache2
I IO 
Hozzuk létre a mappát a weboldalunkhoz a webszerveren és állítsuk be a jogokat:
sudo mkdir /var/www/example sudo chmod 777 /var/www/example
SFTP csoport és SFTP felhasználó létrehozása, jogok beállítása:
sudo addgroup sftponly sudo adduser sftpawsweb
Jelszó: #Passwd12345@
[image: ]sudo usermod -d /var/www sftpawsweb sudo usermod -aG sftponly sftpawsweb sudo usermod -aG www-data sftpawsweb [image: ]sudo chown -R sftpawsweb :www-data /var/www/example
SFTP chroot konfigurálása:
sudo nano /etc/ssh/sshd config
[image: ][image: ]Konfiguráljuk a fájlt az alábbiak szerint:
# Subsystem sftp /usr/lib/openssh/sftp-server

Subsystem sftp internal-sftp
[image: ]
Match 
G
roup 
sftponly
Telepítsük 
és 
konfiguráljuk 
a 
tíízfalat:

sudo apt install -y ufw[image: ]
Hozzunk létre egy profilt az Apache2 számára (Debian 13 esetében ez nem szükséges) sudo nano /etc/ufw/applications. d/apache2-utils.ufw.prof11e
Måsoljuk bele az alåbbi sorokat:
[image: ]
[Apache] title=Web Server description=Apache v2 is the next generation of the omnipresent Apache web server ports=80/tcp
'[Apache Secure]
	the next generation of the omnipresent Apache web server


title=Web Server (HTTPS) description=Apache v2 is 	[image: ]ports=443/tcp
'[Apache Full] title=Web Server (HTTP,HTTPS)
Telepitési segédlet | 10 - (A)mazon (W)eb (S)ervices I webszerver a felh6ben
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[image: ]

[image: ]36
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[image: ][image: ]26
	generation of the omnipresent Apache web server


[image: ]description=Apache v2 is the next ports=80,443/tcp[image: ]
Mentsük a fåjlt és lépjünk ki !
[image: ][image: ]sudo ufw app list sudo ufw default deny incoming sudo ufw default allow outgoing sudo ufw allow in 'Apache Full' sudo ufw allow in 'OpenSSH' sudo ufw allow [image: ]sudo ufw enable [image: ]sudo ufw status verbose[image: ]
Nyissuk meg az Apache2 konfiguråci6s ållomånyåt:
sudo nano /etc/apache2/apache2.conf[image: ]
Illesszük a fåjl végére:
ServerName localhost
Mentsük a fåjlt és lépjünk ki ![image: ]
Hozzuk létre az Apache2-höz a sajåt webhely konfiguråci6s fåjlunkat:
sudo nano /etc/apache2/sites-available/example. conf

Måsoljuk be a fåjlba az alåbbi sorokat:
[image: ]
<
	
	VirtualHost *:80>

	ServerName example-bp.ddnsfree.com ServerAlias www.example-bp.ddnsfree.com
DocumentRoot /var/www/example



	[image: ]


	ErrorLog ${APACHE LOG DIR}/baseline-error.log
CustomLog ${APACHE LOG DIR}/baseline-access.log


[image: ] combined
</VirtualHost>
Mentsük a fåjlt és lépjünk ki !
(Az e-mail cimhez - valÖs környezelben - a szerver adminisz/rå/orånak e-mail cimél adjuk meg!)
Engedélyezzük a konfiguråciös fåjlunkat, tiltsuk le az alapértelmezett konfiguråciös fåjlt, ellen6rizziik a konfiguråci6t és inditsuk üjra az Apache2 szolgåltatåst: [image: ]
sudo a2ensite example. conf sudo a2dissite 000-default.conf sudo apache2ctl configtest sudo systemctl restart apache2
PHP telepitése és konfigurålåsa:
sudo su apt install -y Isb-release ca-certificates apt-transport-https wget [image: ]mkdir -p /etc/apt/keyrings [image: ]wget -O /etc/apt/keyrings/deb.sury.org-php.gpg https ://packages.sury.org/php/apt.gpg
echo "deb [signed-by=/etc/apt/keyrings/deb.sury.org-php.gpg] https://packages.sury.org/php/ $(lsb release -sc) main" I sudo tee /etc/apt/sources.list.d/php.list apt update[image: ]
apt install -y php8.4 libapache2-mod-php8.4 php8.4-cli php8.4-fpm php8.4-mysql php8.4opcache php8.4-mbstring php8.4-intl php8.4-xml php8.4-gd php8.4-zip php8.4-curl php8.4xmlrpc php8.4-cgi[image: ]
FPM (FastCG1 Process Manager for PHP) engedélyezése:
a2enmod proxy fcgi setenvif a2enconf php8.4-fpm systemctl restart apache2
su - admin
Nyissuk meg a dir.conf fájlt és helyezzük az index.php-t előre:
sudo nano /etc/apache2/mods-enabled/dir.conf
[image: ]
Directorylndex index.php index.html index. cgi index.pl index.xhtml index.htm
Mentsük a fájlt és lépjünk ki !
Apache2 webszerver újraindítása:
sudo systemctl restart apache2
Apache2 webszerver futásának ellenőrzése:
sudo systemctl status apache2
[image: ]9. Aurora and RDS (Managed Relational Database Service)
[image: ]Az Amazon Relational Database Service (Amazon RDS) egy webszolgáltatás, amely megkönnyíti a relációs adatbázisok beállítását, működtetését és méretezését az AWS felhőben. Költséghatékony, átméretezhető kapacitást biztosít egy iparági szabványnak megfelelő relációs adatbázishoz, és kezeli az általános adatbázis-adminisztrációs feladatokat. Az Amazon RDS lehetővé teszi az ügyfelek számára, hogy percek alatt uj adatbázist hozzanak létre, és rugalmasságot kínál az adatbázisok testreszabásához.
Az Amazon RDS előnyei:[image: ]
· könnyű kezelhetőség[image: ]
· szükséges adatbázis motorok telepítése és skálázása
· magas rendelkezésre állás[image: ]
· több, mint másfél évtizedes felhőalapú múlt, bevált biztonsági gyakorlat és innováció
9.1 

a keresőből nyissuk meg az „Aurora and RDS” szolgáltatást
	Create database
Amazon Relational Database Service (ROS) makes it easy to set up, operate, and scale a relational database in the cloud.
	Create database


Note: your DB instances will launch in the US East (N. Virginia) region
	You can use a backup from Amazon S3 to restore and create a new Aurora MySQL and MySQL database.
Restore from S3


hozzunk 
létre 
egy 
uj 
adatbåzist
jelsz6:
TAWSdbPaSS12345!

I 
[image: ]
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[image: ]10
	Connectivity Info
Compute resource
[image: ][image: ]Choose whether to set up a connection to a compute resource for this database. Setting up a connection will automatically change connectivity settings so that the compute resource can connect to this database.
	
	O Don't connect to an EC2 compute resource
Don't set up a connection to a compute resource for this database. You can manually set up a connection to a compute resource later.



	
	O Connect to an EC2 compute resource
Set up a connection to an EC2 compute resource for this database.





[image: ][image: ]EC2 instance Info
Choose the EC2 instance to add as the compute resource for this database. A VPC security group is added to this EC2 instance. A VPC security group is also added to the database With an inbound 
Virtual private cloud (VPC) Info
Choose the VPC_ The VPC defines the virtual networking environment for this DB instance.
Only VPCs with a corresponding DB subnet group are listed.
	After a database is created, you can't change its VPC.





	Instance configuration
The DB instance configuration option5 below are limited to those supported by the engine that you selected above.
DB instance class
Hide filters
[image: ]
Show instance classes that support Amazon ROS Optimized Writes into
Amazon ROS Optimized Writes improves write throughput by up to 2m at no additional cost.
[image: ]r and
O Burstable classes (includes t dasses)
	
	db.tag.micro
7 vCPUs 1 GiB RAM 
	up to 7085 Mbps



	[image: ]




	


		Resources 	the VPC can 	connect to the database Choose 	or more VPC secant-y 	that specify which resources can connectChoose 
the 
DB 
subnet 
group. 
The 
DB 
subnet 
group 
defines 
which 
subnetS 
and 
IP 
ranges 
the 
DB 
instance 
can 
use 
in 
the 
VPC 
that 
yo•u 
selected.
DB 
subnet 
group 
info

RDS doesn't assign a public IP address to the database. Only Amazon EC2 instances and other resources inside the VPC gn connect to your database. Choose one or more VPC security groups that specify which resources can connect to the database.
Choose one or more VPC security 	to allow access to your database. Make sure that the security group rules altow the appropriate incoming traffk.
	C) Choose existing
Choose existing VPC security groups
	O Create new
Create new VPC security group


New VPC security group name	[image: ]
	web-server-database-security-grou p

	@ Amazon RDS will add a new VPC security group rds-ec2-1 to allow connectivity with your compute resource.


Availability 
Certificate 
authority 
- 
optional 

Using a server certificate provides an extra layer Of security by validating that the connect•on is being made to an Amazon database. It does so by checking the server certificate that is automatically installed on all databases that you provision.
	rds-ca-rsa2048-g1 (default) Expiry: May 26. 2061


If you don't select a certificate authority. RDS chooses one for you.
Additional configuration


[image: ][image: ][image: ][image: ][image: ][image: ]az „EC2 instance" részben vålasszuk ki a sajåt EC2 példånyunkat
az „Availability Zone" ugyanaz legyen, amit koråbban a subnet-nél ållitottunk be
	I 	[image: ]
	Monitoring Info
Choose monitoring tools for this database. Database Insights provides a combined view of Performance Insights and Enhanced Monitoring for your fleet Of databases. Database Insights pricing is separate from ROS monthly estimates. See Amazon CloudWatch pricing e.
	Database 

	
	[image: ]	O Database Insights - Standard	[image: ]	[image: ]





Additional monitoring settings
Enhanced Monitoring, CloudWatch Logs and DevOps Guru
Enhanced Monitoring
o Enable Enhanced monitoring
[image: ]Enabling Enhanced Monitoring metrics are useful when you want to see how different processes or threads use the CPU.
Log exports
Select the log types to publish to Amazon CloudWatch Logs
CJ Audit log
Error log General log iam-db-auth-error log
CJ Slow query log
IAM rote
The following service-linked role is used for publishing logs to CloudWatch Logs
ROS service-linked


	Database authentication
[image: ]Database authentication options Info O Password authentication
Authenticates using database passwortK
· Password and IAM database authentication
Authenticates using the database password and user credentials through AWS IAM users and roles.
· Password and Kerberos authentication
Choose a directory in which you want to allow authorized users to authenticate with this DB instance using Kerberos Authentication.


	Tags - optimal
A tag consists of a case-sensitive key-value pair.
No tags associated with the resource.
[image: ]
You can add up to 50 more tags.


		Suggested add-ons for web-server-database	x
[image: ]
[image: ]

	Hide add-ons for 30 days [image: ]


[image: ][image: ][image: ][image: ][image: ][image: ]
	Additional configuration
Database options, encryption turned on, backup turned On, backtrack turned off. maintenance, CloudWatch Logs, delete protection turned Off.

	[image: ]
	

	You are responsible for ensuring that you have att of the necessary rightsfOr any third-party products or services that you use with AWS services.
	
	

	
	Cancel
	Create database


A 
sudo 
mysql 
Jelsz6: 
A 
CREATE 
SHOW 
quit

10. SSL tanüsitvåny létrehozåsa Let's Encrypt tanüsitvånykiad6val sudo apt install -y certbot python3-certbot-apache sudo certbot --apache[image: ]
[image: ]Enter email address (usedfor urgent renewal and security notices)
(Enter 'c' to cancel): 	egy valÖs e-mail cimet kell megadnunk!
Please read the Terms ofService at hitps: letsencrypt.org documents LE-SA-vl.5-February-24-2025.pdj: You must agree in order to register with the ACME server. Do you agree?[image: ]
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[image: ]5
Would you be willing, once your first certificate is successfully issued, to share your email address with the Electronic Frontier Foundation, afounding partner of the Lei's Encrypt project and the non-profit organization that develops Ceribot? We'd like to sendyou email about our work encrypting the web,
EFF news, campaigns, and ways to support digitalfreedom. -5 n
Which names would you like 10 activate HTTPSfor?
We recommend selecting either all domains, or all domains in a VirtualHosi server block.[image: ]
[image: ]
Select the appropriate numbers separated by commas and/or spaces, or leave input blank to select all options shown (Enter 'c' to cancel): Nyomjunk Enter-t[image: ]
A tanüsitvåny automatikus megüjitåsa:
A Let's Encrypt tanüsitvånyok alapértelmezetten csak 90 napig érvényesek. Ezért érdemes a tanüsitvånyokat automatizåltan meguj itani !
[image: ]Az åltalunk telepitett certbot csomag gondoskodik a tanüsitvånyok megujitåsåröl azåltal, hogy a certbot.timer systemctl szolgåltatåst naponta kétszer lefuttatja. Ez a folyamat automatikusan megujit minden olyan tanüsitvånyt, amely a lejårattöl szåmitott 30 napon belül van.
A szolgåltatås ållapotånak ellen6rzése:[image: ]
sudo systemctl status certbot.timer[image: ]
A megüjitåsi folyamat tesztelése:[image: ]
sudo certbot renew --dry-run
Ha a parancs nem ad vissza hibåt, akkor minden rendben fut. Ha szükséges, a certbot megujitja a tanüsitvånyokat és beintegrålja az Apache-ba. Ha az automatikus megüjitåsi folyamat meghiüsul, a Let's Encrypt küld egy e- mailt a megadott e-mail cimre, melyben flgyelmeztet a tanüsitvåny lej åratår61[image: ]
[image: ]I 
11. URL åtirånyitås és az Apache2 konfiguråci6s fåjl beållitåsa sudo nano /etc/apache2/sites-available/example. conf
M6dositsuk a mår koråbban létrehozott konfiguråci6s fåjlt, az alåbbiak szerint:
[image: ]
	
	<VirtualHost *:80>

	ServerName example-bp.ddnsfree.com ServerAlias www.example-bp.ddnsfree.com
DocumentRoot /var/www/example



	[image: ]


[image: ][image: ]</VirtualHost>
	SSLEngine On
S SLC ertifi cateFile /etc/l etsencrypt/live/exam 
S SLC ertifi cateKeyFile /etc/l 


ple-bp.ddnsfree.com/fullchain.pem etsencrypt/live/exampl e-bp.ddnsfree.com/privkey.pem
	RewriteEngine On
RewriteCond 
RewriteRule 


	[R=301 Ll


HOST} 	[NC] https://example-bp.ddnsfree.como O{REQUEST URI} 
	ErrorLog ${APACHE LOG DIR }/example-ssl-error.log
CustomLog ${APACHE LOG DIR}/example-ssl-access.log 


combined
</VirtualHost> [image: ]
Mentsük a fåjlt és lépjünk ki ![image: ]
Engedélyezzük az üj konfiguråci6s fåjlunkat, tiltsuk le az alapértelmezett konfiguråci6s fåjlt, engedélyezzük a szükséges modulokat, ellen6rizzük a konfiguråci6t és inditsuk üjra az Apache2 szolgåltatåst: [image: ]
sudo a2enmod SSI [image: ]sudo a2enmod headers [image: ]sudo a2enmod rewrite sudo apache2ctl configtest sudo systemctl reload apache2
[image: ]
12. A WordPress CMS rendszer feltöltése a webszerverre FTP-vel
Töltsük le a gépünkre a legfrissebb WordPress tömöritett (zip) verzi6jåt az alåbbi oldalr61 [image: ]https://wordpress.org/download/
Töltsük le, telepitsük, inditsuk el és konfiguråljuk a WinSCP-t:
https://winscp.net/eng/index.php
word press_install — WinSCP
Left Mark Files Commands Tabs Options Right Help
	Synchronize 	Queue	Transfer Settings Nauit
	wordpress_inst... — 	New Tab
	— D: SSD2TB •	—c: SSD51 •	- 	Find Files
login
	New Site	Session
	Name	File protocol:	Changed
	SFTP	2025, 08.14.807:28
wordpress-6.8,2.zip 27 885 KB Host name: Port number: 2025.04.30. 22 : 2025.08.
2024.04.01,
	User name:	Password:	2025.05.01.
	Save	Advanced...	2025,
2025.04.30.
	Tools	Manage	a Login	Close	Help
	0B of 27,2 MB in Oof 1	OBofO B inO of 10	8 hidden
	Advanced Site Settings	x
	Environment	CJ Bypass authentication entirely
	• Directories	Authentication options
Recycle bin
Attempt authentication using Pageant Encryption
	SFTP	Attempt 'keyboard-interactive' authentication
	Shell	Respond with a password to the first prompt
Connection
	Proor	Authentication parameters
	. Tunnel	Cl Allow agent forwarding
	SSH	Private key file:
Key exchange
D:\linux-web-server-key.ppk Authentication
	Bugs	Display Public Key	Tools
Note
Certificate to use with the private kg:
GSSAPI
Attempt GSSAPI authentication
Cl Allow GSSAPI credential delegation
	Color	OK	Cancel	Help
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[image: ]5c 
[image: ]
a „Host name"-hez a létrehozott DDNS nevünket adjuk meg (mindenki a sajåtjåt) [image: ]user name: sftpawsweb I password:
va16s környezetben nem ajånlott elmenteni a jelsz6t
	Warning	[image: ]	7	x
[image: ][image: ][image: ][image: ][image: ][image: ][image: ][image: ][image: ][image: ]I Continue connecting to an unknown server and add its host key to a cache?
The host key is not cached for this server: example-bp.ddnsfree.com (port 22)
You have no guarantee that the server is the computer you think it is,
[image: ]
[image: ]
[image: ]
[image: ]
The ssh-ed25519 key fingerprint is:
ssh-ed25519 255 R30C/d9dCxr3kAV7tgM3RLj5/rL/CumFl 7760mYlJR54
[image: ]
[image: ]
[image: ]
If you trust this host, select Accept to add the key to WinSCP's cache and carry on connecting,
If you want to carry on connecting just once, without adding the key to the cache, select Connect Once,
If you do not trust this host, select Cancel to abandon the connectiom
Copy key fingerprints to clipboard
[image: ]


[image: ]fogadjuk el a flgyelmeztetést az „Accept" gombbal
I 
[image: ]
lépjünk be az example mappåba és måsoljuk fel a WordPress telepit6t a webszerverre
[image: ]Csomagoljuk ki a Putty terminåljåban a felmåsolt telepit6csomagot:
sudo apt install -y unzip cd /var/www/example[image: ]
[image: ]Is (låtjuk az FTP-n felmåsolt fåjlt, amit ki kell csomagolnunk) sudo unzip wordpress-6.8.2.zip sudo rm wordpress-6.8.2.zip sudo mv /var/www/example/wordpress/* var/www/example/ sudo rmdir wordpress
ValÖs környezetben a kicsomagolt telepitÖkészletet måsoljuk åt a webszerverre! Jelen esetben csak idöspörolås miatt måsoljuk a tömöritettfåj/t, amit a szerveren boniunk ki!
11.1 A WordPress [image: ]telepitése
Terjesszük ki a jogosultsågot a felmåsolt telepit6készlet almappåira is:
sudo chmod -R 777 /var/www/example[image: ]
Nyissuk meg a gépünk böngész6jében a WordPress telepit6jét:
A böngész6nk cimsoråba irjuk a virtuålis gépünk regisztrålt DDNS cimét:
	
	Below you should enter your database connection details. If you are not sure about these, contact your host.
[image: ]Database Name
Username




	


[image: ][image: ]http://www.example-bp.ddnsfree.com(Mindenki 
a 
sajåt 
regisztrålt 
domain 
nevét 
hasznålja!)

[image: ]
Database Name: wordpress
Username: admin
Password: !AWSdbPaSS12345!
Database Host: a létrehozott adatbåzisunk informåci6s felületén talålhat6 cim[image: ]
Kattintsunk a „Submit"-re!

	[image: ]

	Welcome	[image: ]	[image: ]	[image: ]	[image: ]
Welcome to the famous five-minute WordPress installation process! Just fill in the information below and you'll be on your way to using the most extendable and powerful personal publishing platform in the world.
Information needed
Please provide the following information. Do not worry, you can always change these settings later.
	Example Ltd. website


Site Title
[image: ]
Double-check your email address before continuing,
Search engine	Cl Discourage search engines from indexing this site visibilityhonor 
this 
request.


	


[image: ][image: ][image: ]Site Title: Example Ltd. website[image: ]
Username: wpadmin
Password:[image: ]
Your Email: az e-mail cimhez a weboldal adminisztråtorånak cimét adjuk meg
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[image: ]5
	
	Success!
	IQgLQ


[image: ]WordPress has been installed. Thank your and enjoy!
Usemame	wpadmin
Password	Your chosen password.





kész vagyunk a WordPress telepitésével [image: ]a „Log In"-nel be tudunk lépni a WordPress adminisztråciös felületére
[image: ]
10 -
	Ltd. website I	+ New	Hcwdy, wpadmin
	Screen Options	Help
	osshÉo	Dashboard
Home
	Site Health Status	Quick Draft
	Site health creck; will automatically rur	Tit12
	Pusts	periodicall/ to cether It-formation *out
NO inform*on yet..	site. VCLI can Media
	Content	hp,p
about pur ;ite no"
Dn your mind?
Comments
At a Glance
Appearance
Odge
Sue bratt
	Plugins	Comment
users
	W3rdPrcz	them.
	WordPtess Events 	News
	Inv:'.rt	Attend an upcomlrg •vent near you. Seed locatlcn
O Ccllap;o Menu wordcamp vrsac 2025 September 12-14. 2025
Site Health
WJ•dCd111p • Vl%t, Ser-oid
Export Personal Data
	WordCamp Europc 2026	Junc 4 5. 2026
	Erase Personal Data	W'JdCarnp •
pile pditnr t 	an Hello world'	want more events?
Ethic." nunent, Tc get started with moderating
	Ing an cidetng comments, pe;e v•slttiv	Portland. Are fou Nead•,'? The WCLS 202E Schedule les Atrv•ed!
	comments screer in..	Maintenance Releases ior WccdPres; &anches '1.7 to
	Ward/ i onlr*l: Niirturing 	:nnrrihlltnrs: wnrdvrp«
	Kolhan•r 	Online Contribution Series
	All (1) Mineo Pencinq (0) 	Spam O
Matt MCP NVC •lackatr%'n
'rash (u)
opal ch;nnAq Frvt •.-,r.en channel; FV ct snrnmv Break
	Warricamps 	News
kattintsunk a „Tools/Site Health" menüpontra
	Server
The options shown below relate to your server setup. If changes are required, you may need your web host's assistance.
	Server architecture	Linux 6,1.O-38-cloud-amd64 x86 64
Web server	Apache/2.4.62 (Debian)
PHP version	8.4.11 (Supports 64bit values)
PHP SAPI	apache2handler
PHP max input variables	1000
PHP time limit	30
PHP memory limit	128M
PHP memory limit (only for admin	256M screens)
Max input time
Upload max filesize	2M
PHP post max size	8M
cURL version	788.1 OpenSSU/3.O.17
Is SUHOSIN installed?	No
Is the Imagick library available?	No
Are pretty permalinks supported?	Yes
mhtaccess rules	Your .htaccess file contains only core WordPress features.
[image: ]robots.txt	your site is using the dynamic robots.txt file which is generated by WordPress.
Current time
Current UTC time	Tuesday, 19-Aug-25 [image: ] UTC
Current Server time	[image: ]





a „Site Health" oldalon kattintsunk az „lnfo" fülre a , Server" menüpont alatt låtjuk a webszerver informåci6kat
[image: ]a 
vålasszunk, és aktivåljunk egy szimpatikus sablont
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A 
cd 
sudo 
sudo 

A WordPress hivatalos weboldala: https://wordpress.com
Segitség a WordPress hasznålatåhoz: https://wordpress.com/learn
[image: ]
13. A fut6 szolgåltatåsok és a laborgyakorlat leållitåsa, törlése, alaphelyzetbe ållitås
[image: ]
Mie16tt kilépnénk az AWS-b61 mindenképpen ållitsuk le a fut6 virtuålis gépeket, szolgåltatåsokat! Amennviben mår nincs szükségünk a telepitett szolgåltatåsokra, virtuålis gépre, töröliiik azokat! Ållitsuk le a laborgyakorlatot!
A fut6 EC2 példåny (instance) leållitåsa:
	[image: ]
Oashbuad
View
Instances
	[image: ]


Instances
	Stop instance	x
Stopping your instance allows you to reduce costs, modify settings, and troubleshoot problems.
Instance ID	Stop protection
	i-Oe2b1b31 If1 e69e54 (linux-web-server)	@ Off (Can stop instance)
You will be billed for associated resources
After you stop the instance, you are no longer charged usage or data transfer fees for it. However, you will still be billed for associated Elastic IP addresses and EBS volumes.
Associated resources
You will continue to incur charges for these resources while the instance is stopped
Skip OS shutdown
This option skips the graceful OS shutdown process. Use only when your instance must be stopped immediately, such as during an emergency or failover.
o Skip OS shutdown

		Stop


Cancel


Az EC2 példåny törlése:
	@ 	initiated grooving of i•Oe'bIh511fle69e%4
	O&ihboatd	Instances (1/1)	state
	EC2 Globai	Q and instance by 	toyfeose-sens1Zh•e'	I Ail states
	I instmcesute v I Instance type	Statuscbe•ck	Stan
	instarxe	medium	View alarms + uv•east-
inst..nc.s
	Terminate (delete) instance	x
On an EBS-backed instance, the default action is for the root EBS volume to be deleted when the instance is terminated. Storage on any local drives will be lost.
Are you sure you want to terminate these instances?
Instance ID	Termination protection
	i-Oe2b1 b31 Ifl e69e54 (linux-web-server)	@Disabled
Clean up associated resources
Associated resources may incur costs after these instances are terminated.
[image: ]

[image: ]
	Release attached Elastic IPS [image: ]	[image: ]	[image: ]	[image: ][image: ]		[image: ]	[image: ]
[image: ]
To confirm that you want to delete the instances, choose the terminate button below. Instances with termination protection enabled will not be terminated. Terminating the instance cannot be undone.
Skip OS shutdown
This option skips the graceful OS shutdown process- Use only when your instance must be stopped immediately, such as during an emergency or failover.
Skip OS shutdown

	Cancel
	Terminate (delete)


	Stop DB instance temporarily	X
You're stopping this web-server-database DB instance for up to 7 days. You can restart the DB instance manually at any time. To stop the DB instance permanently, save it in a snapshot and delete it. Learn more
Acknowledgement
I acknowledge that stopping the DB instance only pauses billing for instance hours. The DB instance restarts automatically on August 26, 2025, 17:52 (UTC+02:OO).
While your DB instance is stopped, you're charged for provisioned storage, including Provisioned IOPS. You're also charged for backup storage. This includes manual snapshots and automated backups within your retention window. For more information, see Billing FAQs
Snapshot - optional o Save the DB instance in a snapshot
The snapshot enables you to restore the DB instance to its last state before it was stopped.
O You can use a Lambda function to start and stop a DB instance automatically at the beginning and end of its maintenance period. Learn More

	Cancel
	Stop temporarily


[image: ][image: ]Az adatbåzis leållitåsa:
vigyåzzunk arra, hogy ha leållitjuk az adatbåzist, 7 nap mülva automatikusan üiraindul,
		[image: ]	[image: ]	[image: ]	[image: ]	[image: ] és a kreditet fogyasztja tovåbb
adatbåzis törlése:	[image: ]	[image: ]	[image: ]	[image: ]
Auora and 	>
Aurora and RDS	@ database 	tenporaniy. it wal restart automatically after 7 on August 202S.17:52
	[image: ]
	Start
	activity
[image: ]

	[image: ]	Status	V	Engine	Region & AZ v I Size
	Stogoed temporaruy	Instance	M•ySQL Community	db.t4q
	[image: ]	"-em 
	

	[image: ]
	[image: ] - rew
	

	
	[image: ]
Create blue/green dQlqrnent
Convert to Multi-AZ deployment
	

	
	Take glapshat
Restore to point in time
	

	
	Create zero-ETL create ROS Proxy
Create ElastiCache cluster
	


	Databases (1)	C) Group resources 	Modify	Actions
Pet	[image: ]
Eaoorts in Amazon SS
Automated backups
Reserved instances
Subnet
Patameter groups
Option groups
Custom engine
Zero-ETL •ntegrations New
Events
Event "Oscriptions
[image: ]
Certificate update

	


[image: ][image: ]Az 
	
	Delete web-server-database instance
Permanently delete web-server-database DB instance. You can't undo this action.
To 
confirm 
deletion, 
type 
delete 
me 
into 
the 
field.

	delete me	[image: ]


[image: ]
[image: ]

	Cancel
	Delete
	



	[image: ]


[image: ]
a törléshez meger6sitésként manuålisan be kell irnunk a „delete me" szöveget
A 

	Are you sure you want to end the lab?
[image: ]
	No


A laborgyakorlat alaphelyzetbe ållitåsa (minden tör16dik):
	
	Modules
Discussions
Grades
[image: ]
	• • Modules > AWS Academy Learner Lab Launch AWS Academy Learner Lab
Used SO of SSO
[image: ]
	Start Lab [image: ]
[image: ]
[image: ]Learner Lab
Instructions last updated: 2025-06-24
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	Calendar
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	O Reset will delete all your content in the work area and replace it with the starter code.
[image: ]O If you choose yes, all the resources and data that have been configured in your AWS account will be permanently deleted,
Are you sure you want to reset your work-area?	[image: ]
	[image: ]




Windows-server
Alap configurálása cli-ben(Ip, dns, hostname, időzóna)
CLI
1. Hálózati interfész nevének lekérdezése
netsh interface ipv4 show interfaces
Megkapod pl:
· "Ethernet" 
· vagy "Ethernet0" 
👉 ezt a nevet kell majd használni

2. Statikus IP beállítása
netsh interface ipv4 set address name="Ethernet" static 192.168.1.10 255.255.255.0 192.168.1.1
Mit jelentenek:
· "Ethernet" → interfész neve 
· 192.168.1.10 → IP cím 
· 255.255.255.0 → subnet mask 
· 192.168.1.1 → gateway
DNS
3. DNS szerver beállítása
netsh interface ipv4 set dns name="Ethernet" static 8.8.8.8
Másodlagos DNS:
netsh interface ipv4 add dns name="Ethernet" 8.8.4.4 index=2

4. Ellenőrzés
ipconfig /all
Powershell

Hostname:
Rename-Computer -NewName "win-srv-core" -Restart
Ellenőrzés: hostname
Időzóna:
Időzóna beállítása
Set-TimeZone -Id "Central Europe Standard Time"

Lista lekérdezése (ha nem tudod a nevet)
Get-TimeZone -ListAvailable

Ellenőrzés
Get-TimeZone

Hitelesítés, jogosultságok, engedélyek kezelése

Hitelesítés (Authentication)
A hitelesítés annak ellenőrzése, hogy a felhasználó vagy számítógép valóban az, akinek mondja magát.
· Pl.: felhasználónév + jelszó megadása bejelentkezéskor.
Windows Server környezetben ez általában Active Directory Domain Services (AD DS) segítségével történik.
Leggyakoribb hitelesítési módok
· Kerberos (alapértelmezett tartományban)
· NTLM (régebbi vagy fallback megoldás)
· Smart card
· Multifaktoros hitelesítés (MFA)
· Tanúsítvány alapú hitelesítés
A tartományi hitelesítés az Active Directory segítségével történik.
Hitelesítés konfigurálása:
1. Active Directory telepítése
1. Server Manager → Add Roles and Features
2. Válaszd ki: Active Directory Domain Services
3. Telepítés után: „Promote this server to a domain controller”
4. Új domain létrehozása vagy meglévőhöz csatlakozás

2. Felhasználók létrehozása
1. Eszköz: Active Directory Users and Computers
2. Tools → Active Directory Users and Computers
3. OU kiválasztása
4. Right click → New → User
5. Jelszó és policy beállítása
3. Jelszóházirend konfigurálása
· Eszköz: Group Policy Management
· Útvonal:
Computer Configuration
 → Policies
  → Windows Settings
   → Security Settings
    → Account Policies
     → Password Policy
· Beállítható:
· Minimum jelszóhossz
· Lejárati idő
· Complexity requirement
· Account lockout

Jogosultság (Authorization)
A jogosultság (authorization) azt határozza meg, hogy egy már hitelesített felhasználó mit tehet meg.
· Például:
· Beléphet-e a szerverre?
· Futtathat-e programot?
· Hozzáférhet-e egy megosztott mappához?
· A jogosultság a hitelesítés UTÁN történik.
Windows jogosultsági típusok:
1. User Right Assingment 
· Elérése:
Computer Configuration
 → Windows Settings
  → Security Settings
   → Local Policies
    → User Rights Assignment
· Itt állítható pl. bejelentkezési log esetén:
· Allow log on locally
· Allow log on through Remote Desktop Services
· Deny log on locally
2. Csoportalapú jogosultságkezelés (Ajánlott módszer)
· Soha ne egyéni usernek adj jogosultságot, hanem Security Groupnak.
· Példa:
· HR_Group
· IT_Admins
· Finance_ReadOnly
· Lépések:
1. AD Users and Computers → New → Group
2. Security type: Security
3. Scope: Global (általában ez ajánlott)
Majd:
4. Felhasználók hozzáadása a csoporthoz
5. Jogosultság hozzárendelése a csoporthoz

Engedélyek (Permissions)
Az engedély konkrét erőforrásokra vonatkozik:
· Fájl
· Mappa
· Nyomtató
· Registry
· Megosztás
NTFS engedélyek
· NTFS az alapértelmezett fájlrendszer Windows Serveren.
· Alap NTFS engedélyek:
· Full Control
· Modify
· Read & Execute
· Read
· Write
NTFS engedély beállítása
1. Mappa → Right Click → Properties
2. Security fül
3. Edit
4. Add (csoport hozzáadása)
5. Engedély kiválasztása

Share engedélyek
Ha egy mappát megosztasz hálózaton:
1. Properties
2. Sharing fül
3. Advanced Sharing
4. Permissions

NTFS vs Share
Ha hálózaton keresztül érik el:
· A szigorúbb engedély érvényesül!!
· Példa:
· Share: Full Control
· NTFS: Read
· Eredmény: Read (NTFS)

Öröklődés (Inheritance)
Alapértelmezetten:
· A mappa engedélyei öröklődnek az al-mappákra.
· Beállítás:
Security → Advanced → Disable inheritance

Group Policy (GPO)
A Group Policy segítségével központilag kezelhető:
· Jelszópolicy
· Tűzfal
· RDP engedélyezés
· Szoftvertelepítés
· Script futtatás
GPO létrehozása
1. Tools → Group Policy Management
2. Domain → Right Click → Create GPO
3. Linkeld OU-hoz
4. Szerkesztés

Fájlrendszerek, fájlműveletek, partíciók, szoftveres RAID

Fájlrendszerek (File systems)
A fájlrendszer határozza meg, hogyan tárolja és kezeli az operációs rendszer az adatokat a háttértáron.
Windows Server környezetben leggyakrabban használt filerendszerek:
NTFS (New Technology File System)
· Az alapértelmezett és leggyakrabban használt fájlrendszer Windows Server környezetben.
· Előnyök: Jogosultságkezelés, titkosítás (EFS), kvóták, naplózás, nagy fájlok támogatása
· Hátránya: Régebbi OS-ek nem támogatják
ReFS (Resilient File System)
· Előnyök: Hibatűrés, adatkorrekció, nagy tárkapacitás, virtualizáció (Hyper-V)
· Hártányok: Nem minden funkció érhető el (pl. EFS)
· Win. Server támogatása: Windows Server 2012 és afölött
FAT32
· Régi fájlrendszer
· Előnye: Egyszerű, kompatibilis minden OS-sel
· Hátránya: Max 4 GB fájlméret, kevés funkció
· Win. Server támogatása: Windows Server 2016 és afölött (bár nem használják)
exFAT
· FAT32 továbbfejlesztett verziója
· Előnye: Nagy fájlok, hordozható lemezek
· Hátránya: Kevés jogosultsági lehetőség
· Win. Server támogatása: Windows Server 2003 (updaten keresztül!) és afölött
Szervereknél mindig NTFS vagy ReFS ajánlott!

Fájl műveletek (File operations)
Windows Server GUI-ban a fájlműveletek főként a 
“File Explorer” vagy “Server Manager” → File and Storage Services → Shares részeken történnek
Alapvető műveletek
· Másolás / Áthelyezés / Törlés: Jobb-klikk → Copy / Move / Delete
· Új mappa létrehozása: Jobb-klikk → New → Folder
· Jogosultságkezelés:
· Jobb-klikk → Properties → Security → Edit
· Hozzáadás / eltávolítás felhasználók, csoportok
· Jogosultságok: Full Control, Modify, Read, Write
Speciális fájlműveletek
· Quota (kvóta) beállítás:
· File Server Resource Manager → Quota Management → Create Quota
· Szűrők / Szerver oldali replikáció:
· DFS (Distributed File System) segítségével.
· Shadow Copies (VSS):
· Backup és korábbi verziók elérhetősége.
· Jobb-klikk meghajtó → Configure Shadow Copies.

Partíciók (Partitions)
Partíció típusok
· Elsődleges partíció (Primary Partition)
· Bootolható, lehet rajta OS.
· Kiterjesztett partíció (Extended Partition)
· Több logikai meghajtót tartalmazhat.
· Logikai meghajtó (Logical Drive)
· Kiterjesztett partícióban hozható létre, adatok tárolására.
Partíció létrehozása:
1. Nyisd meg a Server Manager → File and Storage Services → Volumes → Disks.
2. Válaszd ki a nem inicializált lemezt → Initialize Disk.
3. Hozz létre új partíciót a New Volume Wizard segítségével:
· Válaszd ki a partíció méretét.
· Fájlrendszer: NTFS vagy ReFS.
· Hozz létre meghajtóbetűjelet.
· Készíts formázást (quick format ajánlott új lemezeknél).
Megjegyzés: MBR vs GPT:
· MBR: max 2 TB, max 4 partíció.
· GPT: > 2 TB, több partíció, ajánlott új szerverekhez.
Szoftveres RAID (Software RAID)
A RAID (Redundant Array of Independent/Inexpensive Disks) lehet hardware vagy software. Windows Serverben GUI-val a Disk Management és a Server Manager alatt konfigurálható szoftveres RAID.
Főbb RAID fajták és működésük:
· RAID 0 (Csíkozás / Striping):
· Minimum lemez: 2 db
· Működés: Az adatokat több lemezre osztja szét (csíkozza).
· Előny: Nagyon gyors írási/olvasási sebesség
· Hátrány: nincs redundancia (ha egy lemez meghibásodik, az összes adat elveszik).
· RAID 1 (Tükrözés / Mirroring):
· Minimum lemez: 2 db
· Működés: Az adatokat egyszerre két (vagy több) lemezre írja, így a lemezek tartalma megegyezik
· Előny: Kiváló adatbiztonság (egy lemez kiesése nem okoz adatvesztést)
· Hátrány: a tárkapacitás feleződik
· RAID 5 (Paritásos csíkozás):
· Minimum lemez: 3 db
· Működés: Az adatokat és a paritásinformációkat (hibaellenőrző adatokat) elosztja az összes lemezen.
· Előny: Jó egyensúly a sebesség, a tárkapacitás és a biztonság között
· Hátrány: Egy lemez hiba esetén a rendszer működőképes marad
· RAID 10 (1+0 - Tükrözött csíkozás):
· Minimum lemez: 4 db
· Működés: A RAID 1 és RAID 0 kombinációja: először tükrözi a lemezeket, majd a tükrözött párokat csíkozza.
· Előny: Nagyon gyors és biztonságos
· Hátrány: drága, a teljes tárkapacitás fele redundancia
· Megjegyzés: Szoftveres RAID nem bootolható, ha a rendszerlemezen RAID-et szeretnél, hardveres RAID kell.
RAID konfiguráció:
1. Nyisd meg: Server Manager → File and Storage Services → Volumes → Disks.
2. Válaszd a több lemezt, jobb-klikk → New Mirrored Volume / New Striped Volume / New RAID-5 Volume.
3. Kövesd a Volume Wizard lépéseit:
· Válaszd ki a lemezeket.
· Add meg a volume nevét, betűjelét.
· Formázás NTFS-sel.
RAID karbantartás:
· Ellenőrizd a status a Disk Management-ben.
· Hiba esetén:
· Hibás lemezt Remove → Replace Disk → Resync.
· Rendszeresen készíts backupot, mert szoftveres RAID nem helyettesíti a backupot.
DHCP, DNS, DFS szolgáltatások

DHCP
A DHCP (Dynamic Host Configuration Protocol) egy hálózati szolgáltatás, amely automatikusan IP-címet és egyéb hálózati beállításokat (pl. átjáró, DNS szerver) oszt ki a klienseknek.
Windows Server 2025-ben a DHCP szerepkör a Server Managerből telepíthető.
DHCP működési folyamata (DORA)
1. Discover – kliens DHCP kérést küld (broadcast)
2. Offer – szerver IP ajánlatot küld
3. Request – kliens elfogadja az ajánlatot
4. Acknowledge – szerver jóváhagyja

DHCP telepítése (GUI – Server Manager)
1. Nyisd meg: Server Manager → Manage → Add Roles and Features
2. Role-based installation
3. Válaszd ki a szervert
4. Pipáld ki: DHCP Server
5. Install
6. Telepítés után: Complete DHCP Configuration
Ha a szerver tartomány tag, akkor Authorize-olni kell Active Directoryban
Miért kell authorize-olni a DHCP szervert?
Active Directory környezetben védelem van az úgynevezett:
· "Rogue DHCP Server" ellen -> ez egy illetéktelen DHCP szerver, amely:
· Hibás IP-címet oszt
· Rossz átjárót ad
· Rossz DNS-t ad
· Hálózati problémát okoz
· Ha nincs Authorize, a DHCP szolgáltatás elindul, de:
· Event Viewerben hiba jelenik meg
· Nem fog IP-t kiosztani
· A konzolban piros lefelé mutató nyíl látható
Az AD csak az engedélyezett (authorize-ált) DHCP szervereknek engedi az IP kiosztást. Ha a DHCP szerver domain tag vagy DC, akkor kötelező!
Workgroupban nem kell DHCP Authorize, mert nincs Active Directory, amely ellenőrizné és engedélyezné a DHCP szervereket. Az Authorize mechanizmus az AD biztonsági funkciója.
Hogyan kell authorizálni a DHCP szervert?
Miután telepítetted a DHCP Server role-t:
1. Server Manage
2. Felső sárga figyelmeztetés → Complete DHCP configuration
3. Kattints → Authorize
VAGY manuálisan:
1. Server Manager → Tools → DHCP
2. Jobb klikk a szerver nevére
3. Authorize
Pár másodperc múlva:
1. Jobb klikk → Refresh
2. A piros nyíl zöldre vált

DNS
A DNS (Domain Name System) névfeloldást végez.
IP-cím ↔ domain név átalakítás.
DNS típusok
· Forward Lookup Zone
· Reverse Lookup Zone
· Primary Zone
· Secondary Zone
· Active Directory Integrated Zone
DNS telepítése
1. Server Manager
2. Add Roles and Features
3. Pipáld ki: DNS Server
4. Install
DNS konfiguráció
1. Forward Lookup Zone létrehozása
Server Manager → Tools → DNS
1. Forward Lookup Zones
2. New Zone
3. Primary Zone
4. AD Integrated (ha DC)
5. Zone name: <domain_name>
2. “A Record” létrehozása
Zone → jobb klikk → New Host (A)
· Name: server
· IP: <ip_address>
3. Reverse Lookup Zone
Reverse Lookup Zones → New Zone
· Network ID: <halozati_azonosito_ipcim>   -> prefixtől függ, hogy milyen IP-t adunk meg
· PTR rekord automatikusan generálható.
DNS és Active Directory
AD működéséhez DNS szükséges!
SRV rekordok automatikusan létrejönnek. Ez azonosítja, hogy az adott IP címen milyen szolgáltatás fut, és melyik porton
Fontos zónák:
· _msdcs
· _tcp
· _udp

DFS
A DFS (Distributed File System) lehetővé teszi:
· Megosztások logikai összefűzését
· Több szerver közötti replikációt
DFS komponensek
· DFS Namespace
· Lehetővé teszi a felhasználók számára, hogy egyetlen megosztott mappában (logikai útvonalon) lássák a különböző szervereken tárolt adatokat, így a tényleges fizikai helyszín rejtve marad.
· DFS Replication
· Hatékonyan szinkronizálja a fájlokat több kiszolgáló és helyszín között, biztosítva a magas rendelkezésre állást és a redundanciát.
DFS telepítése:
1. Server Manager → Add Roles and Features
2. File and Storage Services → DFS Namespaces + DFS Replication

DFS Namespace konfiguráció
1. Server Manager → Tools → DFS Management
2. New Namespace
3. Válaszd ki a szervert
4. Namespace neve
5. Domain-based namespace (ajánlott)
Folder hozzáadása
1. Namespace → New Folder
2. Folder name: Docs
3. Add Folder Target → UNC path
UNC path e.g.: 
Ha a dokumentumok a “SZERVER01” nevű géped “Dokumentumok” nevű megosztásában vannak, akkor ezt írod be:
“\\SZERVER01\Dokumentumok”
DFS Replication konfiguráció
1. DFS Management
2. Replication → New Replication Group
3. Multipurpose replication group
4. Add szerverek
5. Topológia:
· Full Mesh
· Hub and Spoke
6. Primary member kiválasztása
7. Replikálandó mappa

Rendszerfelügyelet (pl. MMC konzol, Server Manager)

MMC
Mi az MMC?
· A Microsoft Management Console (MMC) egy keretrendszer, amely egységes felületet biztosít különböző felügyeleti eszközök számára (“snap‑in” modulok).
· Az MMC önmagában nem egy konkrét eszköz – hanem egy tálca, amelybe különböző felügyeleti funkciókat („snap‑ineket”) lehet betölteni.
· Ezek a snap‑inek .msc formátumú fájlokként vannak mentve és indíthatók
(pl. services.msc, compmgmt.msc)
Mire használható?
Példák gyakori MMC snap‑inekre:
· Computer Management: eszközkezelés, meghajtók, szolgáltatások, eseménynaplók
· Event Viewer: Rendszer és alkalmazás események vizsgálata
· Device Manager: Hardvereszközök felügyelete
· Local Users and Groups: Felhasználók és csoportok kezelése
· Group Policy Management: Házirendek kezelés
· Disk Management: Partíciók és lemezkezelés
MMC konfigurálása:
Snap-inek létrehozása:
1. Nyisd meg: Win + R → mmc → Enter
2. Menj a File → Add/Remove Snap‑in… menüpontra
3. Válaszd ki a kívánt snap‑ineket, majd Add → OK
4. Beállíthatod, hogy a snap‑inek vagy helyi, vagy távoli szerverekhez kapcsolódjanak
Konzol mentése:
· Állítsd be a megfelelő snap‑ineket 
→ File → Save As… → nevezd el → mentsd .msc‑ként
· Később közvetlenül megnyitható dupla kattintással
Jogosultságok:
· Az MMC konzol fájlokra (pl. saját .msc) biztonsági jogosultságokat adhatsz, így korlátozhatod, ki nyithatja vagy szerkesztheti a konzolt

Server Manager
Mi a Server Manager?
· A Server Manager a Windows Server központi grafikus felügyeleti konzolja, amelyet helyi és távoli szerverek egyszerű kezelésére terveztek.
· Alapértelmezés szerint automatikusan elindul, amikor rendszergazdai felhasználó bejelentkezik a szerverre.
Mire használható?
· Szerepkörök és funkciók telepítése: Szerepkörök, szolgáltatások és funkciók telepítése helyi vagy távoli szervereken.
· Kiszolgálók csoportos kezelése: Több szerver egyidejű felügyelete egyetlen konzolon keresztül.
· Állapot és állapotcsempék: Felügyeleti nézet, gyors áttekintés a kiszolgálók állapotáról.
· Szerepkörök eltávolítása: Szerepkörök és funkciók konfigurációja vagy eltávolítása.
· Szkriptek és parancsok indítása: PowerShell parancsok futtatása közvetlenül a konzolból.
Server Manager konfiguráció és beállítások
Távoli felügyelet engedélyezése, ahhoz, hogy más gépről is felügyelhesd a szervereket Server Managerrel:
1. Nyisd meg a Server Managert
2. A “Local Server” lapon kattints a “Remote Management” beállításra
3. Engedélyezd a “Ez a számítógép távoli felügyeletének engedélyezése” opciót
4. Alternatív: futtasd PowerShellből: “Configure-SMRemoting –Enable”
Megjegyzés: ha a tűzfal blokkolja a távoli felügyeletet, a konfiguráció nem fog működni. Bizonyosodj meg róla, hogy a megfelelő tűzfalszabályok engedélyezve vannak.
Automatikus indítás kezelése
A Server Manager alapból indul bejelentkezéskor.
Ha ezt szeretnéd letiltani:
1. Server Manager → Manage → Server Manager Properties
2. Jelöld be: “Do not start Server Manager automatically”

MMC & Server Manager combination
A Microsoft ajánlja a Server Manager és az MMC együttes használatát.
A Server Manager a több szerver állapotának áttekintését és szerepkör telepítést/eltávolítást könnyíti meg.
Az MMC konzolok pedig a részletes konfigurációs és monitorozási feladatokat végzik (pl. eseménynapló, szolgáltatások, felhasználók kezelése stb.)
Best practice:
Server Manager
· Ha új feladatot adsz a szervernek, vagy látni akarod, hogy pl. 10 szerverből melyiken van hiba.
MMC
· Mikor használd: A telepítés után mindenre. A Server Manager "Tools" menüje is valójában csak MMC konzolokat nyit meg.

Active Directory tartományvezérlő telepítés, konfigurálás

Active Directory Domain Controller (AD DS)
Az AD DS egy központi címtárszolgáltatás, amely:
· Felhasználókat kezel (bejelentkezés, jelszavak)
· Számítógépeket kezel (tartományba léptetés)
· Jogosultságokat szabályoz
· Erőforrásokhoz való hozzáférést irányít (megosztások, nyomtatók, alkalmazások)
· Központi házirendeket alkalmaz (Group Policy)
Röviden: Az AD teszi lehetővé, hogy egy cégnél mindenki ugyanazzal a felhasználónévvel és jelszóval jelentkezzen be bármely céges gépre, és csak azokhoz az erőforrásokhoz férjen hozzá, amihez jogosultsága van.
Előkészületek (telepítés előtt)
1. Fix IP cím beállítása (Az AD-nak mindig fix IP címmel kell rendelkeznie!)
1. Start → Settings → Network & Internet
2. Adapter settings
3. Jobb klikk az aktív hálózati kártyára → Properties
4. Internet Protocol Version 4 (TCP/IPv4)
5. Manual IP beállítás
2. Gépnév beállítása
1. Server Manager → Local Server
2. Computer name → Change
3. Adj meg egy hostnamet:
4. Újraindítás szükséges.
Active Directory Domain Services szerepkör telepítése
1. Role telepítés GUI-val
2. Nyisd meg a Server Manager
3. "Manage" → Add Roles and Features
4. Role-based or feature-based installation
5. Válaszd ki a helyi szervert
6. Pipáld be: Active Directory Domain Services 
(A rendszer ezekután automatikusan felajánlja a szükséges feature-öket → Add Features)
7. Next → Install
Telepítés után egy sárga zászló jelenik meg a Server Managerben, mivel a szerepkör telepítése még nincs teljesen befejezve.
Az AD DS tartományvezérlővé promótálása
1. AD DS szerepkör telepítés után:
1. Server Manager → Notification flag
2. Promote this server to a domain controller
2. Deployment Configuration
Három lehetőség van:
· Add a new forest (Új forest létrehozása)
· Add a new domain to an existing forest (Új domain meglévő forestben)
· Add a domain controller to an existing domain (További DC meglévő domainhez)
1. Új rendszer esetén: Add a new forest / Új forest létrehozása
2. Ezután meg kell adni egy “domain name”-t
a. Lehet lokális pl. ceg.local
b. Lehet publikus pl. ceg.hu
3. Domain Controller Options
Beállítások:
· DNS Servert engedélyezzük
· Global Catalog-ot engedélyezzük
· Nem engedélyezzük a Read Only DC-t (ha nem RODC!)

DSRM jelszó: Directory Services Restore Mode jelszó (nagyon fontos!)

----- ELMÉLETI MEGJEGYZÉS -----
Mi az a Global Catalog?
· Egy normál Domain Controller:
· Csak a saját domainjének teljes adatbázisát tárolja.
· Egy Global Catalog szerver:
· a saját domainjének teljes adatbázisát tárolja
· az erdő (forest) összes többi domainjéből egy részleges másolatot
(Partial Attribute Set)
Mire jó a Global Catalog?
· Erdőszintű keresés: Ha egy többdomaines forestben keresel egy felhasználót, a GC tudja az összes domain objektumát (legalább részlegesen).
· Bejelentkezés (Universal Group tagság)
· A GC tartalmazza a Universal Group membership információkat.
· Ha nincs elérhető GC: a felhasználó nem- vagy csak korlátozottan tud bejelentkezni (többdomaines forestben)
· UPN alapú bejelentkezés
· Ha valaki így jelentkezik be: pl. “user@ceg.hu”
· A rendszer a Global Catalogból keresi ki, melyik domainben van a user.
Mi az a DRSM?
· DSRM (Directory Services Restore Mode) az Active Directory speciális helyreállítási módja egy tartományvezérlőn (Domain Controller).
· DSRM módot akkor használunk, ha például:
· sérült az Active Directory adatbázis
· rendszerállapot (System State) mentésből kell visszaállítani
· autoritatív restore szükséges
· offline AD javítást kell végezni (ntdsutil)
· jelszó-helyreállítás történik
· Ilyenkor a szervert DSRM módban kell indítani.
· Amikor egy szervert tartományvezérlővé promótálsz (pl. Windows Server 2025 alatt), kötelező megadni egy DRSM jelszót, ez:
· egy helyi admin jelszó
· csak DSRM módban használható
· független a domain admin jelszótól
· nem replikálódik más DC-kre
----- ELMÉLETI MEGJEGYZÉS VÉGE -----

4. DNS Options
Ha új forest, figyelmeztetés lesz (delegation nem található) → normális.

5. PATH
Alapértelmezett mappák:
· Database: C:\Windows\NTDS
· Logs: C:\Windows\NTDS
· SYSVOL: C:\Windows\SYSVOL
6. A telepítés után:
1. Automatikus újraindítás
2. A gép tartományvezérlővé válik

Active Directory alapfogalmak
Az AD logikai struktúrája:
Forest
 └── Domain
      └── OU
           └── User / Group / Computer

Active Directory alapkonfigurációk
1. Organizational Units (OU) létrehozása
1. Tools → Active Directory Users and Computers
2. Domain név → jobb klikk → New → Organizational Unit
2. Felhasználók létrehozása
OU → jobb klikk → New → User
Fontos mezők:
· First name
· Last name
· User logon name
Jelszó beállítás:
· User must change password at next logon, vagy
· Password never expires
3. Csoportok létrehozása
New → Group
Group scope:
· Global
· Domain Local
· Universal
Group type:
· Security (jogosultsághoz)
· Distribution (email)

DNS konfiguráció
Az AD működésének alapja a DNS
1. DNS ellenőrzés
Tools → DNS
· Ellenőrizni kell:
· Forward Lookup Zones
· _msdcs zone
· SRV rekordok
2. Forwarder beállítása
DNS Manager → Server → Properties → Forwarders
Add:
· 8.8.8.8 (primary)
· 8.8.4.4 (secondary)
· Így az internetes DNS lekérdezések is működnek.

DHCP (ha ugyanazon a szerveren van)
Ha DHCP is telepítve van:
1. DHCP role telepítése
2. Authorize DHCP in AD
3. DHCP Scope DNS beállítása:
· DNS server: <DC IP>
· DNS suffix: <domain-name>

Group Policy konfiguráció
Tools → Group Policy Management
Új GPO létrehozása:
1. OU → Create a GPO in this domain
2. Edit
· Példák:
· USB tiltás
· Desktop háttér
· Szoftver telepítés
· Tűzfal szabályok

Tartományba léptetés (kliens oldalon)
1. Client gépen: System → Rename this PC → Join domain
2. Írd be a “domain-name”-t (pl. ceg.local)
3. Domain admin hitelesítés
4. Újraindítás

Címtárszolgáltatás objektumainak kezelése

Címtárszolgálatatás objektumainak kezelése
Az objektumokat az Active Directory Domain Services kezeli.
Kezelő konzol: 
Tools → Active Directory Users and Computers (ADUC)
Mi az objektum az AD-ben?
Az AD-ben minden egy objektum, amely:
· Egyedi névvel rendelkezik
· Attribútumai vannak
· Jogosultságok rendelhetők hozzá
· Hierarchikus struktúrában helyezkedik el
Objektumtípusok:
· User (felhasználó)
· Computer (számítógép)
· Group (csoport)
· Organizational Unit (OU)
· Contact
· Shared Folder
· Printer
· Service Account

Organizational Unit (OU) kezelése
1. OU létrehozása
ADUC → Domain → jobb klikk → New → Organizational Unit
Fontos beállítás (pipáld be): Protect container from accidental deletion
2. OU konfiguráció
Jobb klikk OU → Properties
Lehetőségek:
· Description
· Managed By (delegálás miatt fontos)
· Group Policy linkelés (GPMC-ben)
3. Delegation (Jogosultság delegálás)
OU → jobb klikk → Delegate Control
Használható:
· pl. ha a HR csak user jelszót resetelhet
· pl. ha az IT csak számítógépet hozhat létre

User objektum kezelése
1. Felhasználó létrehozása
OU → New → User
Beállítások:
· First name
· Last name
· User logon name (UPN)
· username@domain
· Pre-Windows 2000 logon name
· csak username
· bejelentkezésnél: DOMAIN\username
2. User konfiguráció (Properties)
General: Alapadatok
Account
Fontos opciók:
· User must change password at next logon
· User cannot change password
· Password never expires
· Account is disabled
Logon Hours: Időkorlátozás beállítása
Logon To: Meghatározható, mely gépekre jelentkezhet be
Profile
· Roaming profile path
· Home folder
· Logon script
3. Fiók zárolás és feloldás
Account → Unlock account
4. Speciális attribútumok (Advanced Features)
View → Advanced Features
Ekkor elérhető:
· Attribute Editor
· Object tab
· Security tab

Computer objektum kezelése
1. Gépfiók létrehozása
OU → New → Computer
Általában tartományba léptetéskor jön létre.
2. Computer objektum konfiguráció
Properties:
· Description
· Managed by
· Delegation
· Location
3. Computer reset
Ha trust hiba van: Jobb klikk → Reset Account

Group objektum kezelése
1. Csoport létrehozása
OU → New → Group
Group scope:
· Global
· Domain Local
· Universal
Group type:
· Security
· Distribution
2. Csoport konfiguráció
Properties → Members
Tagok hozzáadása
3. AGDLP modell
Accounts → Global → Domain Local → Permission
Gyakorlat:
· User → Global Group
· Global → Domain Local
· Domain Local → NTFS jog

Contact objektum
Nem tud bejelentkezni
· Általában külsős partner email címe, vagy egy olyan személy aki nem dolgozik a domainben
· Viszont van neve, email címe és megjelenik a címlistában
Használat:
· New → Contact

Service Account objektum
Szolgáltatások futtatására
Típusok:
· Normál user account
· Managed Service Account (MSA)
· Group Managed Service Account (gMSA)

Objektum jogosultságok kezelése
View → Advanced Features
Object → Properties → Security
Beállítható:
· Read
· Write
· Delete
· Reset password
· Full control

Objektum törlés
Törléshez:
1. ADUC → View → ✔ Advanced Features
2. Objektum → Properties
3. Object fül
4. Vedd ki a pipát: Protect object from accidental deletion
5. Ok (mostmár törölhető az objektum)
6. Törlés

Objektum mozgatás
Drag & Drop másik OU-ba
Hatása:
· Új GPO érvényesül
· Új jogosultság öröklődik

Objektum attribútum kezelés (Attribute Editor)
Hol található?
1. ADUC → View → ✔ Advanced Features
2. Jobb klikk az objektumon → Properties
3. Megjelenik az Attribute Editor fül
Fontos attribútumok:
· distinguishedName
· Megmutatja az objektum teljes LDAP útvonalát
· objectGUID
· Egyedi azonosító
· Soha nem változik
· Replikációhoz használatos
· sAMAccountName
· Pre-Windows 2000 logon name
· Max 20 karakter
· userPrincipalName
· Modern logon név
· Formátum: user@domain

Objektumok keresése
ADUC felső menüsor:
· Action → Find, vagy
· Jobb klikk a domainen → Find
Mit lehet szűrni?
A Find ablakban:
Find legördülő:
· Users, Contacts, and Groups
· Computers
· Custom Search

AD Lomtár (Recycle Bin)
Az AD Lomtár az Active Directory Administrative Center (ADAC)-ben kezelhető.
Hol található?
Server Manager → Tools → Active Directory Administrative Center
Engedélyezés
Bal oldalon:
1. Domain kiválasztása
2. Jobb oldalon: Enable Recycle Bin
Figyelem, csak egyszer lehet engedélyezni!
Ha aktív:
Törlés után: ADAC → Deleted Objects
Itt:
1. Kijelölöd az objektumot
2. “Restore” vagy “Restore To…”
Mit állít vissza?
· Objektum
· Csoporttagság
· Jogosultságok
· SID
· Attribútumok

Gyakori admin műveletek
User disable / enable
ADUC → User → jobb klikk
· Disable Account
· Enable Account
Password reset
User → jobb klikk → Reset Password
Itt:
· Új jelszó
· User must change password
Computer account reset
Computer → jobb klikk → Reset Account
Ez:
· Trust kapcsolatot nulláz
Group membership módosítás
User → jobb klikk → Properties → Member Of 
Itt:
· Add
· Remove
Bulk műveletek (multi-select)
Több objektum kijelölése:
· CTRL + kattintás
· SHIFT + kijelölés
Jobb klikk után:
· Disable
· Move
· Delete
Megjegyzés: Nem minden művelet érhető el tömegesen


Csoportházirend szolgáltatások konfigurálása

A Csoportházirend szerepe
A Csoportházirend (Group Policy) az Active Directory egyik legfontosabb központi menedzsment eszköze, amellyel:
· Felhasználói és számítógép beállítások központi kezelése
· Biztonsági szabályok kikényszerítése
· Szoftvertelepítés és korlátozás
· Windows frissítések szabályozása
· Script-ek és login műveletek automatizálása
· A házirendek GPO-kban (Group Policy Object) tárolódnak.

GPMC megnyitása (GUI)
Lépések:
1. Server Manager megnyitása
2. Tools → Group Policy Management
3. Megnyílik a GPMC konzol
Itt látható:
· Forest
· Domains
· Group Policy Objects
· Sites
· WMI Filters
Új GPO létrehozása
Lépések:
1. Domain → jobb klikk → Create a GPO in this domain
2. Név megadása
3. OK
4. Ezután: Jobb klikk a GPO-n → Edit
Megnyílik a Group Policy Management Editor

GPO felépítése
A GPO két fő részből áll:
· User Configuration (felhasználóra vonatkozó beállítások):
· Desktop korlátozások
· Start menü
· Script-ek
· Registry
· Folder redirection
· Computer Configuration
· Számítógépre vonatkozó beállítások:
· Biztonság
· Szolgáltatások
· Windows Update
· Tűzfal
· Software deployment

Configuring Security Settings in Group Policy (GP)
Útvonal:
Computer Configuration → Policies → Windows Settings → Security Settings
Gyakori beállítások:
Jelszóházirend:
Account Policies → Password Policy
Konfiguráció:
· Minimum jelszóhossz
· Komplexitás
· Maximum életkor
· Jelszóelőzmények
Account lockout
Account Policies → Account Lockout Policy
Beállítható:
· Hibás próbálkozások száma
· Zárolási idő
· Reset idő

Windows Tűzfal konfigurálása
Útvonal:
Computer Configuration → Policies → Windows Settings → Security Settings
→ Windows Defender Firewall
Konfiguráció:
· Domain / Private / Public profil
· Bejövő és kimenő szabályok
· Port megnyitás
· ICMP engedélyezés

Windows Update konfigurálása (WSUS / központi frissítés)
Útvonal:
Computer Configuration → Policies → Administrative Templates
→ Windows Components → Windows Update
Fontos beállítások:
· Automatikus frissítés konfigurálása
· WSUS szerver megadása
· Újraindítás viselkedése
· Felhasználó értesítése

USB és eszközkorlátozás
Útvonal:
Computer Configuration → Policies  → Administrative Templates → System
→ Removable Storage Access
Konfiguráció:
· USB tiltás
· Írás tiltása
· Olvasás tiltása
· CD/DVD tiltás

Group Policy Software Deployment
Mi ez?
· Központi programtelepítés domain környezetben
· Automatikus telepítés bejelentkezéskor vagy induláskor
· Egységes verzió minden gépen
· Admin felügyelet alatt történik
Útvonal:
Computer Configuration → Policies → Software Settings → Software Installation
Lépések:
1. New → Package
2. UNC elérési út (fontos!!!)
3. Assigned vagy Published

Script-ek konfigurálása
Startup / Shutdown
Útvonal: Computer Configuration → Windows Settings → Scripts
Logon / Logoff
Útvonal: User Configuration → Windows Settings → Scripts

Használat:
· meghajtó csatolás
· automatizálás
· környezet konfiguráció

GPO linkelése
Mire való a GPO linkelés?
A GPO linkelés azt határozza meg, hogy mely felhasználókra vagy számítógépekre érvényes a házirend.
Ha egy GPO nincs linkelve, akkor nem alkalmazódik senkire — létezik, de „inaktív”.
A linkelés tehát a hatókört (scope) adja meg.
Linkelés:
· Site
· Domain
· OU
Jobb klikk → Link an Existing GPO

GPO szűrés (Security Filtering)
A GPO hatókör szűkíthető:
· Security Groups
· Felhasználók
· Számítógépek
Scope fül → Security Filtering

WMI szűrés
Mi ez?
A WMI szűrés (Windows Management Instrumentation Filtering) egy olyan technika a Microsoft Windows hálózatokban, amely lehetővé teszi a csoportházirendek (Group Policy Objects - GPO) dinamikus és pontos alkalmazását a célgépeken.
Lényegében egy olyan feltételrendszert (lekérdezést) hozol létre, amely ellenőrzi a számítógép tulajdonságait, és a házirend csak akkor fut le, ha a feltétel igaz.
Mire használják? (Példák)
A WMI szűréssel elkerülhető, hogy minden házirend minden gépre rákerüljön, így elkerülhetők a hibaüzenetek vagy a helytelen konfigurációk.
· OS verzió alapú szűrés: Csak a Windows 11-et futtató gépekre települjön egy szoftver.
· Hardver alapú szűrés: Csak a laptopokra (akku megléte) kerüljön rá egy energiagazdálkodási házirend.
· IP cím/Subnet szűrés: Csak a budapesti irodában található gépekre vonatkozzon egy nyomtatóbeállítás.
· Szabad lemezterület: Csak akkor futtasson egy takarító scriptet, ha a C: meghajtón 10GB-nál kevesebb a hely.

GPO feldolgozási sorrend (LSDOU)
A házirendek alkalmazási sorrendje:
1. Local
2. Site
3. Domain
4. OU (OU a legerősebb
Házirend frissítése
Kliensen: gpupdate /force
Ellenőrzés: gpresult /r

PowerShell szkript

PowerShell alapok
Gépnév megváltoztatása:
Rename-Computer -NewName "<gépnév>" -Restart
Ellenőrzés:
Get-ComputerInfo | Select-Object CsName
IP beállítások elvégzése:
Az elérhető afdapterek megjelenitése (ifindex):
Get-NetAdapter
IP és Gateway beállítása:
New-NetIPAddress -InterfaceIndex <interfaceindex> -IPAddress <ipaddress> 
-PrefixLength <prefix> -DefaultGateway <ipaddress>
DNS server beállítása:
Set-DnsClientServerAddress -InterfaceIndex <interfaceindex>
-ServerAddresses ("<ipaddress>","<ipaddress>")
IP beállítások törlése:
Remove-NetIPAddress -InterfaceIndex <interfaceindex> -Confirm:$false
Alapértelmezett átjáró törlése:
Remove-NetRoute -intefaceindex <interfaceindex>
DNS kliensek lekérdezése:
Get-DnsClientServerAddress
DNS beállitások törlése:
Set-DnsClientServerAddress -InterfaceIndex <interfaceindex> -ResetServerAddresses
Időzóna beállitások:
Az elérhető időzonák listája:
Get-TimeZone -ListAvailable
Időzóna beállitása (CET esetén):
Set-TimeZone -Id "Central Europe Standard Time"
Ellenőrzés:
Get-timezone

AD DS telepítése PowerShell-en keresztül

AD DS szolgáltatás telepítése:
Install-WindowsFeature -Name AD-Domain-Services -IncludeManagementTools
Erdő létrehozása:
Install-ADDSForest -DomainName "example.com" -DomainMode "Win2016" -ForestMode "Win2016" -DomainNetbiosName "EXAMPLE" -InstallDns -Force
Ebben a példában az alábbi paramétereket használjuk:
· DomainName: Az új erdő teljes DNS neve.
· DomainMode: Az új erdő domain üzemmódja. Ebben az esetben "Win2016", ami azt jelenti, hogy Windows Server 2016 üzemmódban fog működni.
· ForestMode: Az erdő üzemmódja. Szintén "Win2016".
· DomainNetbiosName: Az új erdő NetBIOS neve.
· InstallDns: Az AD DS-hez tartozó DNS szolgáltatások telepítése. 
· Force: Az opció arra kényszeríti a telepítést, hogy felülírja a meglévő konfigurációt. 
· Fontos megjegyezni, hogy az Install-ADDSForest cmdlet futtatása rendszergazdai jogosultságokat igényel, így PowerShell-t rendszergazdaként kell futtatni.

Új felhasználó létrehozása:
New-ADUser -Name "FelhasznaloNeve" -SamAccountName "FelhasznaloNeve" - AccountPassword (ConvertTo-SecureString -AsPlainText "Jelszo" -Force) -Enabled $true
Felhasználó törlése:
Remove-ADUser -Identity "FelhasznaloNeve" -Confirm:$false
Felhasználó jelszavának beállítása:
Set-ADAccountPassword -Identity "FelhasznaloNeve" -NewPassword (ConvertToSecureString -AsPlainText "UjJelszo" -Force)
Felhasználó zárolása:
Disable-ADAccount -Identity "FelhasznaloNeve"
Felhasználó engedélyezése (zárolás feloldása):
Enable-ADAccount -Identity "FelhasznaloNeve"
Felhasználónak kötelező jelszómódosítás beállítása a következő bejelentkezéskor:
Set-ADUser -Identity "FelhasznaloNeve" -ChangePasswordAtLogon $true
Új csoport létrehozása:
New-ADGroup -Name "CsoportNeve" -GroupScope Global -GroupCategory Security
Felhasználó hozzáadása csoportba:
Add-ADGroupMember -Identity "CsoportNeve" -Members "FelhasznaloNeve"
Felhasználó eltávolítása csoportból:
Remove-ADGroupMember -Identity "CsoportNeve" -Members "FelhasznaloNeve"
Csoport törlése:
Remove-ADGroup -Identity "CsoportNeve"
Csoport tagjainak lekérdezése:
Get-ADGroupMember -Identity "CsoportNeve"
Szervezeti egységek (OU) lekérdezése:
Get-ADOrganizationalUnit -Filter *
Új szervezeti egység (OU) létrehozása:
New-ADOrganizationalUnit -Name "ÚjOU" -Path "OU=ParentOU,DC=domain,DC=com"
Objektum hozzáadása szervezeti egységhez:
Add-ADGroupMember -Identity "CN=Group,CN=Users,DC=domain,DC=com" -Members "CN=User,CN=Users,DC=domain,DC=com"

Csatlakozás létező domainhoz
Install-ADDSDomainController -DomainName "MeglévőDomainNeve" -SiteName "AzonosítottTelephelyNeve" -Credential (Get-Credential)
Ebben a parancsban a következő paramétereket kell megadni:
· DomainName: A meglévő tartomány neve, ahova a szerver csatlakozni fog.
· SiteName: A telephely neve, amelyhez a szerver csatlakozni fog.
· Credential: Az adminisztrátori jogosultsággal rendelkező felhasználói fiókhoz tartozó hitelesítési objektum, amelynek joga van Domain Controller telepítésére.

Tartományvezérlő kiléptetése a tartományból
Uninstall-ADDSDomainController -DemoteOperationMasterRole - RemoveApplicationPartitions -Force
Fontos megjegyezni, ha ez volt az egyetlen/utolsó DC a tartományban, akkor problémák lehetnek akár DNS-, akár Domain Authentication- illetve még más területen is!	

ADDS erdő törlése
Uninstall-ADDSDomainController -DemoteOperationMasterRole - RemoveApplicationPartitions -Force

Windows Server Backup

Windows Server Backup
Mi az a Windows Server Backup?
A Windows Server Backup (WSB) egy beépített mentési megoldás, amely lehetővé teszi:
· teljes szerver mentés
· kötet mentés
· rendszerállapot mentés
· fájl és mappa mentés
· bare-metal recovery
Használható:
· helyi lemezre
· külső meghajtóra
· hálózati megosztásra

Windows Server Backup telepítése
Alapból nem mindig telepített.
Telepítés lépései (GUI):
1. Nyisd meg a Server Manager
2. Manage → Add Roles and Features
3. Features résznél jelöld be:
· Windows Server Backup
4. Next → Install
5. Telepítés után nem szükséges újraindítás

Windows Server Backup megnyitása
1. Server Manager
2. Tools → Windows Server Backup
Megnyílik a WSB konzol.

Mentési konfigurációk
Egyszeri mentés (One-time backup)
Lépések:
1. Jobb oldalon Local Backup
2. Action → Backup Once
3. Válaszd:
· Scheduled Backup options (ha már van ütemezés)
· Different options (legtöbbször ez)
Mentés típusa
· Full server
· Custom
· Custom esetén kiválasztható:
· Kötetek
· Fájlok
· System State
Cél kiválasztása
· Local drives
· Remote shared folder

Ütemezett mentés (Scheduled backup)
Ez a legfontosabb vizsgán és gyakorlatban.
Lépések:
1. Local Backup → Backup Schedule
2. Backup Configuration Wizard indul
Mentési mód
· Full Server (gyors visszaállítás)
· Custom (erőforrás kímélő)
Ütemezés
· Naponta egyszer
· Naponta többször (pl. 4 óránként)
(Gyakori gyakorlat: napi egyszer + kritikus szervernél többször)

Mentési cél konfiguráció
Dedikált backup lemez
Legjobb megoldás
Előny:
· automatikus rotáció
· gyors
· megbízható
Hátrány:
· csak mentésre használható
Volume backup
Egy meglévő kötetre ment.
Kockázat: ha a kötet sérül → backup is sérül
Hálózati megosztás
· NAS
· másik szerver
· SMB share
Figyelni kell:
· jogosultság
· hitelesítés
· hálózati sebesség

Fontos konfigurációs beállítások
VSS (Volume Shadow Copy)
A WSB a Volume Shadow Copy Service segítségével készít konzisztens mentést.
Ez lehetővé teszi:
· a futó szolgáltatások mentését
· az adatbázis mentést
· az AD mentést
System State mentés
Tartalmazza:
· Registry
· Boot files
· COM+
· Active Directory
· SYSVOL
Domain Controller esetén kötelező!
Bare Metal Recovery
Lehetővé teszi:
· teljes szerver visszaállítás új hardverre
· OS + konfiguráció + adat

Visszaállítás (Recovery)
Lépések:
1. Windows Server Backup
2. Recover
3. Backup hely kiválasztása
4. Recovery típus:
· Files and folders
· Volumes
· Applications
· System State
· Bare metal

Távmenedzsment (pl. RSAT)

RSAT-ról általánosan
Az RSAT (Remote Server Administration Tools) egy olyan Microsoft eszközkészlet, amely lehetővé teszi a rendszergazdák számára, hogy távolról kezeljék a Windows Server operációs rendszert futtató szervereket egy Windows kliens operációs rendszerről (pl. Windows 10, Windows 11).

Az RSAT segítségével egy Windows alapú kliensről elérhetők és konfigurálhatók a következő szerveres szerepkörök és szolgáltatások:
· Active Directory (AD) eszközök – Felhasználók, csoportok, számítógépek kezelése
· DNS és DHCP kezelése – Tartománynévrendszer és IP-cím kiosztás konfigurálása
· Group Policy Management Console (GPMC) – Csoportházirendek (GPO-k) kezelése
· Hyper-V Manager – Virtuális gépek és Hyper-V infrastruktúra menedzselése
· Failover Cluster Manager – Klaszterezett szerverek kezelése
· File Server Resource Manager (FSRM) – Fájlszerverek és kvóták adminisztrálása
· Windows Server Update Services (WSUS) konzol – Frissítések kezelése
RSAT lehetőséget biztosít a PowerShell és grafikus kezelőfelületű (GUI) eszközök használatára egyaránt.

RSAT és Firewall settings
Az RSAT által használt portok az adott szolgáltatástól függnek, de a leggyakoribbak:
· Kerberos hitelesítés – UDP/TCP 88
· LDAP (Active Directory kapcsolatok) – TCP/UDP 389
· LDAPS (LDAP Secure) – TCP 636
· Global Catalog (AD lekérdezések) – TCP 3268
· RDP (Remote Desktop Protocol) – TCP/UDP 3389
· SMB (File Sharing, Group Policy replicáció) – TCP 445
· WinRM (Windows Remote Management, PowerShell távvezérléshez) – HTTP: TCP 5985, HTTPS: TCP 5986
Ha RSAT-ot használunk egy tűzfallal védett környezetben, akkor biztosítani kell, hogy ezek a portok elérhetőek legyenek

RSAT használatának előnyei és hátrányai
Előnyök:
· Távoli szerverkezelés – Nem szükséges közvetlenül a szerveren dolgozni
· Központosított adminisztráció – Több szerver kezelése egy kliens gépről
· GUI és PowerShell támogatás – Grafikus és parancssoros menedzsment
· Biztonságos – Használható WinRM és LDAPS alapú biztonságos kommunikációval
· Ingyenes – Nem igényel külön licenszet, a Windows része

Hátrányok:
· Kliens operációs rendszertől függ – Windows Home verziókon nem érhető el
· Tűzfal és hálózati beállításokat igényelhet – Bizonyos portok megnyitása szükséges
· Nem minden Windows verzión működik azonos módon – RSAT telepítése és működése eltérhet
· Windows 10 és Windows 11 esetében
· Nem helyettesíti a teljes szerverhozzáférést – Bizonyos konfigurációs lehetőségekhez továbbra is RDP vagy fizikai hozzáférés kellhet

RSAT beállítása szerver és kliens oldalon
Szerveren:
A kiindulás az, hogy:
· Már fut és működik a Windows szerveren az AD DS, DNS szolgáltatás.
· A szerver domain tag
· A WinRM engedélyezve van
· A jogosultságok be vannak állítva a távmendezsmenthez

Nyilván ezeket nem árt ellenőrzni, ezért a következőkben megnézzük, hogy teljesülnek-e a fenti pontok:
1. Remote Management Check
Server Manager → Local Server
Keresd: Remote Management (Enabled kell legyen, ha nem katt → Enable)
2. WinRM check
PowerShell: winrm quickconfig
Ha fut → kész
3. Firewall check
Server Manager → Tools → Windows Defender Firewall
Ellenőrizd inbound
· Windows Remote Management
· Remote Event Log
· WMI
· RPC
4. Remote Desktop (nem kötelező de ajánlott)
Server Manager → Local Server → Remote Desktop → Enable

Kliensen:
A kiindulás az, hogy a  Windows 10/11 gép:
· admin gép (tehát itt ugye fontos a jogosultság!!!)
· domain tag
· DNS működik

1. RSAT telepítés
GUI:
Settings → Apps → Optional Features → Add feature
Telepítsd:
· AD DS Tools
· DNS Tools
· Group Policy
· DHCP (ha van)
VAGY

PowerShell:
Az online elérhető RSAT modulok klistázása:
Get-WindowsCapability -Name RSAT* -Online

A parancs kimenete nem könnyen átekinthető, ezért érdemes a megjelenitendő paraméteerek számát csökkenteni:
Get-WindowsCapability -Name RSAT* -Online | Select-Object -Property DisplayName, State

Az összes elérhető RSAT modul telepítése:
Get-WindowsCapability -Name RSAT* -Online | Add-WindowsCapability -Online

VPN kapcsolat konfigurálás

Előkészületek
Mielőtt beállítanánk a VPN-t, győződj meg róla, hogy:
· A Windows Server 2025 telepítve van, és van adminisztrátori jogosultságod.
· A szerver rendelkezik stabil internetkapcsolattal.
· Ellenőrizd a tűzfal és a NAT beállításokat, hogy a VPN protokollok átmenjenek.
· Egy statikus IP-cím beállítása a VPN szerverhez (ajánlott, hogy a kliensek mindig ugyanahhoz a címhez csatlakozzanak).
· Rendelkezel érvényes Active Directory felhasználókkal, ha a VPN hitelesítés AD-val történik.

VPN Szerepkör Telepítése (Routing and Remote Access)
1. Nyisd meg a Server Manager → Add Roles and Features
2. Válaszd a Role-based or feature-based installation lehetőséget → Next
3. Válaszd ki a szervert → Next
4. A Roles listából pipáld ki:
· Remote Access
· Ezután jelöld a DirectAccess and VPN (RAS) szerepkört
5. A Features résznél hagyd az alapértelmezettet → Next
6. Telepítsd a szerepkört → várd meg a telepítést → Close

Routing and Remote Access (RRAS) konfigurálása
1. Nyisd meg a Server Manager → Tools → Routing and Remote Access
2. Jobbklikk a szerver nevére → Configure and Enable Routing and Remote Access
3. Válaszd a Custom Configuration → Next
4. Pipáld ki a VPN Access → Next
5. Indítsd újra a szolgáltatást, ha kéri
6. Ekkor a szerver készen áll VPN kapcsolatok fogadására

VPN Protokollok kiválasztása
A Windows Server 2025 támogatja a következő VPN protokollokat:
· PPTP (Point-to-Point Tunneling Protocol) – könnyen konfigurálható, de kevésbé biztonságos
· L2TP/IPsec (Layer 2 Tunneling Protocol) – nagyon biztonságos, IPsec titkosítással. Szükséges: előre megosztott kulcs (PSK) vagy tanúsítvány
· SSTP (Secure Socket Tunneling Protocol) – SSL alapú, jól működik tűzfal mögött
· IKEv2 – modern, biztonságos és gyors, mobil kliensekhez ideális
Ajánlás: L2TP/IPsec vagy IKEv2, ha a biztonság prioritás


VPN Tartományok és IP-címek beállítása
1. RRAS → jobbklikk a szerver → Properties
2. Menj a IPv4 fülre → Static address pool → add hozzá a VPN klienseknek szánt IP-cím tartományt (pl. 192.168.100.50–192.168.100.100)
3. Alternatív: DHCP szervert is használhatsz
4. Győződj meg róla, hogy a szerver útvonalat ad a VPN IP-knek az intranethez

Hitelesítés beállítása
1. RRAS → jobbklikk a szerver → Properties → Security fül
2. Válaszd az “Authentication provider”-t:
· Windows Authentication (Active Directory felhasználók)
· RADIUS (külső AAA szerver)
3. PPTP esetén: MS-CHAP v2
4. L2TP/IKEv2 esetén: előre megosztott kulcs (PSK) vagy tanúsítvány szükséges

Tűzfal és Port Forwarding
	Protokoll
	Port
	Protokoll típusa

	PPTP
	1723
	TCP

	L2TP/IPsec
	1701
	UDP

	IPsec ESP
	50
	IP

	IKE
	500
	UDP

	SSTP
	443
	TCP


 VPN működéséhez a következő portokat engedélyezni kell:

· Ha NAT mögött vagy: állíts be port forwardingot a routeren
· Engedélyezd a Windows tűzfalban a “Routing and Remote Access” szolgáltatást

VPN kliens konfiguráció (Windows 10/11)
1. Settings → Network & Internet → VPN → Add a VPN connection
2. Töltsd ki:
· VPN provider: Windows (built-in)
· Connection name: pl. Cég VPN
· Server name or address: szerver publikus IP-je vagy DNS neve
· VPN type: L2TP/IPsec with pre-shared key
· Pre-shared key: amit a szerveren beállítottál
· Sign-in info: felhasználónév/jelszó (AD felhasználó)
3. Mentés → Connect

Teszt és hibakeresés
1. Csatlakozz a VPN klienssel
2. Pingeld a belső hálózat IP-címeit
3. RRAS → Monitoring → Ports menüpontban ellenőrizheted a kapcsolat állapotát
Hibák esetén:
· Ellenőrizd a portokat a tűzfalon/routeren
· Ellenőrizd a hitelesítést (AD felhasználó aktív?)
· L2TP/IPsec esetén győződj meg a PSK/tanúsítvány helyességéről

Biztonsági ajánlások
· Használj erős jelszavakat.
· L2TP/IPsec vagy IKEv2 használata ajánlott PPTP helyett.
· Rendszeresen frissítsd a Windows Servert.
· Auditáld a VPN csatlakozásokat.
· Használj kétfaktoros hitelesítést (2FA), ha lehetséges.

IIS

IIS általánosan
Mi az IIS?
· Az IIS a Microsoft beépített webszervere amely alkalmas:
· weboldalak és webalkalmazások futtatására
· FTP és FTPS szolgáltatásokra
· API-k hosztolására
· ASP.NET és .NET alkalmazások futtatására
· hitelesítés és jogosultságkezelés integrációjára Active Directoryval
· Protokoll támogatás: HTTP/HTTPS, FTP/FTPS, WebSocket, HTTP/2, HTTP/3 (újabb build függő)

IIS konfigurálása
1. IIS telepítése GUI használatával
1. Server Manager megnyitása
· Kattints a Start menüre → Server Manager.
· Vagy keresd a Server Manager-t a keresőben.
2. Role & Feature hozzáadása
· Server Manager → Manage → Add Roles and Features.
· Válaszd a Role-based or feature-based installation lehetőséget.
· Válaszd ki a szervert, amin telepíteni szeretnéd.
3. IIS szerepkör kiválasztása
· A Server Roles listában pipáld ki az Web Server (IIS) lehetőséget.
· Megjelenik egy ablak a szükséges funkciókkal → Add Features gomb.
4. Feature-ek kiválasztása (opcionális)
· Alapértelmezett feature-ek elegendőek a legtöbb webkiszolgálóhoz.
· Ha szükséges, pipálhatod a .NET Extensibility, ASP.NET,
WebDAV Publishing, FTP Server funkciókat.
5. Telepítés
· Kattints a Install gombra.
· A telepítés után ellenőrizheted az IIS működését: nyisd meg a böngészőt → http://localhost → a "Welcome to IIS" oldalnak kell megjelennie.
2. IIS GUI alapú kezelése
· Nyisd meg az Internet Information Services (IIS) Manager-t:
· Start → IIS Manager
· Vagy inetmgr parancs a Futtatás ablakból (Win+R)
Fő ablak felépítése:
· Connections panel: a szerver, site-ok és alkalmazások hierarchiája.
· Features View: kiválasztott webhelyhez tartozó beállítások.
· Actions panel: gyors műveletek (pl. Start, Stop, Restart, Add Website).

3. Webhely létrehozása GUI-ban
1. Jobb klikk a Sites → Add Website…
· Site name: A webhely neve.
· Physical path: Mappa az alkalmazásfájloknak.
· Binding:
· IP Address: Minden IP vagy konkrét IP.
· Port: 80 (HTTP), 443 (HTTPS).
· Host name: pl. www.example.com (ha több domain ugyanazon IP-n).
2. Alkalmazás pool hozzárendelése
· Alapértelmezett: DefaultAppPool.
· Külön alkalmazás pool létrehozása:
· Application Pools → Add Application Pool → név, .NET verzió,
pipeline mode.
· Alkalmazás pool beállításai:
· Managed pipeline mode: Integrated (általában).
· .NET CLR version: pl. v4.0.
· Start application pool immediately: pipáld be.

4. Alapvető konfigurációk IIS-ben
1. Authentication (Hitelesítés)
· IIS Manager → kiválasztott webhely → Authentication
· Anonymous Authentication: alapértelmezett engedélyezett.
· Windows Authentication: csak intranetes oldalakhoz.
· Basic / Digest Authentication: opcionális, HTTPS mellett.
2. Authorization Rules (Engedélyezési szabályok)
· Kiválasztott webhely → Authorization Rules
· Alapértelmezett: mindenki hozzáfér.
· Lehet szabályozni felhasználó, csoport, IP alapján.
3. MIME Types
· Meghatározza, hogy a szerver milyen fájlformátumokat szolgálhat ki.
· Példa: .json → application/json.
4. SSL / HTTPS konfiguráció
· Webhely → Bindings → Edit → HTTPS
· Szükséges SSL Certificate telepítése a szerverre.
· Port: 443
· SSL/TLS beállítások az SSL Settings panelen:
· Require SSL: pipáld be, ha kötelező a titkosított kapcsolat.
· Client certificates: Optional vagy Required.

5. Alkalmazás pool konfiguráció
1. Alkalmazás pool beállításai
· Start / Stop / Recycle.
· Advanced Settings:
· Identity: alkalmazás futtatása rendszer- vagy felhasználói fiókkal.
· Idle Time-out: alapértelmezett 20 perc.
· Recycling: naponta, heti vagy CPU használat alapján újraindítás.
2. Teljesítmény optimalizálás
· Maximum worker processes (web garden): több processz
párhuzamos futtatása.
· Rapid-fail protection: automatikusan leállítja a problémás alkalmazást.

6. Logging és monitoring
· IIS Manager → kiválasztott webhely → Logging
· Alapértelmezett: <SystemDrive>\inetpub\logs\LogFiles
· Log format: W3C, UTF-8, daily rollover.
· Monitoring:
· Worker Processes: futó folyamatok.
· Requests: per-site statisztika.






Hálózat
VLAN-ok használata, VLAN-ok közötti forgalomirányítás
Layer 2-es technológia a Switcheken használjuk. Maga a VLAN(Virtual Local Area Network) logikailag bontja fel a fizikai hálózatot így nagyobb lesz a biztonság.

VLAN létrehozása switchen:
config# vlan <vlan száma> 
vlan#name <vlan neve>

Ezek után VLAN-hoz  kell rendelni az interfacek-et:
config#interface <int neve>
int# switchport mode <trunking módja>
int# switchport <trunking módja> vlan <vlan száma>
int# switchport voice vlan <vlan száma> → IP telefonokhoz így kell voice VLAN-t hozzáadni
Ahhoz hogy több VLAN forgalma is át tudjon menni a hálózaton Trunk-ölni kell az interface-eket.

Trunk config switch-en
int#switchport mode <trunking módja>
int#switchport <trunking módja> allowed vlan <vlanok szám> 
(és szóközzel elválasztva ha több van → opcionális, nem muszáj megadni anélkül is működni fog)
int#switchport <trunking módja> native vlan <A native vlan száma> → A tageletlen nem vlan képes eszközöknek kell ezt létrehozni.

A trunk-öt azokon az interface-eken kell állítani ahol nincs vlan hozzáadva az interface-hez.

VLAN-ok közötti forgalomirányítás Router-en
A router-on-a-stick megoldással lehet több vlan között forgalmat irányítani ehhez subinterface-eket kell létrehozni.

config#int <int neve után egy pont és egy szám> → Subinterface létrehozása
subint#encapsulation dot1Q <vlan száma> (native) → ha a vlan native akkor kell utána a native szó
subinf#ip address <IP cím> <hálózati maszk> → IP címet kell megadni a subint-nek, de nem kapcsoljuk fel
int# no sh → A fizikai int-en kell felkapcsolni és igy az összes subint fel fog kapcsolni

IP telefon konfiguráció Router-en:
Router(config)# telephony-service
Router(config-telephony)# max-ephones <max szám> → Maximum telefonok száma
Router(config-telephony)# max-dn <max vonal szám> → Maximum vonalak/számok száma
Router(config-telephony)# ip source-address <router IP> port <port szám 2000-2999 között>
Router(config-telephony)# auto assign <első> szám> to <utolsó szám> → Automatikus számkiosztás

Telefonszám hozzárendelése (Directory Number):
Router(config)# ephone-dn <vonal száma> → belépünk egy vonalra
Router(config-ephone-dn)# number <telefon száma> → Az első telefon száma

Multilayer switch (MLS) VLAN-ok közötti forgalomirányítás
Multilayer switch-en a VLAN forgalom irányításnál SVI(Switch Virtual Interface)-t kell létrehozni és IP címmel ellátni. Trunk-öt állítani kell mint egy hagyományos layer2-es switch-en kivéve ha az int-et layer3-as ként kezeljük, ott nem kell.

config#vlan <vlan száma> → vlan létrehozás
vlan# name <vlan neve> → vlan név megadása
config#int vlan <vlan száma> → belépünk a vlan-ra
	vlan-int#ip address <IP cím> <maszk>
	vlan-int#no sh
config#ip routing → Forgalomirányítás engedélyezése a switch-en

Ha van routerrel kapcsolata az MLS-nek akkor az int-et úgy kezeljük mint egy router 
int-et, IP címmel kell ellátni:
config#int <int neve>
	int#no switchport → ezzel állítjuk át layer3-as port-ra és adhatunk majd IP címet neki
	int# ip address <IP cím> <maszk>

Fontosabb show parancsok:
· show vlan brief
· show interfaces trunk
· show ip interface brief

Második rétegbeli redundancia:
A második rétegbeli redundancia a spanning-tree(feszítőfa) lesz használva megakadályozva a hurkokat és a a szórási viharokat, mivel layer2-es switchen lesz konfigurálva.

Feszítőfa módok:
· STP (IEEE 802.1D): Az alapértelmezett feszítőfa protokoll, amely lassan (30-50 másodperc) reagál a topológiai változásokra.
· RSTP (Rapid Spanning Tree Protocol - IEEE 802.1w): A standard STP gyorsított változata, amely jelentősen lecsökkenti a hálózat újraépülésének idejét.
· PVST+ (Per-VLAN Spanning Tree Plus): A Cisco saját fejlesztése, amely lehetővé teszi, hogy minden egyes VLAN-hoz külön feszítőfa tartozzon, így optimalizálva a sávszélességet.
· MSTP (Multiple Spanning Tree Protocol): Több VLAN-t csoportosít egyetlen feszítőfa példányba, csökkentve az eszközök processzorterhelését.

Root Bridge választás:
A Bridge ID két fő részből áll, amelyeket a switchek a BPDU (Bridge Protocol Data Unit) csomagokban hirdetnek ki:
1. Bridge Priority (Prioritás):
· Ez egy konfigurálható érték, amelynek alapértelmezett értéke minden Cisco switchen 32768.
· A prioritást 4096-os lépésközökkel lehet módosítani (pl. 0, 4096, 8192 stb.).
· A választásnál a kisebb érték a nyerő. Ha azt akarod, hogy egy adott switch legyen a főnök, állíts be neki alacsonyabb prioritást.

2. MAC cím:
· Ha a prioritások megegyeznek (ami alapbeállításnál törvényszerű), akkor a legalacsonyabb MAC címmel rendelkező switch nyeri a választást.
· Mivel a régebbi eszközöknek gyakran kisebb a MAC címük, manuális beállítás nélkül előfordulhat, hogy egy régi, lassú switch lesz a hálózat központja, ami rontja a teljesítményt.

Minden VLAN-nak be lehet állítani külön a root bridge-et.

Port típusok:
· Root Port (RP): A nem-gyökér switchen az a port, amelyik a leggyorsabb utat biztosítja a Root Bridge-hez. Switchenként csak egy lehet belőle. (Állapota: Forwarding)
· Designated Port (DP): A hálózati szegmens "kiválasztott" portja, amely a forgalmat továbbítja. A Root Bridge összes portja ilyen. (Állapota: Forwarding)
· Alternate / Non-Designated Port: Tartalék port. Ha a Root Port kiesik, ez léphet a helyére. (Állapota: Blocking)



Port állapotok:
· Blocking → Csak BPDU-kat fogad. Nem küld adatot, hogy elkerülje a hurkot.
· Listening → Megpróbálja eldönteni a szerepköröket (RP, DP). Még nincs adatforgalom.
· Learning → Elkezdi feltölteni a MAC-címtáblát, de még nem továbbít kereteket.
· Forwarding → Normál üzemmód: küld/fogad adatot és tanulja a címeket.
· Disabled → A port szoftveresen le van kapcsolva (shutdown).


Beállítása:
· config#spanning-tree mode <STP módja>
· config#spanning-tree vlan <vlan száma> priority <prioritás értéke> → Root bridge megadása priority értékkel
· config#spanning-tree vlan <vlan száma> root <primary/secondary> → Root bridge megadása konkrét kifejezéssel
· int#spanning-tree bpduguard enable → BPDU guard engedélyezése 
· int#spanning-tree portfast → portfast bekapcsolása(olyan porton ami nem trunk port)

Show parancsok:
· show spanning-tree (summary)
Dinamikus címkiosztás IPv4 környezetben
A DHCPv4-et meg lehet valósítani Router-en és szerveren is

Routeren:
· config#ip dhcp excluded-address <IP cím, mettől> <IP cím, meddig>
· Ezzel kizárjuk a címeket amit nem akarunk ki osztani
· config#ip dhcp pool <pool neve>
· pool-t kell létrehozni amiben megadjuk a beállításokat
· dhcp-conf#network <IP cím> <maszk>
· megadjuk a hálózatot ahonnan a címeket fogjuk kiosztani és a maszkot
· dhcp-conf#default-router <Router IP>
· azt az int IP adjuk meg ahova a DHCP-t használjuk ez lesz a host-ok alapértelmezett átjárója
· dhcp-conf#dns-server <Szerver IP>
· a dns szerver ip címét adjuk meg
· int#ip helper-address <cél IP cím>
· ha a DHCP szerver és a kliens másik hálózatba van akkor ezzel a paranccsal megadjuk a kliens default-gateway-nek azt az IP címet ahova azt  a broadcast üzenetet küldi tovább


Show parancs(ok):
· show ip dhcp pool <pool neve>

DHCP szerver (cisco packet tracerben)
2. Be kell kapcsolni a szolgáltatást
3. Pool név beállítás (az első pool név nem átírható)
4. alapértelmezett átjáró megadása (IP cím)
5. DNS szerver IP cím megadása
6. Kezdő IP cím → Ez lesz az első cím amit ki oszt a szerver
7. A hálózat maszkja
8. Max hány címet osszon ki
9. Ha kell, TFTP IP cím
IPv6 címzés és dinamikus címkiosztás IPv6 környezetben:
Az IPv6-os címzés 128 bites címeket használunk, amiket hexadecimális formában írunk fel. Minden eszköznek 2 fajta IPv6-os címzése lehet, maga a IPv6-os ezzel az IP címmel lesz látható mindenki számára, és egy link-local ami csak az adott fizikai eszközök között működik.

Router konfiguráció (címzés)
· config#ipv6 unicast-routing
· Megadjuk a routernek hogy IPv6-os címeket is kezeljen
· config#int <int név>
· int#ipv6 address <ipv6-os cím>/<prefix>
· IPv6-os cím osztás egy in-re
· int#ipv6 address FE80::1 link-local
· IPv6-os helyi(local) cím osztás

Router konfiguráció (dinamikus címkiosztás)
SLAAC:
Ebben az esetben a router csak a hálózati prefixet hirdeti meg, a PC pedig maga generálja a cím végét. Nincsmit állítani csak az IP címet az interface-re, de nincs DNS szerver

Stateless DHCPv6 (SLAAC + DNS)
· (config)# ipv6 dhcp pool <pool név>
· (config-dhcpv6)# dns-server <DNS szerver IP>
· (config-dhcpv6)# domain-name <Domain név>
· (config)# interface <int név>
· (config-if)# ipv6 address <IPv6 cím>
· (config-if)# ipv6 dhcp server <pool név>
· (config-if)# ipv6 nd other-config-flag  → "O" flag: keresd a DHCP-t infókért!
Itt csak a DNS szerver IP címe lesz a DHCP pool-bol

Stateful DHCPv6 (Mint az IPv4-nél)
· (config)# ipv6 dhcp pool <pool név>
· (config-dhcpv6)# address prefix <IPv6 tartomány prefix-el>
· (config-dhcpv6)# dns-server <DNS szerver IP>
· (config)# interface <int név>
· (config-if)# ipv6 address <IPv6 cím>
· (config-if)# ipv6 dhcp server <pool név>
· (config-if)# ipv6 nd managed-config-flag  # "M" flag: az IP-t a DHCP-től kérd!
· (config-if)# ipv6 nd prefix <IPv6 tartomány prefix-el> no-autoconfig → Ne használj SLAAC-t!

Harmadik rétegbeli redundancia 
Router-ek között cisco-nál HSRP konfigurálás kell majd végezni. A HSRP (Hot Standby Router Protocol) a Cisco saját fejlesztésű megoldása a redundáns alapértelmezett átjáró (Default Gateway) biztosítására. 

Fő router(Active):
· (config)# interface <int név>
· (config-if)# ip address <IP> <maszk>
· (config-if)# standby <csoport azonosító szám> ip <virtual IP> → Virtuális IP megadása
· (config-if)# standby <csoport azonosító szám> priority <érték (nagyobb mint 100)> →Magasabb prioritás = Ő lesz az Active
· (config-if)# standby <csoport azonosító szám> preempt → Ha visszatér a hibából, vegye vissza a szerepét

Tartalék router(Standby):
· (config)# interface <int név>
· (config-if)# ip address <IP> <maszk>
· (config-if)# standby <csoport azonosító szám> ip <virtual IP> → Virtuális IP megadása
· (config-if)# standby <csoport azonosító szám> priority <érték (min 100 de nem nagyobb mint az Active-é)> → Alacsonyabb prioritás = Standby marad

Interface Tracking (Interfész figyelés):
· (config-if)# standby <csoport azonosító szám> track <int név> <pirority érték amit levon>

Ha a egy int leáll, a router levon x mennyiséget a saját prioritásából. Így a prioritása (x mennyiséggel) alacsonyabb lesz, mint a tartaléké, és a forgalom automatikusan átterelődik a másik routerre.

Időzítők finomhangolása (Timers):
Alapból a HSRP 3 másodpercenként küld üzenetet, és 10 másodperc után mondja ki, hogy a társ "halott". Ezt csökkenthető, hogy a váltás villámgyors legyen:
· (config-if)# standby <csoport azonosító szám> timers <hello üzenet küldés másodpercben> <váltás másodpercben>

Hitelesítés (Authentication)
Megakadályozza, hogy valaki a hálózatra dugjon egy saját routert és "ellopja" a Default Gateway szerepét egy magasabb prioritással.
· (config-if)# standby <csoport azonosító szám> authentication md5 key-string <jelszó>
Csak azok a routerek állnak párba, amik ismerik a jelszót.

Show parancsok:
· en# show standby brief
· en# show standby

Hálózatbiztonság, kapcsoló biztonságossá tétele

Port-security
Port-security layer2, switch konfiguráció. Port security-t csak access (végponti) porton lehet beállítani. Trunk porton nem működik.
· (config-if)# switchport mode access
· (config-if)# switchport port-security

MAC cím tanulási módszerek
Static → Kézzel beírod a gép MAC címét.
Sticky (Ajánlott) → A switch megtanulja az elsőként csatlakoztatott eszköz címét, és beírja a futó konfigurációba (running-config). Így újraindítás után is emlékezni fog rá. Cisco Port Security Guide.
· Switch(config-if)# switchport port-security mac-address <statikusan/sticky>

Megsértési módok (Violation)
· Shutdown (Alapértelmezett): A port azonnal lekapcsol (err-disabled állapot), és a rendszergazdának kell manuálisan visszakapcsolnia (shutdown majd no shutdown).
· Restrict: A port nem továbbítja az idegen adatot, de aktív marad. Küld egy SNMP értesítést és növeli a "Violation counter"-t.
· Protect: Egyszerűen eldobja az idegen csomagokat, de nem küld naplóbejegyzést.

· (config-if)# switchport port-security violation <mód>

Show parancsok
· en#show port-security interface
· en#show port-security address

EtherChannel(Port összefogás)
Az EtherChannel lehetővé teszi, hogy több fizikai portot (pl. 2 vagy 4 kábelt) egyetlen logikai csatornává (Port-Channel) fogjunk össze. Nő a sávszélesség, és ha az egyik kábel elszakad, a forgalom zavartalanul megy tovább a többin (redundancia). Az STP nem fogja blokkolni a párhuzamos kábeleket, mert egynek látja őket.

Módok
· LACP (nyílt szabvány)
· on
· active
· passive 
· PAgP (cisco szabvány)
· on
· desirable
· auto

Konfiguráció (mindkét switchen ugyanígy)
· (config)# interface range <int-ek amit össze akarunk fogni>
· (config-if-range)# channel-group <group szám> mode <mód> → LACP vagy PAgP használata, de nem keverjük a kettőt!!!
· (config-if-range)# exit
· (config)# interface port-channel <group szám>
· (config-if)# switchport mode <mód> →  A csatornát trunk-ké tesszük

Show parancs
· show etherchannel summary
 
DHCP Snooping
A DHCP Snooping megakadályozza, hogy valaki egy saját (rogue) DHCP szervert kössön a hálózatra, ami rossz IP-címeket vagy hamis átjárót osztana ki a gépeknek.

Működése
A switch portjait két csoportra osztjuk:
· Trusted (Megbízható): Ide kötöd a valódi szervert vagy a felső szintű routert.
· Untrusted (Nem megbízható): Minden végponti port (PC-k). Ha egy ilyen porton DHCP-válasz (Offer/ACK) érkezik, a switch azonnal eldobja.

Konfiguráció
· (config)# ip dhcp snooping → Globális bekapcsolás
· (config)# ip dhcp snooping vlan <vlan száma> → Megadod, melyik VLAN-okban figyeljen
A megbízható port beállítása (pl. ami a router felé megy):
· (config)# interface <router felé néző int>
· (config-if)# ip dhcp snooping <megbizható>

Show parancs
· show ip dhcp snooping
Vezeték nélküli technológiák

SOHO-router
Mindig ments, minden oldal aljára görgess es nyomj a save settings gombra!
1. Internet (WAN) beállítások
Menü: Setup -> Basic Setup
· Internet Connection Type: <Kapcsolat típusa>
· Internet IP Address: <Külső IP cím>
· Subnet Mask: <Alhálózati maszk>
· Default Gateway: <Átjáró címe>
· Static DNS 1: <DNS szerver címe>
2. Helyi hálózat (LAN) beállítások
Menü: Setup -> Basic Setup (lejjebb görgetve)
· IP Address: <Router belső IP címe>
· Subnet Mask: <Belső maszk>
3. DHCP kiszolgáló beállításai
Menü: Setup -> Basic Setup (Network Setup rész)
· DHCP Server: <DHCP állapot>
· Start IP Address: <Kiosztás kezdő címe>
· Maximum Number of Users: <Kliensek maximális száma>
4. Wi-Fi alapbeállítások
Menü: Wireless -> Basic Wireless Settings
· Network Mode: <Hálózati mód>
· Network Name (SSID): <Hálózat neve>
· Radio Band / Channel: <Csatorna száma>
· SSID Broadcast: <SSID szórás állapota>
5. Wi-Fi biztonság
Menü: Wireless -> Wireless Security
· Security Mode: <Biztonsági mód>
· Encryption: <Titkosítás típusa>
· Passphrase: <Wi-Fi jelszó>
Access Point (AP) konfigurációja
Az Access Point (AP) egy egyszerűbb eszköz, amely a vezetékes hálózatot terjeszti ki vezeték nélkülire. A konfigurációt általában a Config fülön végezzük.
1. Fizikai port beállítása (Vezeték nélküli interfész)
Menü: Config -> Port 1
· Port Status: <Port állapota>
· SSID: <Hálózat neve>
· Channel: <Csatorna száma>
2. Vezeték nélküli biztonság
Menü: Config -> Port 1 (lejjebb görgetve)
· Authentication: <Hitelesítési mód>
· Encryption: <Titkosítás típusa>
· PSK Passphrase: <Wi-Fi jelszó>
3. Vezetékes csatlakozás ellenőrzése
Menü: Config -> Port 0 (Ethernet port)
· Port Status: <Port állapota>
· Bandwidth / Duplex: <Sebesség és átviteli mód>
4. IP címkezelés (Opcionális)
Menü: Config -> Settings
· IP Configuration: <IP cím kiosztás módja>
· IP Address: <Eszköz menedzsment IP címe>
· Subnet Mask: <Alhálózati maszk>
· Default Gateway: <Átjáró címe>
Forgalomirányítási alapok, statikus forgalomirányítás

Statikus forgalomirányítás (Static Route)
Kézzel megadott útvonal egy távoli hálózat felé.
· Parancs: ip route <Cél hálózati cím> <Cél maszk> <Következő ugrás címe>
Alapértelmezett statikus útvonal (Default Static Route)
Minden ismeretlen forgalmat egy meghatározott irányba (általában az internet felé) küld.
· Parancs: ip route 0.0.0.0 0.0.0.0 <Kimeneti interfész vagy Következő ugrás címe>
Összevont útvonal (Summary Route)
Több szomszédos alhálózatot egyetlen, rövidebb maszkú bejegyzéssel helyettesítünk.
· Módszer: A hálózatok közös bitjei alapján meghatározunk egy tágabb <Összevont hálózati cím>-et és <Összevont maszk>-ot.
· Parancs: ip route <Összevont hálózati cím> <Összevont maszk> <Következő ugrás címe>
Show parancs

· <show ip route> – A routing tábla tartalma (S = Statikus)
Dinamikus forgalomirányítási ismeretek

OSPF (Dinamikus forgalomirányítás)
Automatikusan építi fel a routing táblát a szomszédos routerektől kapott adatok alapján.
Alapbeállítások:
· Folyamat indítása: router ospf <Folyamatazonosító szám>
· Router azonosító: router-id <Egyedi azonosító>
· Hálózatok hozzáadása: network <Hálózati cím> <Wildcard maszk> area <Terület azonosító>
· Hirdetés tiltása kliens oldali porton: passive-interface <Interfész neve>
Hitelesítés (Biztonság):
A parancsokat az adott interfészen belül kell kiadni:
· interface <Interfész neve>
· ip ospf message-digest-key <Kulcs száma> md5 <Jelszó>
· ip ospf authentication message-digest

Időzítők beállítása:
Az időzítőket közvetlenül az interfészen állítjuk be.
· Szabály 1 (Match): A két szomszédos router értékeinek meg kell egyeznie.
· Szabály 2 (Arány): A Dead időzítő a Hello időzítő négyszerese (4 X).
Parancsok:
· interface <Interfész neve>
· ip ospf hello-interval <Másodpercek száma>
· ip ospf dead-interval <Másodpercek száma>
Show parancsok (Privilegizált mód):
· <show ip route> – A routing tábla tartalma (O = OSPF).
· <show ip ospf neighbor> – Szomszédsági kapcsolatok állapota.
· <show ip ospf interface <Interfész neve>> – Időzítők és hitelesítés paramétereinek ellenőrzése.


Hálózatbiztonság

ZPF (Zone-Based Policy Firewall) – Zónaalapú tűzfal
Nem interfészekre, hanem logikai zónákra és a köztük lévő kapcsolatokra (zónapárokra) építünk szabályokat.
A ZPF felépítésének lépései (Hierarchia):
1. Zónák létrehozása (Zones):
· zone security <Zóna neve>
2. Forgalom osztályozása (Class-map): Itt válogatjuk ki, mit akarunk figyelni.
· class-map type inspect match-any <Osztály neve>
· match protocol <Protokoll neve>
3. Házirend meghatározása (Policy-map): Itt rendeljük hozzá a műveletet az osztályhoz.
· policy-map type inspect <Házirend neve>
· class type inspect <Osztály neve>
· <Művelet: inspect/drop/pass> (Az inspect engedi vissza a válaszforgalmat).
4. Zónapár és Irány (Zone-pair): Összeköti a zónákat és ráteszi a szabályt.
· zone-pair security <Pár neve> source <Forrás zóna> destination <Cél zóna>
· service-policy type inspect <Házirend neve>
5. Interfészek hozzárendelése:
· interface <Interfész neve>
· zone-member security <Zóna neve>

Cisco ASA (Adaptive Security Appliance) – Dedikált tűzfal
Önálló hardveres eszköz, amely biztonsági szinteket használ a forgalom kezeléséhez.
· Security Level: Egy szám <0-100> között.
· A magasabb szintről (<Inside>) az alacsonyabb szintre (<Outside>) a forgalom alapból átmegy.
· Alacsonyabb szintről magasabbra csak <ACL> segítségével mehet.
· Működési alapok:
· interface <Interfész neve>
· nameif <Név: inside/outside/dmz>
· security-level <Számérték>
· ip address <IP cím> <Maszk>

Ellenőrző parancsok (Privilegizált mód):
· ACL: <show access-lists>
· ZPF: <show zone-pair security> és <show policy-map type inspect zone-pair>
· ASA: <show nameif> és <show conn> (aktív kapcsolatok listája)


Hozzáférési listák használata

Általános alapelvek (Minden ACL-re igaz)
Az ACL-ek sorrendben (felülről lefelé) futnak le. Amint egy csomag egyezik egy sorral, a router végrehajtja a műveletet, és nem nézi a többi sort.
· Implicit Deny: Minden lista végén van egy láthatatlan tiltás. Ha semmi nem egyezett, a csomag elvész.
· Irány meghatározása:
· IN (Bejövő): A forgalom a hálózat felől belép a router interfészén.
· OUT (Kimenő): A forgalom a routeren áthaladva elhagyja az interfészt a hálózat felé.
Standard (Alap) ACL
Csak a forrás IP-cím alapján szűr. Nem érdekli a cél vagy a konkrét szolgáltatás (port).
·  A célhoz a lehető legközelebb.
Sablon:
1. access-list <szám: 1-99> <művelet: permit/deny> <forrás_IP> <wildcard_maszk> (Vagy ha csak egy gépről van szó: access-list <szám> <művelet> host <gép_IP>) 
2. access-list <szám> permit any (Ez fontos a lista végére, ha nem akarsz minden mást is tiltani) 
3. interface <interfész_neve> 
4. ip access-group <szám> out 
Extended (Kiterjesztett) ACL
Részletes szűrés: nézi a forrást, a célt, a protokollt és a portot is.
· A forráshoz a lehető legközelebb.
Sablon:
1. access-list <szám: 100-199> <művelet: permit/deny> <protokoll: tcp/udp/ip> <forrás_IP> <wildcard_maszk> <cél_IP> <wildcard_maszk> eq <port_száma/neve> 
2. access-list <szám> deny ip any any (Opcionális, az implicit deny miatt amúgy is ott van) 
3. interface <interfész_neve> 
4. ip access-group <szám> in 
Nevesített ACL (Named ACL)
Ugyanazt tudja, mint a számozott, de nevet adsz neki, így később könnyebb beazonosítani, mire való.
Sablon:
1. ip access-list <típus: standard/extended> <lista_neve> 
2. (Itt már nem kell a sor elejére az access-list szó és a szám):
<művelet> <paraméterek a fentiek szerint> 
3. interface <interfész_neve> 
4. ip access-group <lista_neve> <irány: in/out> 
Távoli elérés korlátozása (VTY/SSH)
Ezzel véded meg magát a routert, hogy ne tudjon bárki belépni. Itt mindig Standard ACL-t használunk.
Sablon:
1. access-list <szám: 1-99> permit host <admin_gép_IP> 
2. line vty 0 15 
3. access-class <szám> in (Fontos: itt access-class és mindig IN irány!) 
Show parancsok

· show access-lists -> Megnézed, jók-e a sorok és vannak-e találatok. 
· show ip interface <név> -> Megnézed, jó interfészen és jó irányban van-e a szűrés. 

Statikus és dinamikus címfordítás lehetőségei

Statikus NAT (Static NAT)
Egyetlen belső IP-címet rendelünk hozzá egyetlen külső (publikus) IP-címhez. Leginkább szervereknél (pl. webszerver) használjuk, hogy kívülről mindig ugyanazon a címen legyenek elérhetőek.
· Logikája: Egy-az-egyhez (1:1) társítás.
· Parancs: ip nat inside source static <Belső IP cím> <Külső IP cím>
 Dinamikus NAT (Dynamic NAT)
Egy belső címtartományt (ACL-lel meghatározva) rendelünk hozzá egy külső publikus címtartományhoz (Pool). Az eszközök az éppen szabad publikus címek közül kapnak egyet.
· Logikája: Sok-a-sokhoz társítás.
· Lépések:
1. Belső hálózat kijelölése: access-list <Azonosító> permit <Belső hálózat címe> <Wildcard maszk>
2. Külső címtartomány (Pool) létrehozása: ip nat pool <Pool neve> <Kezdő külső IP> <Záró külső IP> netmask <Alhálózati maszk>
3. Összekapcsolás: ip nat inside source list <ACL azonosító> pool <Pool neve>
PAT (Port Address Translation / NAT Overload)
Ez a leggyakoribb típus. Sok belső IP-címet fordítunk le egyetlen (vagy kevés) publikus IP-címre, a portszámok segítségével megkülönböztetve a kapcsolatokat.
· Logikája: Sok-az-egyhez társítás.
· Lépések:
1. Belső hálózat kijelölése: access-list <Azonosító> permit <Belső hálózat címe> <Wildcard maszk>
2. Összekapcsolás a router külső interfészével: ip nat inside source list <ACL azonosító> interface <Külső interfész neve> overload
Elengedhetetlen lépés: Interfészek kijelölése
Bármelyik NAT típust is választod, a routernek tudnia kell, melyik oldala a "belső" és melyik a "külső".
· Belső interfészen (LAN):
1. interface <Interfész neve>
2. ip nat inside
· Külső interfészen (WAN):
2. interface <Interfész neve>
2. ip nat outside
Show parancsok:
· <show ip nat translations> – Megmutatja az aktuális, aktív címfordítási táblázatot.
· <show ip nat statistics> – Statisztika a fordítások számáról és a pool-ok állapotáról.
· <clear ip nat translation *> – Törli a dinamikus fordítási táblát.

WAN technológiák

PPP Alapkonfiguráció (CHAP hitelesítéssel)
A legfontosabb, hogy a két routeren a jelszó egyezzen, és a username a szemközti router neve legyen.
Azonosítás:
· username <Router_B neve> password <Közös jelszó>
Interfész konfiguráció:
· interface <Soros interfész neve>
· ip address <IP cím> <Maszk>
· encapsulation ppp
· ppp authentication chap
· clock rate <Sebesség> (Csak ha ez a DCE oldal)
· no shutdown
Show parancsok

· <show ip interface brief> – Itt az állapotnak és a protokollnak is up/up-nak kell lennie.
· <show interfaces <Interfész neve>> – Itt látnod kell, hogy az LCP és az IPCP állapota open.


Virtuális magánhálózat (VPN) kialakítása

GRE Tunnel
GRE (Generic Routing Encapsulation): Egy "csomagoló" protokoll. Képes bármilyen forgalmat (pl. OSPF/EIGRP útvonalfrissítéseket vagy Multicastot) átvinni két távoli hálózat között, de nem titkosít. Mindenki láthatja az adatokat.
· interface tunnel 0 – Létrehozza a virtuális interfészt.
· ip address 10.0.0.1 255.255.255.0 – Az alagút belső, privát IP-címe.
· tunnel source <Saját_Külső_IP> – A router internet felé néző fizikai interfészének címe.
· tunnel destination <Távoli_Külső_IP> – A szomszédos router internetes címe.
Titkosítás
Egy erős biztonsági keretrendszer. Titkosít, de csak a sima Unicast (pont-pont közötti) forgalmat szereti, a dinamikus routing frissítéseket alapból nem viszi át.
ISAKMP
Itt beszéli meg a két router, hogyan fognak egymással biztonságosan kommunikálni.
· crypto isakmp policy 10 – Szabályzat létrehozása a titkosítási alkudozáshoz.
· encryption 3des – Titkosítási algoritmus kiválasztása.
· hash sha – Adat sértetlenség ellenőrző algoritmus.
· authentication pre-share – Megadjuk, hogy közös jelszót (kulcsot) használunk.
· group 2 – Diffie-Hellman kulcscsere matematikai módszere.
· crypto isakmp key <Jelszó> address <Távoli_Külső_IP> – A konkrét közös jelszó rögzítése.
Transform Set
Itt dől el a tényleges felhasználói adatok titkosítási módja.
· crypto ipsec transform-set <Név> esp-3des esp-sha-hmac – A konkrét titkosító protokollok kiválasztása.
· mode transport – Fontos: Nem tesz rá újabb IP fejlécet, mivel a GRE-nél már van, így sávszélességet spórolunk.
IPsec Profile 
Ez fogja össze a titkosítási beállításokat, hogy könnyen az alagútra tehessük.
· crypto ipsec profile <Profil_Név> – Profil létrehozása.
· set transform-set <Név> – A 3. pontban megírt szabályzat hozzárendelése.
Aktiválás 
Itt kapcsoljuk össze a virtuális alagutat a titkosítással.
· interface tunnel 0 – Belépés az alagútba.
· tunnel protection ipsec profile <Profil_Név> – Megparancsolja az alagútnak, hogy minden rajta átmenő adatot titkosítson a profil szerint.
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Learn more [2
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RewriteEngine On
RewriteCond %{REQUEST URI} !"A well-known/acme-challenge/
RewriteRule " https://example-bp.ddnsfree.com%{REQUEST URI} [R=301,L]

ErrorLog ${APACHE LOG DIR }/example-http-error.log
CustomLog ${APACHE LOG _DIR }/example-http-access.log combined
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